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Introduction

Mixbus – Bringing real console mixing to the DAW
Welcome to Mixbus! Mixbus is an “analog style console” that has been incorporated into a Digital Audio
Workstation. The Mixbus engine was developed at Harrison Consoles, where we have been designing high-
end digital and analog consoles for over 40 years.

Many great-sounding, influential, and legendary works were recorded and/or mixed on Harrison consoles,
including…

• Michael Jackson “Bad” and “Thriller” (the best-selling album of all time).
• AC/DC “Back in Black”
• Janet Jackson “Rhythm Nation”
• Queen “Hot Space”, “A Kind of Magic”
• Sade “Sweetest Taboo”
• Paul Simon “Graceland”
• Supertramp “Breakfast in America”

… and many more by artists such as Led Zeppelin, ABBA, U2, Madonna, Mike Oldfield, and Frank Zappa.

Harrison continues to be a major force in the ultra-high-end professional audio community. World-class
facilities like Sony Pictures use Harrison consoles to mix top-tier films.
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Image:
Harrison MPC4-D Console at
Sony Pictures
Sound Stage 6
Culver City, CA

For more information about Harrison, visit our website at http://www.harrisonconsoles.com.

Mixbus is not a tool for beginners. Although we strive to make Mixbus easy-to-use, digital audio editing and
mixing is a very complex topic. This document assumes that you are already comfortable with typical Digital
Audio Workstation (DAW) conventions. Additional online resources are available from the Mixbus “Help”
menu and at:

http://www.youtube.com/user/HarrisonConsoles
http://harrisonconsoles.com/mixbus/forum/
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About This Manual (online version and PDF
download)
The following image will help you understand a few conventions used in the online version of the Mixbus
manual. A PDF version has been made available for download via a link in the lower left corner of the
page. Don’t forget to use the “Feedback” feature near the bottom of each page. (Feedback is intended for
manual specific items only. If you need tech support or would like to make a feature request please email us
or visit our user forum.)
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Features & Specifications
Mixer Features:

• Mixbus uses precision DSP algorithms developed by Harrison for our world-renowned large format
digital mixing consoles. Mixbus also incorporates elements from the rich history of Harrison analog
designs. Mixbus has been optimized to provide a classic Harrison sound.

• Straightforward “what you see is what you get” mixer layout based on Harrison’s renowned 32-series
and MR series music consoles.

• Unlimited stereo or mono input channels (based on available CPU power) featuring EQ, filter,
compression, mix bus sends, and mappable plug-in controls on every channel.

• Like a hardware mixer, the DSP horsepower for EQs and compressors is preallocated. Enabling a
compressor or EQ will not change the DSP load.

• 8 Stereo mix buses (can be used for groups or aux buses) featuring tone control, compression, and
tape saturation.

• Stereo Master that features tone control, compression, tape saturation, and final limiting.
• K-meter on master output helps you make dynamic, polished-sounding mixes.
• Stereo phase correlation meter indicates mono-compatibility of your mix.
• Plug-in delay compensation to support effects such as parallel compression.
• Plug-ins may be pre or post fader in the channel strip signal flow.
• Comprehensive metering with peak, peak hold, and compressor gain reduction visible on every track

and bus.
• The engine is internally dithered, ramped, and gain staged so that sound quality is preserved as close

to analog as possible.

Editor/DAW Features:

• Unlimited audio, MIDI, and virtual instrument tracks.
• Every track/bus has unlimited pre- and post-fader inserts, sends, and plug-ins.
• MIDI tracks with MIDI output to external devices OR virtual instrument
• Non-destructive, non-linear editing with unlimited undo.
• Fast and intuitive audio editing with “smart” mouse editing modes.
• Dynamic automation of fader, pan, and plug-in parameters.
• Pitch/time stretching, transient detection, and varispeed playback.
• Object-oriented, per-region volume, dynamic volume, crossfade in/out, and mute functions.
• Standard file formats (BWF, WAV, WAV64, AIFF, CAF & more…).
• Supports industry standard plug-in formats and I/O devices on each supported platform.
• Transport control via Level 2 MMC or MTC (master or slave)
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• LTC (SMPTE) chase and generation
• Assign MIDI CC knobs to mixer controls with just 1 click.

General

• Refined workflow and graphics, including scaling and support for HiDPI (Retina) displays
• Multicore DSP processing allows more simultaneous tracks and plug-ins
• 64 bit builds for Mac & Windows provide extended memory for VI sample libraries

• 32 bit and 64 bit version available for all three platforms (OS-X, Windows, Linux)
• New ASIO & CoreAudio (mac) I/O engine
• Experimental support for video import and export

System Requirements:

• OS-X Intel Running 10.4.11 or newer, 32 bit or 64 bit
• Windows XP Pro or newer, 32 bit or 64 bit
• Linux system (x86 or x86-64) with working sound
• Two or more processors/cores

*See our website for the latest details on OS compatibility, plug-in compatibility, and system requirements:

http://harrisonconsoles.com/site/mixbus-sysreq.html

By default, Mixbus requires significantly more CPU resources than a typical DAW. You might be exceeding
the capabilities of Mixbus on your system.

The typical methods to minimize the CPU load are:

• increase the “buffer size” in the Audio Setup dialog
• use a lower sample rate, reduce the number of tracks
• reduce the number of plugins in your session.
• And of course using a faster computer, with more CPU cores, is desirable.

The CPU meter on your computer averages the cpu usage over a very long period (perhaps one second).
In digital audio, the timing is much more sensitive. When the soundcard passes us a buffer, then we have to
wake up, process the audio buffer, and return it to the soundcard before the soundcard needs to play it out.
If we don’t wake up in time, or we don’t get finished in time, then you hear a “click” caused by the (we call
these xruns, short for over-run or under-run).
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In the case of a 1024 buffer size, this has to be done within (1024/44100) 25ms, or about 1/40th of a
second.

This is complicated by the fact that it’s the OS’s job to “wake us up” and tell us that the soundcard has some
data for us. Some OS’s and drivers are better at this than others. But let’s say it takes 5ms before we are
even alerted that some data is available. We now have 20ms left to process the audio. If it takes us 10ms to
process the audio, then we are finished within 50% of the allotted time and that’s what we display in the
meter. This is a very accurate indication of your computer’s ability to process audio.

This also explains why the selected buffersize is so critical to the DSP load. A 256-sample buffersize is
about 6ms, so if your computer sometimes waits 5ms after receiving the soundcard interrupt before it
“wakes us up”, we only have 1ms remaining to do our work.

For more information on factors impacting the performance of your computer please see this video:
CPU Performance vs. Real-Time Performance in Digital Audio Workstations
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What’s Different About Mixbus?

“True Analog” sound
Harrison is unique among audio companies: In 1990, we launched digitally-controlled analog consoles which
were installed at many world-class music and film mixing facilities. But digital was the new technology, and
our customers expected the latest digital technologies in their facilities. Harrison made a bold proposal: we
would replace the existing analog processing racks with a digital system, and leave the control surface in-
place so the mix engineers could continue to work with the same workflow and sound that they had grown
used to. Of course, to make this practical we had to make the digital engine “sound” exactly like the analog
engine it was replacing.

During this process of replacing an analog console processor with a digital version, we made many
discoveries about how to make digital sound less like digital, and more like analog. We’ve been refining
these technologies for nearly 25 years since the launch of those first digital consoles. Harrison has made
several generations of analog and digital consoles since that time, and has been continuously improving our
DSP. This unique development path is what gives Mixbus a different sound than traditional workstations.

Analog-style Workflow
Most DAWs were first introduced in the stone-age days of computers. Processors were rated in megahertz
and memory was measured in kilobytes.

At that time, the standard tool was the studio console; it provided nearly every feature that was needed for
day-to-day recording, editing, and mixing tasks. With the addition of a few outboard boxes (such as reverbs,
delays, and maybe a final compressor ) it was possible to create a polished album.

When computers were introduced, they were unable to recreate the features of then-standard tools such as
a 48-track tape machine and console. Those early computer systems could only play back 4, 8 or 16
channels; and because CPU power was so desperately limited, you had to choose which of those channels
would be assigned an EQ. In this model, even the most basic console features had to be treated as
“outboard” gear. And so was born the “Plug-In” !

Fast-forward to the present, and you know that computers are fast enough to run hundreds of channels,
each with a half-dozen plug-ins. As a new-generation workstation, Mixbus takes advantage of today’s fast
computers to take the load off of the engineer, and return to the fun and creativity of mixing music.
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Open Source, Open Standards, Open Community
Mixbus is largely open-source and is the collaborative effort of a worldwide team including musicians,
programmers, and professional recording engineers. Many workstations provide “open” control or plugin
protocols… Mixbus goes far beyond that. Like a good piece of vintage hardware, you can open the box and
look inside. This transparency encourages Mixbus development to happen with integrity. We spend our time
on the issues that users want and need; not just items that look good in an advertisement. In the crazy world
of DAW software, it is nice to know that a sane option exists for your business or personal use.
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Operational Differences from Other DAWs
If you are new to recording, then you’ll find Mixbus very easy to learn and navigate. If you are coming to
Mixbus from another DAW, here are some of the conventions that might seem different to you:

Console-like signal flow
Most DAWs allow the user to create tracks and buses, but the user is expected to assemble the tracks and
buses into a sensible signal flow. To do this, you create one or more buses as-needed, and then assign the
track output(s) to the bus inputs. If you later realize that you want another track assigned to that bus, you’ll
have to make that connection; and at the end of the day you might have lots of nearly-invisible and
arbitrarily-ordered connections all over the place!

Mixbus provides a fixed signal flow, modeled after an analog console. You don’t have to “choose” how many
buses you will need, or where they are assigned. This provides several benefits. The bus assignments/
sends are displayed in a fixed order, so you can quickly determine what channels are feeding the reverb
bus, for example. Additionally, the assignment and/or send-level to a bus can be automated.

Plug-ins are encouraged, but are not considered part of the
core workflow.
Most other DAWs serve as a “container for plug-ins”. They provide little or no signal processing or bussing,
by default. They expect third parties to develop the actual DSP processing.

Mixbus is different! Harrison provides our own high-quality DSP processing for the channel strip EQ and
compressor. We’ve tweaked the various EQ, compressor, saturation and limiter stages to complement each
other. You may still add plug-ins if you wish, but it is no longer necessary to purchase, and choose between,
multiple plug-ins each time you want to change your sound. You can make a great mix without any plug-ins
at all!

Regions may be stacked in layers
Each audio “region” (or “clip”) is a discrete sound that exists on the timeline track, and it may have other
regions stacked above or below it – on the same track. Deleting the topmost region layer does not create a
hole; instead, you will see&hear the audio that was hidden underneath it. You might think of this like the
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layers of an image editing program. Like an image editor, it is even possible to make regions “transparent”
so that the regions underneath it are still visible (or in this case, hear-able).

This provides 2 benefits. Firstly, it allows you to record an overdub, or part replacement, on top of an
existing track. You can then move, trim & fade (or even delete) the replacement part without having to worry
about the audio layer(s) underneath it. Secondly, you can use “transparency” to stack lots of sounds (such
as bird chirps) on a single track, and effect them together, without having to allocate multiple tracks so each
individual sounds is heard.

Region Fades are Crossfades
The start and end of each region has a “fade”, which gradually raises or lowers the volume. When you listen
to the region by itself on a track, you hear it fade from silence into the audio, and then back to silence. But if
the region is on top of another region, then something even more interesting happens: you will hear a
crossfade from the underlying region, into the top region, and then back to the underlying region. This
allows you to stack regions on top of one (or more!) regions underneath it, and set your crossfade to match
perfectly. Later, even if the underlying audio is changed, you’ll still preserve the fade of the topmost region.

Because digital audio streams don’t like abrupt changes in the audio stream, EVERY region has a start and
end fade. Mixbus’s default fades make it easier to edit with confidence that you won’t introduce a click.

Less emphasis on Tools, more emphasis on Actions
Most DAWs have a set of “tools” (or “mouse modes”) which modify how the mouse behaves. For example,
you select the “scissor” tool to make cuts, and the “trim” tool to trim region ends. In Mixbus, we have very
few tools. You can do most of your work using the “Grabber” (hand) tool. Point where you want to perform
the action, and then use the keyboard shortcut to initiate an action (such as “S” for split, or “J” to trim a
region’s start. (you can also grab the edge of the region to trim it, but the keyboard actions are faster)
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Installation
Platform-specific information

Mixbus works on 3 different desktop operating systems ( Mac, Windows, and Linux). Each system has its
own conventions for installation. Rather than force the user to learn an unconventional installation
procedure, we have made Mixbus follow the conventions of the OS you are using.

• On Mac OSX, Mixbus is provided as an application “bundle” inside a DMG file. Just open the bundle,
and drag Mixbus to your Applications folder.

• On Windows, Mixbus is provided with a step-by-step installer that prompts you for the installation
location and then installs Mixbus.

• On Linux, Mixbus is provided as a zip file that, when unzipped, provides an installation script.

The following pages explain the details for installing Mixbus on various operating systems:

• Windows
• OS X
• Linux
• All Platforms

Harrison Consoles Mixbus v3 - 1
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Installation – Windows
Mixbus on Windows uses the windows-standard installation process. Double-click the installer to launch the
process, and follow the directions for a “Typical” installation. This will install Mixbus to the default location.
Mixbus is NOT signed by Microsoft (currently), so you may have to explicitly allow the installer to run. This is
normal operation.

After installation, please continue to Install the Mixbus License file

Uninstalling Mixbus: use the uninstaller provided in “ Start Menu -> Programs -> Mixbus”.

A note about “Audio Setup” on Windows:

On Windows, Mixbus will detect sound cards that use the DirectSound or ASIO API. This means that you
will likely see sound cards appear multiple times in the audio setup menus. If provided, the ASIO driver
option is preferable for stable, low-latency operation.

Many built-in desktop sound devices will not provide an “Input device” if a microphone is not physically
plugged in. If you plan to record with Mixbus, you must plug a device into the sound card’s input before you
launch the audio engine. If you would like to use Mixbus without a capture device, choose “None” for the
Input device. Mixbus does not provide a “None” option for the playback device. If you have no devices for
playback then you can choose the Dummy device which runs Mixbus without any sound I/O.

If you are upgrading from an earlier version of Mixbus it is advisable to keep your previous
version of Mixbus installed on your computer in the event you need to revisit old sessions. It
is possible that opening a session created with a previous version of Mixbus may lose some
functionality.

!

Windows systems, and particularly laptop systems, often require some system optimizations
to operate without clicks and pops. Most importantly, you should visit the System-
>Advanced settings dialog, and tell Windows to optimize for “background tasks”. This will
dramatically improve the stability of audio I/O. For laptops, we highly encourage you to
leave your laptop plugged-in, and select the high-performance CPU mode when it is
plugged-in. There are many other optimizations (such as disabling virus-checks) that may
be beneficial. You can find some of these choices here: optimizing windows for audio
recording.

!
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When you select an ASIO device, the “Buffer size” setting will be automatically changed to the current
preferred buffer size of your ASIO device (normally set in the device’s manufacturer-supplied control panel).
It is important to use the device’s preferred buffer size. Otherwise you will incur a “buffer size adaptation”
process which reduces efficiency and may affect latency (delay) through Mixbus.

Non-ASIO devices will default to a buffer size of 1024 for stable operation. Changing this setting is possible
but is unlikely to have much effect on the performance because of the Windows sound infrastructure.

A note about VST plug-ins on Windows:

After the initial installation, Mixbus will not have any knowledge about your third-party VST plugins. You
must add the path(s) to your VST plugins in the Edit->Preferences->Plug-in tab. For more information about
plugins, click here.

Continue to Download and Install the License File
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Installation – OS X
Installing Mixbus:

Mixbus provides 1 1 package for Mac OSX:

64 bit ( for Intel Mac computers running 10.7 or newer )

In the past, Harrison provided a PowerPC (G4/G5) package of Mixbus. We have chosen not to distribute a
PPC version of 3.0, but we may introduce it later, if there is high demand.

To install Mixbus, download and double-click the .dmg archive (Mixbus_Intel_3.0.,dmg or similar). Drag the
Mixbus icon to your Applications folder (or anywhere that you like to store your applications; Mixbus doesn’t
care which folder it is started from). If you would like Mixbus to be shown in the Dock, then you should drag
Mixbus from your selected location to the Dock.

Audio Input and Output:

Mixbus can use any CoreAudio-supported interface. Many newer soundcards work without a dedicated
driver; but some older interfaces (such as the Digi 00x series) may require a special driver from the
manufacturer before they appear in the list of CoreAudio devices.

If you are upgrading from an earlier version of Mixbus it is advisable to keep your previous
version of Mixbus installed on your computer in the event you need to revisit old sessions. It
is possible that opening session created with a previous version of Mixbus may lose some
functionality.

!

Mixbus is not (currently) digitally signed by Apple. On Mavericks and newer, you may have
to right-click on Mixbus and choose “Open” the first time you launch it.

!

Do NOT drag Mixbus directly from the .dmg archive to the Dock; this would create a
shortcut to the Mixbus application inside the DMG file. If you do this, then when you click
Mixbus in the dock, OS X will have to extract and mount the .dmg file before launching
Mixbus. This will make Mixbus run very slowly.

!
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Newer Mac computers have separately-clocked input (mic/line-in) and output (headphone/line-out) devices.
Prior versions of Mixbus required that you create an “Aggregate” device to combine the internal soundcard
input and output into a single device. Mixbus v3 now provides a method to select separate input and output
devices without making an aggregate device; Mac will create an invisible “aggregate” for you. When
possible, it is always best to use a professional I/O card to avoid any internal sample-rate conversion that
may be performed by OSX.

You can combine multiple devices into an “Aggregate” device which provides all the I/O as if it were a single
device.. For example, you can “aggregate” 2 different 8-channel devices so that you can record 16 channels
into Mixbus. In a few cases, we have found that troublesome devices that don’t work well in Mixbus can be
improved by creating an “aggregate” device, selecting the device’s input and output for the aggregate. This
provides an extra level of separation from the device’s driver into Mixbus. To create an “Aggregate” device,
consult the Apple documentation for your version of OSX.

A note about AU plug-ins on Mac OSX:

After the initial installation, Mixbus will not have any knowledge about your third-party AU plugins. You must
visit Edit->Preferences->Plugins to scan your AU plugins and make them available in Mixbus. For more
information about plugins, click here.

To finish your installation, please continue to Download and Install the License File
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Installation – Linux

Some distro’s are designed for audio (such as Ubuntu Studio). A further list of distros is at: http://www.linux-
sound.org/distro.html. It is beyond the scope of this document to compare these distros.

Sound card (I/O) support:

Support for professional sound I/O is limited on Linux. However there are some excellent options available
at various price ranges. Normally, no driver or configuration is needed to use a sound card if it is supported
by your distro. It is important to choose a distro that has good pro-audio support.

Unfortunately, support must be determined on a per-device basis. The ALSA project provides a fairly
comprehensive list of USB, PCI, and built-in devices. There is a separate list of FireWire devices. When in
doubt, check with your distribution’s documentation, user forums, or support.

Downloading and Installing Mixbus:

After your purchase, you will receive a link to download the installation package. You must first unzip the
package using your distro archive utility.

Once unzipped, a folder will appear with the installer (Mixbus_something.run). Open a terminal in the
directory with the installer and then type ./Mixbus_64bit-3.0.844.run

The installer will prompt you to uninstall previous versions. The installer will check the suitability of your
system for real time audio, and report any problems that it finds.

Continue to Download and Install the License File

A note about Linux distros: While an expert system administrator can adapt nearly any
distro for use with Mixbus, it is easier for most users to start with a distro that is designed
for use in high-performance audio.
*

If you are upgrading from an earlier version of Mixbus it is advisable to keep your previous
version Mixbus of installed on your computer in the event you need to revisit old sessions. It
is possible that opening a session created with a previous version of Mixbus may lose some
functionality.

!
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License Installation – All Platforms
Downloading and Installing the License file:

Click the videos above for “Home Folder” instructions.

The first video is mostly Mac and the second video Windows.

When you complete your purchase through the Mixbus store, you should receive an email with a download
link for your license key.

Please click the link, download the file, and save it to your HOME folder. The location of the HOME folder
varies with each OS:

• Mac OSX: your home folder is typically “Mac HD/Users/{your name}”, or open a Finder window, and in
the main menu click Go->HOME

• Windows XP: your home folder is typically “C:/Documents and Settings/{your name}”, or click your
name at the start of the Start menu

• Windows Vista and newer: your home folder is typically “C:/Users/{your name}”, or click your name at
the start of the Start menu

• Linux: your home folder is typically “/home/{your name}”
Since Mixbus version 3.3 the following locations are searched on Linux in the given order (first found
file is used)
$XDG_CONFIG_HOME/harrisonconsoles/license_key_harrison_*.txt
$HOME/.config/harrisonconsoles/license_key_harrison_*.txt
$HOME/.license_key_harrison_*.txt
$HOME/license_key_harrison_*.txt
/usr/local/share/license_key_harrison_*.txt

Harrison Consoles Mixbus v3 - 1

Page 21 of 420

https://www.youtube.com/embed/vif6VaAncxc?rel=0
https://www.youtube.com/embed/vif6VaAncxc?rel=0
https://www.youtube.com/embed/To5SOyd0Qw4?rel=0
https://www.youtube.com/embed/To5SOyd0Qw4?rel=0


The license file is used to display your name in the New Session dialog when Mixbus launches. If Mixbus
reports that your copy is UNLICENSED, please review the license instructions, and if you are still unclear on
the license installation process then please contact Harrison for support.

Unlicensed copies of Mixbus will occasionally generate noise to indicate that it is not licensed.

After downloading it to your HOME folder, you can store a backup copy of your license file
in a safe place. If you later change computers, you can copy the file to your new computer.*
Windows often hides the “.txt” extension, so make sure you don’t have “.txt.txt” at the end of
the filename.

!
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Using Mixbus with JACK (optional)
JACK is a system service that allows for the interconnection of audio between applications. Previous
versions of Mixbus required that JACK be installed on your system. Mixbus no longer requires or expects
JACK to be installed. Mixbus uses your sound card directly via ASIO (Windows), Core Audio (Mac) or
ALSA (Linux ).

If you would like to interconnect the audio of different applications into Mixbus, then you can download and
install JACK for your system. JACK is not a Harrison product, and we cannot provide email support for
JACK users. However you will find a lot of JACK users on our forum, because JACK is a powerful utility.

JACK creates virtual audio and MIDI ports that can be connected and shared between nearly any
application on your system. If the application is JACK-aware ( i.e. it was compiled with the JACK libraries)
then it will have some additional features such as sample-accurate transport control and sync. There are
many third-party apps that can control JACK connections, save and restore your connections, or even route
the audio or MIDI using Ethernet. Mixbus is fully JACK-enabled, and it can save all the JACK connections
that are made to it. Mixbus can also use JACK as a sync source, or it can be the master sync source. A full
description of JACK timecode sync is beyond the scope of this manual.

You can learn more about JACK at JackAudio.org
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Getting Started
Getting Started (Overview)

Mixbus is an editor that works on a document format called a Session. A session is a folder on your hard
drive that stores all of your recordings, edits, and mixer settings together. Unlike a word processor, Mixbus
does not allow you to start an empty document and then “save” it later. Instead, when you first launch
Mixbus, it will guide you through creating or selecting a session before you can start to record, import, edit
or mix your project.

A session is a collection of tracks. Use the “Add Track/Bus” dialog which can be found in the Session and
Track menus. You can also create tracks by right clicking in the gray track area under the track headers, or
by right-clicking in empty mixer-window space, or by clicking the blue “+” button in the top of the mixer
window’s left-side panel.

Alternatively, you can create new tracks by Importing existing audio from the Session-Import menu.

If you find yourself starting the same way for each session, you can create a session template which will be
available as a starting point next time you start a new session. You’ll find the list of available templates
when you create a new session. Click Session Templates to learn more.

You can save multiple snapshots of your settings inside that session. Snapshots conveniently save your
entire editing/mixing session for later recall. Saving a snapshot is instantaneous and takes up essentially no
extra disk space (snapshots all share the same audio data in the session folder). Click Snapshots to learn
more.

If you make a mistake while recording or editing, you can click “Undo” to revert your changes. Only a few
editing operations (such as adding or removing a track) cannot be undone. One of the cool features of
Mixbus is the fact that your “Undo” history for each session snapshot is stored when you save the session;
This means that you can return to a session after a few days, and still undo the last changes you made, if
you decide that they weren’t a good idea.

When you are finished, you can Export your session to an audio file using the Session->Export menu item.
The exported file can be shared online or burned to a CD.

Mixbus uses the right mouse button for many features. Try right-clicking on tracks,
regions, mute buttons, solo buttons, group panes, regions, selected ranges, markers, mixer*
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Need Help?

Getting started with a new DAW can be a challenging task. While Mixbus shares conventions with many
other popular DAWs, it can still be a little difficult at the beginning. Rest assured that it is worth your time
and effort to learn Mixbus. For technical issues, bug reports, and feature requests, email support is available
from Harrison Consoles: mixbus@harrisonconsoles.com.

If you’d like to interact with other users of Mixbus, you can visit our forum or internet chat area. The easiest
way to find them is to select the Help menu within Mixbus. This will open your web browser to a page that
allows you to interact with other Mixbus users. If you are unable to open the Mixbus window and see these
options, just enter either of these URLs directly into your web browser:

http://harrisonconsoles.com/mixbus/forum/
http://webchat.freenode.net/?channels=ardour-mixbus

Another mechanism for support is the Ardour forums at: http://community.ardour.org/community This is a
good place to get involved with the open-source aspect of Mixbus; you can be directly involved with new
features, bug fixes, and the overall direction of the Ardour DAW.

“Once you have reached the level of a Harrison Console, you are ready for new flights of
engineering imagination. Unlimited. Unhaltered. Uninhibited by the bounds of technical
obstructions. YOU BECOME THE STUDIO. You are the living extension of the electronic link
between the perfect sound and the perfect master. You are the ultimate conductor in the universe
of recorded music” – Harrison 4032 brochure, circa 1975

redirects, clocks, the region list, and the marker bar area. Each will launch a context menu
that provides many features.
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First Time Configuration
First Time Configuration Dialog boxes:

A welcome message will appear. Click the“Forward” button to continue
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An option to change the default session folder is given. If you have a preferred hard drive you would like to
use, the dropdown box will allow you to browse to it. Choosing a drive other than the one that your OS or
the Mixbus application resides on may increase performance (this is dependent on your computer
configuration).
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Some soundcards provide a low-latency mixer interface which can be used to monitor yourself while you are
recording. If you want to use your interface to monitor yourself, choose “hardware monitor”. Otherwise
choose “Mixbus does monitoring”. You can find more information about monitoring, click here
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The monitoring section provides an additional volume control between your master mix, and your
soundcard. You will want to enable this option if your interface doesn’t provide a monitor level knob. It also
provides some additional solo-ing features. For more on the monitoring section click here
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Starting a session

Session setup:

3 options are given in the session setup window:

1. Open a recent session:(this list will be blank for first time users). The black window with in the dialog box
displays a list of a saved session’s name, sample rate, and bit depth. If any “snap shots” have been saved,
an arrow next to that session will appear. Notice the arrow next to the session “Alligator Lily” but no arrow
next to “The Nashville Sessions”. Clicking on the arrow will show all snap shots available to choose from. In
this case the engineer choose to name them rev 1 and rev 2.

It is possible that sessions created with other versions of Mixbus may not work with the
latest version. It is advisable to keep earlier versions of Mixbus on your computer if you
intend to open and work on those session.

!
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2. “Click to create a New session”: When creating a new session a dialog box will allow you to name the
session and choose a location other than the default if you wish.

Note in the above image the message “This copy of Mixbus is licensed to:” If your copy is
unlicensed and you would like to join the Mixbus community click here. for further
information.
*
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3. “Click to open an Existing session”: If a previously created session does not show up in the session
window, or if no previous sessions have been created, then you can use the browser function to locate and
open an existing session. A session file will have a file name suffix of “.ardour”. In the image below the
session file is “The Lost Sessions.ardour” and it is located on the desktop as shown by the folder tabs
across the top. For more on Session File Management click here.
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Browse to open an existing session

Clicking on the name of a recent session or creating a new session will open the “Audio/MIDI Setup” dialog
box. Here you will be given a chance to verify your system settings (image below).

If you are opening an existing session, the audio system will be configured for that session’s sample rate.
The other settings (I/O devices, buffer sizes, etc) will be configured with your most-recently used settings.

If you are creating a new session, this is your chance to define the sample rate for the session. For more on
the Audio/MIDI setup window click here.

IMPORTANT NOTE: A session’s sample rate is determined when it is created. There may
be external utilities available which can convert a session to a new sample rate, but this
requires sample rate conversion and may impart subtle artifacts into the recordings. Music
projects are typically created at 44.1 kHz, while most audio-for-video projects utilize 48 kHz.

!
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Session File Management
A session folder contains everything associated with a particular session. Audio files (or links to them),
multiple snapshot files, the waveform display cache, your exported mixes (unless the default location has
been changed) and many other things.

Additionally, under menus>Session you will find the following:

New: Calls up the Session Setup dialog and allows a new session to be created. This will save and close
any currently open session.

Open: Allows the user to open an already saved session. A navigation dialog will appear so that you can
locate your session.

Recent: Contains a list of recently opened session that can be opened.

Close: Exits the current session. If any changes have been made to the session a dialog box will present a
save option.

Save: Saves the current session

Save As: Saves the current session with a new name and/or new location

• Switch to newly-saved version: Closes the session you are currently working with and opens the new
session.

• Copy media to new session: All files within the interchange folder (audiofiles, midifiles, and videofiles)
will be copied to the new session/interchange folder. If this option is not checked Mixbus will refer
back to the previously named session’s interchange folder.

• Copy external media into new session: Same as above but also moves any files that may be located
in other directories or hard drives. See topic clean-up, sub topic real world example for similar
functionality and why you may need it.

Rename: Renames the current session

Snapshot (& keep working on current version) …: Makes a copy of the opened session in its current
state for later recall.
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Snapshot (& switch to new version) …: Saves a copy of the opened session in its current state with a
new name and/or location.

Save Template: Session templates are a fast way of recalling common session “layouts” such as hardware
connections, plug-ins, and number of tracks. If you find your current session is a common one, you can save
the it as a template (no audio will be saved).

Recover from a Snapshot

Snapshots are instantaneous and take up essentially no extra disk space (snapshots all share the same
audio data in the session folder). To recover from a “backup” file in the backup folder, you must first drag it
up one level into the main “session” folder. Then you can open it normally. If you try to open it from within
the “backup” folder, it won’t find the audio files.

1. Quit Mixbus
2. Open the session folder and find the “backup” subfolder.
3. Choose the last-created snapshot file ( the file ending in .ardour )
4. Copy the file up to the main session folder
5. Launch Mixbus
6. In the “recent sessions” list, you should see a triangle next to your session; click the triangle and

choose the backup snapshot.
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Session Templates
Any session can become a session “template” for future sessions. Once you’ve created a session and set
up your track routing, plug-ins, etc, you may want to reuse that setup for a future project. A template
contains everything except the actual audio data: track layouts, plug-ins, and your channelstrip EQ/
Compressor/Bussing setup.

To save a template, choose Session->Save Template, and name the template something meaningful so you
can find it in the future.

To use a template, you have to create a NEW session. In the New Session dialog, there is a pulldown list of
your templates, and a checkbox that enables the template for this session.

Where are my templates stored on disk?
Templates are stored in the user config area, under a folder called “templates”. You can delete templates
from that folder, if you know you don’t want them anymore.

For example, let’s assume there’s a template called “TemplateTest”

This will create a folder called “TemplateTest” inside the templates folder. Inside that folder you’ll find a file
called “TemplateTest.template”. That is the prototype session file that will be used for your new session.

Location of The Template Folder

The location of the template folder will vary depending on your setup but it will be something like this:

On MAC: macHD>Library>preferences>Mixbus>templates

(On some systems the library folder is hidden. If you go to the OS X menu bar and hold the option key while
clicking “Go” it will show up.)

On Windows: C:\Users\your name\AppData\Local\Mixbus\templates

Some plugins can store additional data that won’t fit in the session file. For example, a
convolution reverb might include the user-selected impulse response files. For that purpose,*
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there is also a “plug-ins” folder inside the template folder which stores this additional
information.
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Audio Midi Setup Dialog

Audio System:

The “Audio System” selection tells Mixbus which way you will connect to your devices.

• To use your audio devices on Mac OS X, select “Core Audio” (this option is only available on Mac).
• To use your audio devices on Windows, select “ASIO” (this option is only available on Windows).
• To use your audio devices on Linux, select “FFADO” (for FireWire devices) or “ALSA” (these options

are only available on Linux).
• “JACK” uses the JACK server to talk with your sound card and other software on your system. It is

only available if you have already installed JACK on your system. If the JACK server is already
running, then Mixbus will connect to the JACK server. If not, then Mixbus will start the JACK server for
you (the JACK option is available on Mac, Windows and Linux). You can learn more about JACK here.

• The “Dummy” system is used for testing only. It has all the features of a real audio system, but it does
not connect to your sound card so you cannot record or play back any sound from Mixbus if you
select the Dummy system (the Dummy option may not be available on your system).
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Device:

• Select your preferred audio interface from the pulldown list. For best results, you should use Mixbus
with a high-quality audio interface.

Device Control Panel:

• This opens the control panel of the audio interface that has been selected on the “Device” list.

Sample rate:

• A drop down list with all sample rates supported by your selected audio interface will be displayed.

Buffer size:

• In conjunction with sample rate, buffer size is used to control latency and to manage hardware
resources. See more here.

Hardware output latency:

• When audio is routed to outboard equipment and back to Mixbus it must undergo a conversion from
digital to analog (DAC), the time it takes for this conversion can be entered to compensate for latency
so that all audio remains time aligned (This process can be automated, see “Calibrate Audio” below).

Mac OSX and Linux provide separate pull-down menus for the Input and Output devices.
This allows you to use Mixbus on laptops or other devices that only have a sound output,
but no input.
*

A note about internal sound cards on Windows: Mixbus currently only works with
soundcards that have an ASIO driver. If you soundcard doesn’t have an ASIO driver ( some
internal soundcards do not) then you can install a thrid-party utility, ASIO4ALL, to provide
an ASIO driver for your soundcard.

*

On Windows, using ASIO devices, please make sure that the Buffersize selection is not
blank. With ASIO devices, the device’s control panel defines the buffersize, not Mixbus.
Mixbus is supposed to query the device’s buffersize and fill the selection box automatically.
But in some setups, this does not work. We plan to fix this problem in a future release.

!
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Hardware input latency:

• When audio is routed from outboard equipment and back to Mixbus it must undergo a conversion from
analog to digital (ADC), the time it takes for this conversion can be entered to compensate for latency
so that all audio remains time aligned (This process can be automated, see “Calibrate Audio” below).

Calibrate Audio:

• This calls up a latency measurement tool with step by step instructions on how to compensate latency
introduced by external equipment and the digital to analog, and analog to digital conversion process.

MIDI System

• This selection will default to the MIDI framework supported by your OS.
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Latency and Buffer Size
Latency

Latency is a measure of the time it takes for digital audio to pass from input to output (including associated
hardware). If audio arrives at the output later than desired then it is considered to have high latency. Due to
the nature of computers and digital audio, there will always be some latency in a DAW. If the latency is
minimal, we may not be able to perceive it. Low latency is desirable for recording, tracking, overdubbing,
etc.

Buffer

A buffer is an area in the computer’s memory that is set aside to temporarily store digital audio. By
temporarily storing digital audio we can prevent any interruption in the flow of sound. Interruptions will be
heard as clicks and pops. We can set the size of the buffer to achieve a specific delay, usually measured in
milliseconds. The memory stores samples of audio, the more samples it can hold the more latency will be
exhibited. Hence, the size of the buffer also determines the latency. Setting the buffer too small can cause
buffer underruns with audible pops and clicks. Setting the buffer too large might cause a noticeable delay in
the sound or operation.

Sample rate Vs. Buffer size

Sample rate and buffer size are like two sides of a see-saw. The higher the buffer setting (for a given
sample rate) the higher the latency, the lower the sample rate (for a given buffer size) the higher the
latency. If the idea of a lower sample rate causing higher latency seems counter-intuitive don’t worry,
usually the session’s sample rate is set for other reasons, and the latency issue is addressed with buffer
size.

Buffer size while mixing or editing

While mixing or editing, a large buffer will prevent pops and clicks at the expense of a slightly less
responsive system. This lack of responsiveness may be evident when pressing the play button and a slight
delay occurs before audio can be heard. Many times this delay is so small you may barely notice it. So while
mixing or editing, a larger buffer is advisable. A buffersize of 1024 samples is typical.
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Buffer size while recording

If monitoring through a DAW and an artist needs to listen to themselves while recording, such as a vocalist
listening to a headphone mix, then low latency audio will be required. Adjust the buffer size to achieve a
latency of 10 ms or so. A smaller buffer is achievable during recording by keeping the plug-in usage as low
as possible. A value of 128 samples is typical.

Our friends over at Sound on Sound have some great information on this topic
http://www.soundonsound.com/sos/jan05/articles/pcmusician.htm

Hardware Vs. Software Monitoring

If you choose “Mixbus does monitoring” then:

1. Mixbus can control which channels you are hearing (subject to the Monitoring rules … see section
“Monitoring” ). So, for example, Mixbus will only “monitor” the inputs that are currently record-armed.

2. The inputs will automatically be mixed into the master output of Mixbus, so you can hear them in
context with your mix.

3. You will be able to hear any effects (eq, compression, and/or plug-ins) that are applied to the tracks.
4. HOWEVER: the signal path through your converters, Mixbus, and plug-ins can add up to a significant

latency. The latency can be minimized by using a small buffer size, and avoiding the use of plug-ins
with long latency

If you choose “Hardware does monitoring” then:

1. You will not incur the latency penalty of getting into and out-of the computer. However if your interface
or mixer uses digital signal processing, there may still be some latency.

2. You must use your external I/O controls, and/or mixing console, to build monitor mixes for your talent.
3. Mixbus cannot control which channels you are hearing. Record-arming a track in Mixbus will not

automatically route that track into the monitor mix.

Some artist maybe more sensitive to latency than others. If the artist is not performing as
expected, one thing to check is latency; even if the artist does not perceive or complain of
latency. In some anecdotal cases, singers have been bothered by the “comb filter”
(frequency cancellations) caused by a very short delay between their headphones and
internal vocal cavities. In this case you can try decreasing the latency to see if that helps.
(sometimes increasing it will also help). If the singer finds this objectionable then you should
consider a hardware-monitoring setup instead.

*
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On Windows, using ASIO drivers, you must choose the buffer size from the device’s control
panel. Mixbus does not have control over ASIO buffer sizes.

!
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Primary Windows: Editor and Mixer
This document will reference the Editor and Mixer windows. These are the two primary windows that are
used to operate Mixbus.

The Editor Window
When you first launch Mixbus, you will be presented with the Editor window. The editor window presents
the Audio and MIDI tracks that make up your session. You can reorder, resize, and rename the tracks from
the Editor window. Generally speaking, the Editor window provides all the features you need to edit your
arrangement, while the Mixer window allows you to balance the sounds in the arrangement so they can all
be heard.

The top of the editor screen provides the transport buttons ( play, stop, etc) as well as the main clocks
that display the location of the playhead in the session. Just below the transport buttons are the* editor
tools* which are used to edit your arrangement.
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Just below the editing tools, you’ll see the ruler bars which help to indicate your timeline position in various
formats – timecode, bars/beats/ticks ) – and it also provides a place to set “Markers” and set your Loop and
Punch ranges. Learn more about the rulers here.

The main editor canvas shows your tracks, and any regions (audio clips) that are present.

On the right of the editor is “Editor List”. The Editor List may be shown and hidden via the “View” menu.
Learn more about the Editor list here.

On the left of the editor is the “Editor Mixer”. The Editor Mixer shows the mixer channelstrip for the
currently-selected track or bus. The Editor Mixer may be shown and hidden from within the “View” menu or
the associated keyboard shortcut (Shift+E by default).

The bottom of the editor is the Summary view. The summary view shows a light grey box that encompasses
your current view, with the entire session behind it. You can move the grey box around your session to
quickly move your view. The Summary may be shown and hidden via the “View” menu.

Mixer Window
The Mixer Window may be shown using the “Window” menu, or the keyboard shortcut (ex: Alt/Opt+M) which
toggles between the editor and mixer windows. If you have the editor and mixer windows on different
monitors (screens), then the “Toggle Editor/Mixer” shortcut does not have an effect.

When viewed in the Mixer Window, Mixbus resembles a traditional analog console. Input Channels are on
the left, while the busses and master are located on the right side.

The audio signal flow is generally left-to-right. The signal starts at the input channels (which might be live
inputs, playback tracks, MIDI tracks, or virtual instruments), progresses through the mix buses, and into the
master. The channel’s EQ, Filter, Compressor, panning, bus summing, and master bus processing are
performed inside the proprietary Harrison channel plug-in.
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In Mixbus, like other audio workstations, each recording track has its own mixer strip. These mixer strips
resemble the input channels of a traditional analog mixing console. Input channels can be configured to be
mono or stereo and by default include all the DSP processing that makes up a real console channel. This is
the major difference between Mixbus and other DAW mixers. No time is wasted searching for and adding
the necessary high-quality mixing tools.

Just to the right of the input channels are the 8 mix bus channels. Mix bus channels are used to collect the
outputs from the input channels into groups. For example, in a typical music project, you might send the
drums to mix bus 1, the vocals to mix bus 2, instruments to mix bus 3, and use mix bus 4 as a parallel
effects bus, like reverb. This allows you to easily adjust the relative levels of these groups and apply
processing to them.

The master channel is the final mixer strip on the right. Typically, the master channel will be connected to
your monitoring system (speaker outputs). The output of the Master channel is the final output of your

You can double-click on a strip’s “name” to toggle between wide and narrow mode.
Shift+double-clicking a strip will toggle ALL of the strips together. Toggling all of the strips to
a “narrow” view will allow more channels to fit on the screen.
*
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project i.e. your 2 track master file. This output is rendered to the final .wav file when you export the
session.

The monitor section on the far right is has been made available for those who do not have access to a
dedicated external monitoring section.

Adding Tracks and Buses >>
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Adding Tracks and Buses

Adding Tracks
This section describes how to add audio tracks. If you wish to import existing media take a look at Importing
Files section. If you would like to add MIDI tracks click here.

When you are ready to record, you must create tracks. Use the “Add Track/Bus” function which can be
found in the Session and Track menus. You can also create tracks by right clicking in the gray track area
under the track headers, in a empty mixer window space, or by clicking the blue “plus” button at the top of
the mixer’s left-side panel.

You can create as many tracks as needed. Mixbus supports Mono and Stereo tracks only. If you have
created some track templates, the templates will appear as additional choices in the “Channel
Configuration” menu.

Mixbus also allows the creation of additional busses which may be used to combine tracks together into
groups for further processing or utilitarian tasks such as headphone cue feeds. These additional Busses
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(not to be confused with the mix busses) do not have the processing or delay compensation features of the
mix busses. In general, the built-in Mixbus summing engine is sufficient for music projects that match the
scale of the 8-48 track records we all love. But if your project is large enough to need additional bussing,
they are available here.

The add Track or Bus dialog box

Options within the dialog box

• Add: Multiple audio tracks can be added at one time via the “add” setting.

• Tracks types that may be added:
◦ Audio Tracks
◦ Midi Tracks
◦ Busses

• Name: A custom name may be assigned to the audio track before it is added. If multiple audio tracks
are added they will be sequentially numbered.

• Configuration: Allows for stereo or mono tracks with mono being the default. This is only for audio
tracks, not MIDI.

• Record Mode: Options are for audio only and include:
◦ Layered ( default ) – in this mode, recording over existing audio will create a new region “layer”

atop the existing audio
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◦ Non Layered – in this mode, recording over existing audio will replace the existing region with a
new region, in the same layer

◦ NOTE: you can change a track’s record mode by right-clicking in a track header and selecting
the options under “Record Mode”

• Instrument: Setting is for MIDI tracks only.

• Group: Assigns the new audio track to a group. Whether a group is selected or not you can change
the group assignment at anytime after the audio track is added.

• Insert: Determines where in the Mix/Edit window the new audio track will be placed.
◦ Before Selection: In the Mix window this will place the new track to the left of the selected track.

In the Edit window this will place the new track above the selected track.
◦ After Selection: In the Mix window this will place the new track to the right of the selected track.

In the Edit window this will place the new track below the selected track.
◦ Last: This will place the new track in the last position in the Mix/Edit window.

Once all choices are made click the Add button at the bottom right corner of the dialog box to add the new
audio track.

NOTE: You can re-order tracks anytime, using either the Editor List, or by selecting tracks
and then using the Track menu to move them up/down.*
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Managing Tracks
Mixbus provides several methods to rename and re-order your tracks to help your workflow. You can
rename and reorder tracks from the editor view or the mixer view.

The editor list is a great place to manage your tracks, because it typically shows many more tracks at the
same time, and you don’t have to scroll the main editor canvas to rename or re-order tracks.

Naming Tracks

• In the editor window, double-click on the track name to edit it. Press TAB to advance to the next track.
• In the editor list, “Track/Bus” tab, double click the track name to change it. Press TAB to advance to

the next track.
• In the mixer sidebar, right-click on the mixer-strip name, and choose “rename” from the popup menu.

Re-ordering tracks
There are 3 ways to change the order of tracks:

• In the editor window, you can select tracks by turning them red (clicking on them to select them), then
use the menu item Tracks->Move Tracks up/down (or the associated keybindings) to move the
selected tracks up and down together.

• In the editor list, you can drag and drop tracks to reorder them.
• In the mixer sidebar, you can drag and drop tracks to reorder them.

No two tracks or buses can share the same name. If you try to rename a track to something
that already exists, Mixbus will show an error dialog (when practical), or append a number
to the end of your newly named track.
*

You can’t rename a track while it is record-enabled, because the track name defines the
resulting audio wavefile name.*
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Audio Input & Output

Input
Mixbus uses an internal audio routing system to make audio connections between Mixbus, your sound I/O,
and other parts of Mixbus.

With a new session, Mixbus makes these connections:

• The master bus is connected to the first two physical output ports.
• Track/Bus inputs are assigned sequentially from the physical inputs whenever a new track/bus is

created.
• The Auditioner and the Click are connected to the first two physical output ports.

However it is possible to change any or all of these connections using The Audio Connections Manager
window via Window->Audio Connections

Audio Connections Manager

The Audio Connections Manager window allows you to connect any output port to the track/bus input:
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In the above image an audio interface with 16 inputs is shown (viewed via the hardware tab on the left side).
The bottom tab labeled “Mixbus Tracks” shows a total of 4 tracks in the session. The green dots indicate
Mic1 is connected to the Mixbus channel strip input labeled VOX and Mic 2 is connected to the Mixbus
channel strip input labeled GTR. The other two channels labeled keys and drums have no connections
because in this example those tracks had been recorded previously. This is an example of having drums
and keys already recorded and a vocalist and guitar player coming to the studio for an overdub session.

Note: audio connections use a floating-point 32-bit format, which means that headroom is
essentially unlimited. You don’t have to worry about “clipping” the sound when routing from
one application to another. You may route a single output port to several inputs, and an
input port can be routed from several different outputs (the summing of these signals is
done automatically).

*
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Track I/O Selections

Track inputs can also be assigned directly from the channel strip, by clicking on the “shortcut” input button
near the top of the channel strip (not to be confused with the “monitor input” button just above it labeled
“In”). Left clicking on the “shortcut” button calls up a simplified menu.

The image above shows a channel strip “shortcut” button that has no input assigned to it. If you are working
with imported audio this is fine (note: typically audio such as this is stored on a disk. Notice in the upper
right corner the the “Disk” indicator).

The image above shows 4 channel strips “shortcut” buttons which have been assigned inputs. Mic 1 and 2
or are on the first two channel strips and Line 3 and 4 have been assigned to the next two channels (note: in
the upper center of each channel strip the “In” indicator).
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Output

For convenience, the Master Bus has an “output” button which can be used to select the ports that the
master bus output will feed. Normally, you connect the Master Bus output to your audio interface outputs.

Harrison Consoles Mixbus v3 - 1

Page 55 of 420



In the above image the master bus has both of its outputs connected to the audio interface “Mon” or monitor
output.

Navigating the Editor Window >>

Note: The “shortcuts” may not display a connection until you select it from the menu. These
are provided as a quick way to override the current setting, not a method to see what the
track is connected to.
*
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Navigating the Editor Window
Panning and Zooming in the Editor Window

Basic Transport Features

Summary View
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Panning and Zooming in the Editor Window

Panning
Panning in the editor window is accomplished by grabbing the gray box in the summary view window and
dragging it, or by clicking the arrow buttons at the left and right sides of the window. See graphic below.

Additionally, panning can be done with the mouse scroll wheel.

Zooming
Zooming in Mixbus is a fast way of navigating the Edit Canvas. A couple of methods are available.

Zooming using the mouse scroll wheel while holding the Ctrl key causes the zoom action to occur around
the mouse cursor. (for most users, this is the preferred method)

The keyboard + (plus) and – (minus) keys are another way of maneuvering.

Additional commands can be found under View>Zoom

Zoom to Session: Brings the entire sessions audio clips into view.
Zoom to Selection: Brings the selected clip or clips lengths into view
Zoom to Selection (Width and Height): Same as above but adding clip height
Toggle Zoom State: Alternates between the last 2 zoom states

Waveform Scale
Additional waveform displays can be accessed in Menu>Edit>Preferences>Editor

• Linear: Displays the audio waveform in a linear fashion. This setting does not change the gain of the
signal, it is strictly a visual aid.

In the editor panning usually refers to a left or right movement of the graphics. In the mixer
panning refers to the audio being directed to the left or right channel.*
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• Logarithmic: Displays the audio waveform so that quiet sounds can be more easily seen on the
screen. The display is disproportionate. This setting does not change the gain of the signal, it is
strictly a visual aid.

Zoom Focus

Menu: View>Zoom Focus

Zoom Focus provides a anchor point by which keyboard zooming occurs around. For example, some users
expect the screen to zoom towards and away from the playhead (this is the default).

Additional zoom focus options are available under View>Zoom Focus. They include:

• Left : leftmost side of the summary view is anchored
• Right : rightmost side of the summary view is anchored
• Center : center of the summary view is anchored and zooming occurs around it
• Edit Point : edit point is anchored and zooming occurs around it

When zooming with the keyboard + (plus) or – (minus) keys always keep in mind your
Zoom Focus. (see below)*
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Above image: Summary View circled in red.

Zoom to Time Scale and Number of visible tracks:

In the above image circled in red: the box on the left is the “Zoom to Time Scale” function and provides
quick zooms of the time axis from 10 milliseconds to 24 hours, as well as options to “Zoom to Session” and
“Zoom to Range/Region Selection”. The box on the right is the “Number of visible tracks” function and
provides quick zooms of the height of all visible tracks from 1 track to 48 tracks, plus “Fit all tracks” and “Fit
Session” actions.

Combining zoom functionality with The Summary View makes for a powerful set of
navigation tools.*

Additional waveform display options can be found in Menu>Edit>Preferences>Editor. Click
here for more.*
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Transport, Markers, and Rulers
The transport buttons control the playhead’s location, speed and record-enable.

Transport controls are (from left to right):
MIDI Panic: Send note off and reset controller messages on all MIDI channels
Metronome: Enable/Disable audio click ( see Recording to learn more )
Rewind: Go to session start or start marker
Fast forward: Go to session end or end marker
Loop playback: Plays loop range
Play range/selection: Plays the selected range or region, then stops
Play: Activates “play”, starting from the current playhead location (space bar)
Stop: Stops the transport (space bar again)
Record-enable: Toggles mater record-enable ( you must also have tracks rec-enabled, to record on them)

Jog/Shuttle control: Allows for increased or decreased playback speed.
Right-click to adjust the speed display, mode, and max speed settings.

• Units:
◦ Percent or Semitones.

• Mode:
◦ Sprung: control returns to center position when mouse is released.
◦ Wheel: control remains at its last location.

• Maximum speed:
◦ adjustable from 1.5 X to 8X of “play” speed.

Auto Return
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When turned on, the playhead will return to the position in which it started when the transport was last
engaged.

Primary Clock

Right click in the window to select:

• Timecode
• Bars:Beats
• Minutes:Seconds
• Samples
• Display delta to edit cursor ( if this is checked, the clock displays the elapsed time between the

playhead and the mouse cursor; this allows you to measure the time elapsed between 2 points on the
timeline )

Secondary Clock

The secondary clock is identical to the Primary clock, but it gives the user a choice to show an alternate
clock format simultaneously with the primary clock format.

Maximize Mixer/Editor space

Maximize Editor space command can be found under menu> View. Enabling this function causes the editor
window to occupy all screen real estate. The title bar will be hidden as will the task bar. The same function
is available for the Mix window. To exit this mode uncheck Maximize Editor in Menu>View.

Summary View >>
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Ruler Bar

The ruler bar runs along the top of the edit canvas. A number of timelines can be shown via View>Rulers, or
by right clicking in the blank area just to the left of the marker labels.

Available Rulers available include:

• Min:Sec Minutes and Seconds elapsed since time “0”
• Timecode :
• Samples :
• Bars & Beats
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Marker bars in the ruler area

Marks can be set in the following ruler areas:

• Meter ( a meter marker initiates a new musical timebase )
• Tempo ( a tempo marker initiates a new musical tempo )
• Range Markers ( Ranges can be exported simultaneously in the Export dialog )
• Loop/Punch Ranges
• Markers ( Location markers are typically used to quickly locate to a new time in the project ). The “q”

and “w” keys jump to the next/previous marker.
• CD Markers ( CD markers are used in the Export dialog to define CD track markers )

To set a marker in any of the rulers, simply right click to pull a dialog box.
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The Meter Marker:

The Tempo Marker Dialog Box:

The Range Marker Dialog Box:

The Loop/Punch Ranges Marker Dialog Box:

The CD Markers Dialog Box:
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Video Timeline Ruler

The “video timeline” ruler can show a thumbnail of a video, if you have imported a video file.

Summary View >>
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Summary View
The “Summary View”, located at the bottom of the edit window, is a condensed view of the entire session
between the “start” and “end” markers.

Within the Summary view you can see a small representation for each audio/midi region on the timeline, and
a lightly shaded box that indicates your current edit canvas view. You can grab the light shaded box to pan
up, down, left, or right. And you can grab the edges of the light shaded box to stretch or shrink (zoom) in
either dimension. Additionally, arrow buttons are provided at either end of the view box for maneuvering the
shaded box if you prefer.

The height of the view box can be made larger or smaller by grabbing its top border and dragging.

In the image above three regions are shown with the shaded box fully encompassing the region contained in
track 2, indicating it will be fully visible in the edit canvas. The start of regions 1 and 3 will not be visible but
the regions ends will be.

Status Bar >>
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Status Bar

• File: Audio file format

• TC: Time code format

• Audio: Sample rate / Buffer latency

• Buffers: p: playback buffer c: capture buffer

• DSP: Time required to process an audio block / duration of the audio block. It displays the worst-case
maximum (not average).

• X: Number of xruns (see details below)

Disk: Remaining disk space for recording audio at current settings.

By default, Mixbus requires significantly more CPU resources than a typical DAW. You might be exceeding
the capabilities of Mixbus on your system.

The typical methods to minimize the CPU load are:

• increase the “buffer size” in the Audio Setup dialog
• use a lower sample rate, reduce the number of tracks
• reduce the number of plugins in your session.
• And of course using a faster computer, with more CPU cores, is desirable.

The CPU meter on your computer averages the cpu usage over a very long period (perhaps one second).
In digital audio, the timing is much more sensitive. When the soundcard passes us a buffer, then we have to
wake up, process the audio buffer, and return it to the soundcard before the soundcard needs to play it out.
If we don’t wake up in time, or we don’t get finished in time, then you hear a “click” caused by the (we call
these xruns, short for over-run or under-run).

In the case of a 1024 buffer size, this has to be done within (1024/44100) 25ms, or about 1/40th of a
second.
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This is complicated by the fact that it’s the OS’s job to “wake us up” and tell us that the soundcard has some
data for us. Some OS’s and drivers are better at this than others. But let’s say it takes 5ms before we are
even alerted that some data is available. We now have 20ms left to process the audio. If it takes us 10ms to
process the audio, then we are finished within 50% of the allotted time and that’s what we display in the
meter. This is a very accurate indication of your computer’s ability to process audio.

This also explains why the selected buffersize is so critical to the DSP load. A 256-sample buffersize is
about 6ms, so if your computer sometimes waits 5ms after receiving the soundcard interrupt before it
“wakes us up”, we only have 1ms remaining to do our work.

For more information on factors impacting the performance of your computer please see this video:
CPU Performance vs. Real-Time Performance in Digital Audio Workstations
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Mixbus Conventions & Tips
Selection:

• The ESC key will always clear the current selection, so there will be no selected tracks, regions,
notes, or automation control points.

Mixbus Knobs and Faders:

• When a knob is in the “default” position, the indicator is very dim. This allows you to scan the mixer
for settings that are not at default.

• Mixer strip knobs can be double-clicked to instantly return them to their default value.
• Holding Ctrl/Cmd while turning the knob provides a fine-adjust mode, while Shift+Ctrl/Cmd allows

super fine adjustments.
• Mixbus knobs and sliders incorporate an “in-on-change” feature. When any knob or fader is clicked

and changed, it will automatically enable the control by also setting the “in” or “on” control for that
section.

Default Signal Routing:

When you make new tracks, they are automatically assigned to the master channel to allow the signal to be
monitored quickly.

Floating-Point processing:

Mixbus uses a floating-point internal architecture, it is possible to exceed 0 dBFS (decibel full scale i.e: the
loudest sound in the digital domain) on the channel and mix bus strip meters without ill effects. For this
reason there is no colored indication of overly-loud signals on input and mix bus strips.

Master Bus Volume:

If you are not using the monitoring section built into Mixbus (Session>Properties>Monitoring tab) you will
use the volume knob provided by your computer or I/O device to control the loudness of your speakers. If
you are using the fader of the Master strip to control speaker volume, remember to set the fader to the
correct level before you export your project to a .wav file, since the master fader level is applied to the
export. Use the K-14 meter to verify that the export volume is at a reasonable level.
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Right-click:

Mixbus uses the right mouse button for many, many features. Try right-clicking on tracks, regions, mute
buttons, solo buttons, group panes, regions, selected ranges, markers, mixer redirects, clocks, the region
list, and the marker bar area. Each will launch a context menu that provides useful features.

Shift+Right-click: (Delete shortcut)

Shift+Right-click is a shortcut to Delete objects. Some examples include regions, plugins, and automation
control points. Holding shift while right-clicking on one of those objects will delete it.

Shift+Ctrl-click: (applies to ALL tracks)

Holding Shift and Ctrl (Shift+Cmd for Mac users) while clicking on a track button will apply that operation to
“all” tracks. Some examples include the Mute, Solo, and Record-arm buttons. Clicking on those buttons with
Shift+Ctrl held will apply your click to ALL tracks. This is a fast way to un-solo all tracks, or to rec-arm all the
tracks in a session simultaneously.

Middle-click: (non-latching mute/solo)

Clicking a Mute or Solo button with the middle mouse button will trigger a “non-latching” button push; this
means that when you release the mouse button, the solo/mute button will also release. This provides a
quick way to temporarily mute or solo a track while you hold the mouse down.

“If you asked a hundred engineers, mixers and producers to define the “perfect console” you would
probably get a hundred answers. The answers, however, would all contain the same salient points.
The “perfect console” would have totally transparent sound, capturing the true musical quality of all
performances. It would have unlimited features, facilities, and functions. It would perform all required
tasks with a minimum of operator effort. It would be totally reliable and require no preventive or corrective
maintenance…
You can spend the rest of your life looking for the “perfect console”. You’ll never find it. You will find,
however, that we have what you need.”- Harrison MR20 brochure, circa 1982
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Audio Tracks
A track is the fundamental building-block of a Mixbus session. You can create new tracks by creating empty
tracks ( using the New Track/Bus dialog ) or by Importing existing audio files as new tracks. Mixbus
supports audio tracks and MIDI tracks. The track type (audio or MIDI) defines what kind of data you will see
in the editor.

An audio track is a series of audio regions, sequenced in a Playlist, that receive the same channel
processing (the eq, compressor, plugins, panning, bussing, etc )

You can record new audio into an audio track at any time. Any underlying audio will be preserved, so you
can always revert to the previous track if you want to.

The Playlist defines the order of audio regions (files), as well as properties such as their mute state, volume
levels, fade in/out, etc. You can edit the Playlist using various editing tools and features:

• Object (Region) Editing
• Range Editing
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Recording

Click above for video instructions.

Following these steps will quickly get you recording tracks

1. Set the tempo (optional). Allows use of the metronome feature and will make editing the track much
easier. If the Tempo ruler is not showing you can open it via Menu>View>Rulers>Tempo. A default
tempo of 120 BPM is established. The BPM can be changed by left clicking on the marker.

2. Add a track by left clicking in a blank area where track headers are located or via Menu>Track> Add
Track or Bus.

3. Insert any plug-ins you might like such as reverb and/or delay.
4. If you are using an audio interface or mixer for low latency monitoring you can disable Mixbus for

monitoring (Menu>Preferences>Audio Tab>Monitoring).
5. The track you would like to record to must have its inputs connected to the hardware channel in which

the microphone or instrument is connect to. Near the top of the channel strip is a button to facilitate
this.

6. Arm the track you would like to record to by clicking the red record button in the track header.
7. Click the master record enable in the transport section and then click play or space bar to roll the

transport. Alternatively, you may roll the transport first and then click the transport record button.
As the transport rolls you can click the record button at any time to punch in or out. When the
transport is stopped the master record will be disabled.
(if you are recording yourself then “roll record” is useful. Click “Shift” + “space bar” or “3” on the
number pad).

Punch Recording

1. Pre select a range to record to (example:the second measure) by dragging the mouse and creating a
range.

2. enable the punch markers by right clicking in the range and selecting “Set punch from selection”
3. arm the track(s) and the master record on the transport. As the transport rolls, recording will only

occur as the playhead rolls over the defined area protecting existing audio before and after the range.
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For information regarding latency click here

Recording Modes:

• Layered
• Non-Layered

The “Tape” track mode creates tracks which may not be edited, and in which the underlying
file is overwritten with new data when recorded into (i.e. destructive recording).
—-X

!

NOTE: due to the underlying file system, Tape track mode is not available on Windows*

Harrison Consoles Mixbus v3 - 1

Page 75 of 420



Monitoring
Monitoring

“Monitoring” is the process of hearing the prerecorded tracks (and/or hearing yourself) while the transport is
playing. There are several options that control how Mixbus will monitor the inputs of each track.

At the top of each audio channel, there are selection buttons for “In”, and “Disk”:

If the “In” button is selected, then the input to the track will be heard. If the “Disk” button is selected, then
you will only hear the playback of the track. If neither button is selected, then Mixbus will use automatic
monitoring to switch between In and Disk ( this is represented with an outline around the currently-selected
option)

Mixbus has 2 global preferences that control automatic monitoring. You select the mode in Preferences-
>Audio->Monitoring:

Audio Hardware Does Monitoring This option is best used with audio interfaces that have
the ability to monitor the inputs to the interface. Some interfaces come with a software
application to control this while others may have a knob or button on the interface to allow
direct monitoring. Other interfaces may need to be configured using the operating system’s
volume control application. In this case Mixbus will never automatically monitor the input,
because you are going to use your hardware device to hear yourself. When Hardware
monitoring is available, it is generally a better option because it provides lower-latency
monitoring. However it does not allow you to hear the effect of Mixbus’s processing or
plugins, because you are bypassing the computer in your monitor path.

*

Mixbus Does Monitoring This setting is also known as “software monitoring”. With this
setting, when Mixbus is recording audio it will route the inputs of the record-enabled tracks
through the tracks instead of playing back the previously recorded audio. This is best used
*
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Automatic monitoring is also affected by the “Auto Input” mode, which is found in the Transport menu. “Auto
Input” is enabled by default. When Auto-input is enabled, then Mixbus will monitor tracks any time that you
are aren’t playing. This feature allows easier setup of your instrument, or communication among members of
a band, because all the live mics are passed through to the master bus output so everyone can hear them.

Finally, there is an option to enable “Tape Machine Mode”. If “Tape Machine” mode is enabled, then Mixbus
never monitors the input of an unarmed track; even if auto-input would normally cause it to monitor.

Mixbus Monitoring Modes Chart

The following chart shows how the monitoring interacts with various settings in Mixbus.

Monitor
Mode

Is The Track Rec
Enabled?

Is The Master Rec
Enable On?

Auto Input
Status

Transport
Mode Meter Monitor

Normal No No On Stop Input Input

Normal No No Off Stop Track
(silence)

Track
(silence)

Normal No No On Play Track
(Audio)

Track
(Audio)

Normal No No Off Play Track
(Audio)

Track
(Audio)

Normal No Yes On Stop Input Input

Normal No Yes Off Stop Track
(silence)

Track
(silence)

Normal No Yes On Play Track
(Audio)

Track
(Audio)

Normal No Yes Off Play Track
(Audio)

Track
(Audio)

Normal Yes No On Stop Input Input

Normal Yes No Off Stop Input Input

Normal Yes No On Play Input Track
(Audio)

Normal Yes No Off Play Input Input

on systems that work well with very low buffer sizes (128 at 44 or 48 kHz or 256 at 96 kHz).
Very small buffer sizes are used to minimize the monitoring latency.
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Normal Yes Yes On Stop Input Input

Normal Yes Yes Off Stop Input Input

Normal Yes Yes On Play Input Input

Normal Yes Yes Off Play Input Input

Tape
Machine No No On Stop Track

(silence)
Track
(silence)

Tape
Machine No No Off Stop Track

(silence)
Track
(silence)

Tape
Machine No No On Play Track

(Audio)
Track
(Audio)

Tape
Machine No No Off Play Track

(Audio)
Track
(Audio)

Tape
Machine No Yes On Stop Track

(silence)
Track
(silence)

Tape
Machine No Yes Off Stop Track

(silence)
Track
(silence)

Tape
Machine No Yes On Play Track

(Audio)
Track
(Audio)

Tape
Machine No Yes Off Play Track

(Audio)
Track
(Audio)

Tape
Machine Yes No On Stop Input Input

Tape
Machine Yes No Off Stop Input Input

Tape
Machine Yes No On Play Input Track

(Audio)

Tape
Machine Yes No Off Play Input Input

Tape
Machine Yes Yes On Stop Input Input

Tape
Machine Yes Yes Off Stop Input Input

Tape
Machine Yes Yes On Play Input Input

Tape
Machine Yes Yes Off Play Input Input
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The Click (Metronome)
The Metronome (or click) can be activated by toggling the Metronome button in the upper left of the edit
window, or the associated keybinding.

Enabling this function allows Mixbus to generate a click that musicians can play along to. If a song is
recorded to the “click” then editing can be eased with “snap” settings that automatically select snap to
measures, beats, or subdivisions of a beat. ( see Editing with the Grid Loop Record >> for more details )

Once enabled, a click sound will be produced when the transport is engaged. An audible click with an
emphasis will be produced at the first downbeat of every bar.

Right clicking on the metronome button is a shortcut to open the Preferences dialog box, where more Click
settings can be found including the specific sound and volume of the click.

By default, the metronome connects itself to the first 2 soundcard outputs, or into the Monitor if you are
using a monitor section.

Sometimes (particularly if you switch the “monitor” section on and off), the metronome will lose its
connection. To re-connect it, open Window->Audio Connections and restore the connection from the
metronome to your speaker outputs, like this:

If you are recording to the click, you should take care to set the tempo for the song before
you start.*

An audio file can be substituted for the default click sound.*
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Loop Record

This short video demonstrates how to loop record.
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MIDI Tracks

MIDI tracks are just like regular tracks, but they store MIDI performance data on the timeline, rather than
audio data.

Otherwise, MIDI tracks are identical to audio tracks; they can have MIDI inputs and outputs, audio inputs
and outputs, plugins, and they have the full complement of Mixbus EQ/Compressor/bus sends. MIDI tracks
are intended to host virtual instrument (VI) plug-ins, which will render the MIDI data into audio which is then
available to mix within the Mixbus mixer. It is also possible to route the MIDI data directly to a MIDI
synthesizer device, and then patch the audio (if desired) back into the same MIDI track, thereby
incorporating the external device as if it were a VI.

MIDI data may be generated by importing a MIDI file, by playing a MIDI instrument into the track, or by
drawing notes with the Draw tool. Each time you draw or record MIDI notes and controls, Mixbus creates a
MIDI region with a corresponding MIDI file inside the session folder.

MIDI editing was designed to operate with the same conventions as Mixbus’s audio region editing. You can
cut, copy, move and trim MIDI regions.

To create a new MIDI track, select “Track->New Track/Bus” from the main menu.

A MIDI Primer has been provided here.

Because MIDI data is always recorded into a MIDI file, this has some implications for control
data. You can only draw controller automation underneath an existing MIDI region. These
controller moves are part of the MIDI region and will move with it. Note that you can still
write fader & other mixer-strip automation linearly on the track.

*
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Adding MIDI tracks

Adding MIDI tracks
This section describes how to add MIDI tracks. If you wish to import existing media take a look at Importing
Files section. If you would like to add audio tracks click here.

To create a new MIDI track, select “Track->New Track/Bus” from the main menu or, in the edit window right
click in the blank area in which a track header would be found. Additionally clicking on the blue + (plus)
button at the top of the window shown in the image below will also open the “add track” dialog box. For more
on working with plug-ins click here.
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The add Track or Bus dialog box

Options within the dialog box

• Add: Multiple MIDI tracks can be added at one time via the “add” setting.

• Tracks types that may be added:
◦ Audio Tracks
◦ Midi Tracks
◦ Busses

• Name: A custom name may be assigned to the MIDI track before it is added. If multiple MIDI tracks
are added they will be sequentially numbered.

• Configuration: Setting is not applicable to MIDI. (it is grayed out)

• Record Mode: Setting is not applicable to MIDI (it is grayed out)

• Instrument: By default, a new “MIDI” track will be created with a very basic synthesizer called
“ReasonableSynth”. This built-in utility allows you to audition your MIDI performances without any
plug-in parameters to set. It may be deselected and substituted with another plug-in via the drop down
list, or after the track has been added to the session. For more on working with plug-ins click here.

• Group: Assigns the new MIDI track to a group. Whether a group is selected or not you can change the
group assignment at anytime after the MIDI track is added.
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• Insert: Determines where in the Mix/Edit window the new MIDI track will be placed.
◦ Before Selection: In the Mix window this will place the new track to the left of the selected track.

In the Edit window this will place the new track above the selected track.
◦ After Selection: In the Mix window this will place the new track to the right of the selected track.

In the Edit window this will place the new track below the selected track.
◦ Last: This will place the new track at the last position in the Mix/Edit window.

Once all choices are made click the Add button at the bottom right corner of the dialog box to add the new
MIDI track.

Once a MIDI track is added you will find a MIDI input Enable/Disable button near the top of the channel
strip.
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Setting up an external MIDI device

A step by step guide to record MIDI performance data.
1. Plug in your external MIDI equipment into the input of your MIDI interface or USB connector on your
computer.

2. During session set up be sure system MIDI is enabled (CoreMIDI for Mac and MME for Windows).

3. Add a MIDI track(s) to your session. Click here for more on adding tracks. By default “Reasonable Synth”
plug-in will be inserted into the redirect. You can select a different plug-in at this point or it can be changed
after the track has been created. More on Plug-ins here
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4. Route the system MIDI to the track input. In the image below the MIDI device happens to be called
“Launchkey 25 capture”. You should look for the name of your device here.

A convenient set up is to switch to the Edit window and turn on the Mixer Editor
(Menu>View>Show Editor Mixer). This way you can manage the MIDI channel strip and
view your performance as you record it. More on Editor Mixer here
*
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5. Enable MIDI input. The default is on as shown in the image below. Click on the green MIDI connector to
disable if you don’t want to hear the MIDI input.

6. Be sure to set the channel strip to monitor input.

7. Record arm the MIDI track
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8. Record arm the master record button in the Edit window, roll the transport and record your performance.

9. Once a performance is recorded (or perhaps you have imported MIDI data to the track) you can send the
audio output to a track to be recorded (bounced). Click the output connector (circled in red) and route the
MIDI output. In this image it has been routed to a stereo audio track (audio 7). Click here for more on
recording.
Additionally you can route MIDI performance data to outboard equipment via your MIDI interface (many
audio interfaces have a MIDI interface built-in).

You can also visit “Window->MIDI Connections” to see a grid of your track outputs (on one side) and
hardware outputs (typically on the bottom right tab)

A short cut to arming the master in the edit window: rec arm the channel strip then press 3
on the number pad. This will record arm the master and roll the transport simultaneously.
This is especially useful if you are managing the session while recording yourself.
*
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Virtual Instruments
Virtual Instruments (VI) are plug-ins that convert MIDI performance data (notes) into sound. Otherwise
Mixbus treats them like a normal plug-in. They can be inserted anywhere in the channel’s signal flow. This
allows you to insert a MIDI-generating plug-in, or a MIDI “filter” plug-in before the VI. But normally, you
should ensure that the VI is the first plugin at the top of the redirect list.

When you create a new MIDI track, there is a menu selection for the Instrument you would like to use on
this channel. By default, the instrument will be inserted at the top of the redirect list.

Mixbus supports three Virtual Instrument formats:

• VSTi (using the VST plug-in specification, the VST format has been extended to include MIDI note I/
O) – currently support on Windows and Linux only. Coming to Mac in the future.

• Audio Unit Instruments – this is an Apple technology and is only supported on Mac OS X.
• LV2 instruments – LV2’s can be compiled for Mac, Windows and Linux. Currently there are no

commercial LV2 instruments available.

The fader, EQ, and Compressor elements should come AFTER (below) the Virtual
Instrument in the channelstrip, so they can operate on the audio stream created by the VI.

!

It is also possible to create a MIDI track without a virtual instrument. In this case you will
likely send the MIDI output to a hardware synthesizer, and return the signal into the MIDI
track’s audio inputs (or whatever track(s) you choose)
*

Note that because the VI is in the plug-in window, after the channel’s input, the input trim is
not effective on the VI. Most VI’s have their own internal volume control which can be used
as a trim.
*
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Editing MIDI Regions
A MIDI region is exactly like an audio region, except that the information inside the region is MIDI
performance data, not audio.

MIDI regions may be cut, copied, pasted, and trimmed in much the same way as audio regions. Region
editing is accomplished with the same tools: the Grabber (Hand) tool and the Range tool.

Grabber Tool

Range Tool

Editing features like the Grid, Sync Points, and Ripple Mode apply to MIDI regions just like audio regions.

There are 3 major differences with MIDI regions vs audio regions:

1. MIDI regions do not have fade in/out handles.
2. MIDI regions are “transparent”. This means that if you layer 2 regions atop each other, you will hear

the notes of the region below. This allows you to overlap regions so you can sustain one note through
the start of a new region.

3. By default, a copy of a MIDI region is a “linked” copy. So if you move the note in the source region,
the same note will be moved in the copy (and vice versa).

MIDI regions do not only contain MIDI notes; they also contain performance information such as pitch bend,
aftertouch, controllers, etc. This has one side-effect: in order to draw controls (with the Draw tool), there
MUST be an underlying region. MIDI data cannot exist on a track without an underlying MIDI file, and this is
represented by a midi region in the track. If you record MIDI data, then a region is created to hold any notes

In the same way that audio regions have underlying audio files that are actually stored on
disk, a MIDI region has a MIDI file in the session that it represents.*
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or controls that you play into the track. If you want to draw notes or controllers, you must first use the Draw
tool to drag a region, and then you can draw notes or automation into the region.

Using the Grabber (“G”) tool, you can right-click on a MIDI region and navigate to the MIDI context menu:

• Transpose – transposes all the notes by a given octave/semitone offset.
• Insert Patch Change – Inserts a patch change event in the region.
• Quantize – Quantizes the note start/ends to a defined grid.
• Legatize – Extends note ends to meet the next note’s beginning.
• Remove Overlap – After this operation, each new note onset will cut off any notes that were held on

before the new note was struck.
• Unlink from other Copies – unlinks this MIDI region from its copies. Any edits done to this region will

no longer apply to the region(s) it was copied from.
• List Editor – shows MIDI notes in a text list. Each note can be individually edited in the list.

It was a design goal of Mixbus3 to edit MIDI regions “just like audio regions”. To some users this is going to
feel inelegant. To others it will be a breath of fresh air.
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MIDI Banks and Patches
Many MIDI devices can be told to select different banks and patches.

The default (beginning) patch for each MIDI track is shown on the track header. “External MIDI Device”
allows the user to define what external device is connected to the MIDI output. If Mixbus has a patch map
for the selected device, then patch change dialog will list the factory preset patch names in the pulldown list
(instead of just patch numbers).

To create a patch change, right-click on a region, and choose “Insert Patch Change” from the MIDI
submenu. The dialog will prompt you for the bank and patch number. NOTE: if the patch doesn’t appear
where you expect it, select “Playhead” for the Edit Point, and use the playhead to define the patch change
location. Once inserted, you can use the Edit (“E”) tool to move the patch change. Scrolling the mouse
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wheel over the patch change will increment the patch number. Use the shift+right-click convention to delete
a patch change.

In the current version of Mixbus (3.0), patch changes are only sent when they are “played
through”. In other words, locating to a time after a patch change does not automatically
send the patch. This feature might be implemented in a future version.

!

With the advent of “virtual instruments” rather than external MIDI gear, bank/patch changes
are much less common. Virtual instruments typically use their own GUI or preset
mechanism to change sounds, not MIDI events.
*
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Editing MIDI Notes and Controls
MIDI notes on the piano-roll represent note velocity by color. Quiet notes (low velocity) will be dark green,
while loud notes (high velocity) will be yellow. Notes in the middle range will be bright green.

In the image below: Highlighted in green is the Draw (“pencil”) tool, and to the right is the Edit (“points and
lines”) tool. These tools are used to edit MIDI notes inside MIDI Regions.

In the image below: 2 MIDI notes have been selected for editing.
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Draw tool Edit Tool

• Click anywhere to start dragging a new MIDI
note; drag to extend the length of the note

◦ Newly-created notes get the average
“velocity” of other nearby note velocities

• Click in the middle of a note to select it ( the
note will turn red ). Ctrl+click ( Cmd+click on
Mac ) to add/remove notes from the selection

• Shift+right-click on a MIDI note to delete it
• Click the left or right edge of the MIDI note to

trim the start and end times of the note
• Click in the middle of a note to drag it
• Shift+right-click on a MIDI note to delete it
• Scroll the mouse wheel on a note to increase/

decrease the velocity

• Shift+right-click on a MIDI note to delete it
• Click in the middle of a note to select it ( the

note will turn red ). Ctrl+click ( Cmd+click on
Mac ) to add/remove notes from the selection

• Click the left or right edge of the MIDI note to
trim the start and end times of the note

• Click in the middle of a note to drag it
• Scroll the mouse wheel on a note to increase/

decrease the velocity
• Click an empty space in the region to initiate

a “box select” rectangle. With multiple notes
selected, you can:

Once a note (or multiple notes) is selected (red), you can:

• Click Backspace or Delete key to delete the selected note(s)
• Click the up/down arrows to transpose the note pitch up/down
• Point at the selected note, and use the mouse wheel to adjust all of the selected note velocities
• Right-click on a selected note to open the MIDI context menu

MIDI context menu:

• Delete – Requires one or more notes to be selected. Deletes the selected note(s)
• Edit – Operates on a single selected note. Allows changing the length, pitch, velocity, etc.
• Legatize – Operates on a multi-note selection. Extends note ends to meet the next note’s beginning.
• Quantize – Operates on one or more selected notes. Quantizes the note start/ends to a defined grid.
• Remove Overlap – After this operation, each new note onset will cut off any notes that were held on

before the new note was struck.
• Transform – Allows transforming the note pitch, velocity, and other parameters using logical

operations.

Remember, the Grab and Range tools are used to edit Regions, while Draw and Edit
operate on the contents of regions.*
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MIDI Control (CC) Automation

MIDI Controls use the same conventions as automation, except that you can only have MIDI controller
automation inside a MIDI region. You can only click to create new control points if there is a MIDI region on
the timeline at that location.

If you want to apply these MIDI operations to all the notes in a region, you can use the
Grabber (“G”) tool, and right-click on the region(s). The MIDI submenu allows you to apply
these operations to all notes in the selected region(s), without having to select the notes
separately.

*
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Step Entry
Step entry of MIDI data is an alternative method of entering MIDI arrangements. In step editing, you set the
length of notes, and the transport is automatically moved forward each time you play a note (or chord) on
the keyboard. This is a fast way to enter a long sequence of chord progressions or a drum pattern. Or it can
be helpful for users that are not proficient in keyboard performance, but would like to enter notes using the
keyboard.

To initiate step entry, right-click on the track’s “REC” button. A keyboard will be displayed.

Use your externally-connected keyboard to enter notes and chords; the step-entry dialog will automatically
advance the playhead with each event. This is a fast way to enter a chord progression or drum parts.
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Plug-ins
Plug-ins

Mixbus can load plug-ins in several formats, depending on your platform. Mixbus can only use plug-ins that
meet these criteria:

• The plug-in must be a supported format on your platform (see below)
• The plug-in must be compiled for the same platform as the Mixbus you are running. ( for example,

64bit Mixbus loads 64bit plug-ins, but not 32bit plug-ins )

A summary of plug-in support in Mixbus:

Plug-in input/output configurations for all formats

AppleTM AU plug-ins (supported on OS X only)

AU (Audio Unit) is the native (Apple-developed) plug-in format for OS X. Most commercial plug-in
developers make AU plug-ins for Mac, because this is the native format for Apple’s Garageband and Logic.

Unlike other formats, AU plug-ins normally provide a “variable” number of inputs and outputs. The host
(Mixbus) must tell the plugin how many inputs and outputs we want, and then the plugin can respond
whether that is a valid choice. This can get quite complicated. Mixbus chooses the I/O based on the number
of signal “pipes” at the insertion point of the plug-in.

Scanning of AU plugins must be initiated manually in Mixbus->Preferences->Plugins. If a plugin causes
Mixbus to crash during the “scan” procedure, then this plugin will be placed on a “blacklist” which prevents
that version of the plugin from scanning in the future.

This chapter covers the general principles of plug-ins in Mixbus. To learn about using
plugins in your mix, visit Using Plug-ins*

It is Harrison’s intent to support every plug-in available, whether commercial or free.
However there are many, many reasons why a plug-in might not work in Mixbus, or might
crash, or might behave unexpectedly. This is true of any DAW.

!
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LADSPA plug-ins (supported on all platforms)

LADSPA is the “Linux Audio Developer’s Simple Plug-in Architecture”. LADSPA plug-ins are simple to
develop and are freely available. LADSPA plug-ins do not support customized GUIs. The “generic” GUI will
provide sliders and knobs on a simple window. Being very portable, most LADSPAs are available for all
platforms (OS X, Linux, and Windows). LADSPA makes an excellent starting point for developers that want
to learn plug-in development. The quality can vary significantly, but there are a few good plug-ins available.

Mixbus can load a mono LADSPA plug-in into a stereo channel (by duplicating the plug-in and assigning the
same controls to both sides of the signal). This works well for some plug-in types (such as EQ) but less well
for compressors, which might introduce a shift in the stereo image if they aren’t truly stereo. In these cases,
you should choose a stereo LADSPA, not a mono one.

LV2 plug-ins

The successor to LADSPA, LV2 is the “next generation” open-source plug-in format. LV2 plug-ins have
several advantages over other formats. For example, plug-ins do not have to be instantiated to be scanned,
so startup is much faster and less likely to crash. For developers, LV2 is completely unencumbered by
licensing restrictions. Harrison’s bundled plug-ins currently use the LV2 format, and the same plug-ins
operate on Windows, Mac, and Linux. This allows you to share sessions with users on other platforms, and
have your sound remain unchanged.

Steinberg VST plug-ins (currently supported on Linux and Windows only).

VST (Virtual Studio Technology) plug-ins were developed by Steinberg TM and are the most common plug-in
format on Windows. VST plug-ins can be developed for Windows, OS X, and Linux. Currently, Mixbus does
not support VSTs on Mac, but that feature is under development.

VST plugins typically come in 2in/2out versions (stereo I/O). Mixbus channels are typically mono or stereo;
but the signal width can vary in the redirect sections. Mixbus will try to accommodate the audio and MIDI
“pipes” that are present in the signal flow at that location. This can get very complicated, and is outside the
scope of this manual.

Scanning of VST plugins must be initiated manually in Edit->Preferences->Plugins. If a plugin causes
Mixbus to crash during the “scan” procedure, then this plugin will be placed on a “blacklist” which prevents
that version of the plugin from scanning in the future.

Digidesign AAX/TDM/RTAS plug-ins (no support currently).

AAX, RTAS and TDM plug-ins are proprietary formats for Pro Tools TM. Mixbus does NOT support RTAS or
TDM plug-ins. It is unlikely that Mixbus will ever support AAX, RTAS or TDM plug-ins.
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Windows DirectX plug-ins (no support currently)

The DirectX plug-in API was developed by Microsoft and is the native plug-in format for Windows. Few
professional plug-in manufacturers provide DirectX plug-ins, so Mixbus does not currently support DirectX
plug-ins.

Installation of Plug-ins

Other than Apple’s Audio Unit Plugins, It seems no two plug-in developers share the same idea as to what
folder location their plug-ins should be installed. While installing plug-ins on Windows and Linux, take note
of the folder’s location the installer package has chosen. You may find it easier to redirect the installer to
one of the default location Mixbus uses which can be found at Menu>Edit>Preferences>Plugins tab>Edit. Or
you can create a new folder of your liking and install all of your plug-ins there. This way Mixbus has to scan
fewer folders. For every new folder created, Mixbus has to be made aware of its existence. If you have 20
different folders, then it places a burden on the user to inform Mixbus of their locations. Simplifying the
plugins location upon installation may prove useful.

Note: While we have taken care to follow the specifications for each plug-in format, plug-ins
are developed by third-party vendors. This means that Harrison cannot take responsibility
for plug-ins that don’t work as expected. Please use caution when trying a plug-in for the
first time. Verify that all the functions work as expected before committing to using a
particular plug-in in a session.

*
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Once the plug-in has been installed it is now time to inform Mixbus. First, go to
Menu>Edit>Preferences>Plugins tab. If you installed the plug-in in a folder Mixbus is already set up to scan
then click “Scan for Plugins” button. If the folder has never been scanned before, you must click the “Edit”
button, “Add”, and then browse to the new folder. Once that is done click “Scan for Plugins”.

Clear Cache

The Plug-in cache is a list of all plug-ins that Mixbus has scanned. If, during a scan of plug-ins, Mixbus or
the plug-in encounters an error, the offending plug-in will be removed from the cache and to the blacklist.
This will prevent Mixbus from crashing on the next scan of plug-ins. Clearing the blacklist will return the
plug-in to the cache allow Mixbus to once again try and scan it

Harrison Consoles Mixbus v3 - 1

Page 102 of 420



Latency Compensation

Some plug-ins, particularly plug-ins that use hardware “accelerators” or convolution-type processing, can
cause significant latency (time delay) from the input to the output. This can cause problems if the delayed
signal is mixed with a signal that is not delayed. A long delay can cause the tracks to sound “out of time”,
while a very short delay can cause comb filtering (“phasiness”). Mixbus can automatically accommodate
plug-in and insert latencies for you. To do this, Mixbus delays the non-affected tracks to match the track with
the longest latency. Please be aware of these facts:

• Tracks can accommodate “unlimited” latency by buffering the audio from disk earlier than it is needed.
• Mix buses are limited to 8192 samples of latency compensation. If the total latency of all plug-ins in a

mix bus exceeds 8192 samples, then a time offset will occur.
• “Buses” created with the Add Track/Bus dialog (we call these “utility buses”) do not support latency

compensation.

Plug-in Manager

The Plug-in Manager window provides a rich set of controls for browsing your installed plug-ins, and making
them quickly available when needed.

To access the Plug-in Manager,_ double click_ in any channel strip’s redirect box ( it’s the empty black box
near the top of a mixer strip )

Alternatively,_ right-click_ in the redirect area, and choose “New Plugin->Plugin Manager”.
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• Fav: If this column is checked, the plug-in will appear in the “favorites” shortcut in the redirect menu.
• Hide: If this column is checked, the plug-in will NOT appear in the “by creator” or “by category”

shortcut menus.
• Search: the search bar allows you to instantly find plug-ins by Name, Type, Category, Author, Library,

Favorites or Hidden properties.
• Add + (plus): This will add the selected plug-in to the list at the bottom. Continue adding plug-ins to

the list if you’d like to add more than one plug-in at a time.
• Remove: This will remove the selected plug-in from the list at the bottom.
• Refresh: This will reload the list of plug-ins, if you’ve added or removed plug-ins from your system

since the dialog was first shown.
• Insert Plug-in(s): This will insert the list of plug-ins in the bottom pane to the mixer strip that launched

the Plug-in Manager Window.

Currently, Mixbus displays plug-ins in the same list, regardless of whether they are audio effects, MIDI
effects, or virtual instruments. This might change in the future.

Tip: Try using the Search bar when looking for a plug-in. Just type the first few letters of the
name of your plug-in, and your plug-in will be sorted to the top window instantly.*
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Once Installed, plug-ins will be visible within the redirect box of the channel strip. Click here and here for
more information.

For information on Virtual Instruments click here.
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Editing
In Mixbus, audio and MIDI data is presented as “regions” on a timeline. All editing operations apply to the
regions. Some of the things you can do to a region: move it, trim the start/end, set the fade-in/out length,
and adjust the gain. Additionally there are many, many ways that you can manipulate those simple features
of a region to accomplish your task:

Using editing tools, like the “Range” tool: A “range” is a selection on the timeline that can span over multiple
regions, and make cuts or moves as if they were a continuous piece of audio.
Using editing modes, like Ripple mode: if you make a deletion or insertion using Ripple mode, then the later
regions (to the right) will respond to your moves so you don’t have to re-shuffle them if you make cuts earlier
in the session.
Using the Grid: You can use the “Grid” to limit your edits so they only happen on musical times (such as
measure, or quarter notes)

Combining these techniques gives you a nearly limitless opportunity to work with regions on the timeline.
Like the tools and modes of a drawing application, you have to learn the combinations of the tools to get
your work done most efficiently.

Furthermore, you can choose to make edits on the location of the playhead (“what you hear”) versus the
mouse (“what you point at”). Sometimes it makes more sense to edit with one point, and sometimes it
makes more sense to edit with the other. Learning when to use each mode is an important skill to develop.

UNDO: with all of these ways to edit, it is unavoidable that you will make mistakes. Mixbus
provides an “undo” feature that allows you to revert your changes. Perhaps more
interestingly, Mixbus supports persistent undo. Each time you save your editing session, the
“undo” information is saved alongside the session in a separate file. Upon reopening the
session, you can still “undo” the edits that happened prior to your closing it. The main
session file, and each of the snapshot files in the session folder, have their own persistent
undo storage file.

*
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Edit Window Overview
Basic Editing Concepts

Users familiar with other DAW conventions will quickly adapt to the recording and editing features of
Mixbus.

Track Management

On the far left of the edit window, the Editor Mixer can be displayed via Menu>View>Show Editor Mixer.
The Editor Mixer is a single mixer channel strip that “follows” the selected track. To see all of the mixer
strips for the tracks and buses on one window, show the Mixer window. Alt+M ( or Ctrl+M for Mac ) toggles
between the Mixer and the Editor windows. Located near the top of the mixer strip is an Input button for

LOGIC users: you will notice that dragging a region to the blank area below the editor tracks
will automatically create a new track for the region. This is a quick way to separate out a
region and make a new track for it.
*
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selection of the physical input that feeds the track. For example if you have 8 tracks but only a 2 input sound
card, you must route the inputs to the tracks as-needed.

The right side of the screen is a pull-out window which accommodates several different functions. Most
panels have a right-click context menu for additional features:

• Tracks/Buses – drag & drop to reorder tracks, or click to show/hide them.
• Regions – shows all of the recorded or imported regions. Drag & drop from here into the editor.
• Snapshots – Click a snapshot to recall all of the settings in the snapshot.
• Edit Groups – Click the +/- buttons to create edit groups, and enable them.

Using Tracks

To the left of the editing canvas are the track headers.

Note: Normally “snapshots” are used as backup states. You store the snapshot and
continue working on the main session. Future “save” operations will apply to the selected
session, not the snapshots. If you prefer that future “save” operations go into the newly-
created snapshot, then you will want to invoke the “Save As” command.

*

Tip: You can also select tracks in the editor and use the “Move tracks Up/Down” command
from the track menu.*
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You can select or deselect a track by clicking on the empty area. You may shift-click to select a range of
tracks, or Ctrl/Cmd-click to select and deselect individual tracks. Right-clicking the empty track area will
open the track context menu. Certain functions such as mute, solo, and record-arm can be applied to ALL
tracks simultaneously by Ctrl-Alt-Shift-clicking (Cmd-Opt- Shift-click). You can manipulate multiple tracks at
once by selecting them and then using operations from the “Track” menu in the main application. Hovering
the mouse near the bottom of the header causes 2 horizontal lines to appear allowing the track to be
resized vertically.

The “P” key on each track allows selection of the track’s playlist. Playlists can be used to enable multiple
takes in a single track, or the sharing of playlist data across multiple tracks. Some users create a new
playlist for each recording “take” while others use Layers to manage takes.

Tracks also support automation of the fader, panner, and other processing parameters including those of
plug-ins. The “A” button in each track opens the automation menu which allows editing of automation data.
Each parameter has multiple dynamic automation states: Manual, Play, Write, and Touch. These control
whether dynamic automation will play back or be recorded while playing. Automation lines can be created
and edited with the Draw Mode (green box in the image below).

You may also select a Range of automation for deletion, or to raise/lower the selected range.

Groups

Tracks may be assigned to “edit groups” using the G button. When tracks are assigned to an edit group, and
the regions align exactly on the start and end times, then all changes to one track will be applied to all other
tracks in the edit group, regardless of whether the grouped tracks and regions are selected for editing. This
is very convenient for editing multitracked instruments. Another convenience is that some playlist operations
(such as “New”) will apply across the edit group. Edit groups are created and enabled in the Mixer List to the
right of the screen. To enable the Mixer List go to menu>View>Toggle Mixer List See more on Groups here.

Note: In addition to edit groups, you can create mix groups from the mixer window. Mix
groups allow the same sort of features as edit groups, but they apply to mixing functions
such as fader, mute, solo and record-arm. This is another convenient feature for
multitracked instruments.

*
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Recording, Loops and Punch Ranges

Above the recording tracks is the “ruler bar” area (highlighted by the red box in the image below).

Left-click anywhere in the ruler bars to locate the playhead. You can also locate the playhead to the current
mouse location with the “p” key. Right-clicking in each of the “ruler bar” areas will allow you to create
location markers (cue points), CD markers, tempo markers, or meter markers. Clicking and dragging in the
“range” or “loop punch” ruler bars will allow you to define song ranges, loop ranges, or punch in/out
ranges. Right-clicking on the ruler bar names will allow you to show or hide the various rulers.

Navigating in the Editor window: Zooming and Panning

The area of the editor where the regions is shown is called the “canvas”. There are several ways to navigate
(pan and zoom) the editor canvas.

Go to Menu>View>Zoom Focus to select the zoom focus. The “zoom focus” affects the operation of the
zoom buttons and the zoom key commands by changing the focal point for the zoom.

Zoom focus can be one of:

Tip: Holding “Shift” will temporarily override a mix group assignment for the fader and mute.
For example, if you have 2 tracks in a mix group, the faders will move together if you move
one. But if you would like to move a single fader without disabling the mix group, you can
hold “Shift” while you move the fader, and it will not cause the other grouped fader(s) to
move.

*
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• Left: Zoom focus is the left side of the summary view gray box.
• Right: Zoom focus is the right side of the summary view gray box.
• Center: Zoom focus is the center of the summary view gray box.
• Playhead: Zoom operations will center on the playhead.
• Mouse: Zoom operations will center on the mouse position (only makes sense when using the zoom

keyboard commands; when buttons are clicked the Playhead is used as zoom focus).
• Edit Point: When the Playhead is the Edit Point, it is used for zoom focus.

In addition, there are several scroll-wheel commands that can be used to navigate the editor canvas:

• Scroll: Scrolls vertically.
• Shift+scroll: Pan the editor canvas left/right.
• Ctrl/Cmd+scroll: Increase/decrease the zoom (note: this always uses the Mouse as zoom focus).
• Alt/Option+scroll: Increase/decrease the height of the track that is currently under the mouse.

The Transport Menu and Toolbar

Many items in the Transport Menu and Toolbar are self-explanatory. For more details click Help-
>Reference.
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The Editor List
Track and Bus Management in the Editor

Menu>View>Show Editor List

On the right side of the edit screen there is an adjustable ‘shelf’ with tabs. The Tracks/Buses tab is used to
manage tracks. You can click on the checkboxes to hide/show tracks, and you can drag/drop the tracks to
change their order.

A right-click menu provides these options:

• Hide/Show all.
• Hide/Show all tracks.
• Hide/show all buses.
• Hide/show all MIDI tracks
• Show tracks with regions under playhead (only shows the tracks that have active audio regions right

now).

Double-click on a track to jump the editor to show that track
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Tracks & Buses
To the rightmost side of the editor window is a slide out drawer that contains the Editor List
(Menu>View>Show Editor List).

Located on the right of the slide out drawer are tabs. Selecting the “Tracks & Busses” tab will show the
tracks and busses.

Features of The Editor List Window

• Name: Clicking on name will show that track/bus at the top of the Edit Canvas. Double click to rename
the track/bus

• V: Toggles the track or bus to Visible/Invisible in the edit canvas
• A: Toggles the track/bus to Active/Inactive
• I: MIDI input Enable/Disable
• R: Rec enabled button/indicator
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• M: Mute button/indicator
• S: Solo button/indicator
• SI: Solo Isolate button/indicator
• SS: Solo Safe Lock/Unlock

Tracks/busses can also be reordered by clicking while dragging the track to the desired location.

Right clicking anywhere within the slide out drawer calls up a context menu. “Show Tracks
With Regions Under Playhead” is a method which allows the users to quickly maximize the
editing canvas space.
*
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Regions
This shows the audio regions that have been recorded or imported into the session. The full-length audio file
is shown and the underlying “regions” are the different excerpts from it. You can grab a file, or a region
excerpt, and drag it into the timeline.

Pointing at a file shows the path to the file on your disk(s)

Right-click on a region entry to:

• audition (simply plays the wave file, outside of any context in the mix)
• hide
• Import a new file to the list (see: Import)
• Delete any regions that aren’t used in your session (see: cleanup)

For convenience, the table shows you the region’s start time, length. In the current version, these properties
cannot be modified.

It also shows properties such as muted, locked, etc. (see Object Editing) which CAN be modified.
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Snapshots
This lists shows the available snapshots in the current session.

Menu>Session> Snapshot

A “snapshot” is a complete recall all of the track, region, mixer strip, and plug-in information.

All of the snapshots share the same session audio data; this means you can have multiple “snapshots” ( i.e.
songs, mixes, or remixes ) without recreating copies of all the audio data.

Single Click on a snapshot to switch to that snapshot.

Snapshots are also accessible when launching Mixbus
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Track Headers
The “Track Header” provides quick access to key functions

Red Dot: record-arm
M: Mute Button
S: Solo Button
P: Playlist Button
A: Automation Button
G: Group Selection Button

The horizontal slider servers as a fader.

Right Clicking in the track header pulls up a context menu.

Selected tracks can be muted, solo’ed, record-armed or gain-adjusted directly from the keyboard.

Track Height
The waveform displayed in the editor canvas area can be made to appear larger or smaller by simply
hovering the cursor near the bottom of the track header. A double arrow and 2 lines will appear, at this point
click and drag the cursor downward to increase the size, or click and drag upwards to decrease the size.
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You can perform this action to multiple tracks at one time by shift clicking a range of tracks or ctrl clicking for
discontiguous selection.

Alternatively the menu item Track>Height will provide additional methods.

For additional information click here

This action has no effect on the gain of the track, it is simply a visual aid.*
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Object (Region) Editing

Click above for video instructions.

Object (Region) Editing

The basic element of audio editing in Mixbus is the Region. Another common name for a Region is a “clip”.
A region represents an audio file (or a portion of an audio file) on disk. Regions can be moved, stacked,
trimmed, copied, deleted, and otherwise edited. The maximum length of a region is the length of the file that
it uses as a source, but it can be much shorter. A region might represent just a small segment (such as one
syllable or drum hit) from the source file. Editing or deleting a Region does not change the source file in any
way. This is called non-destructive editing. Audio regions can only exist on audio tracks. You cannot drop an
audio region onto an audio bus, or a MIDI track. Similarly, a MIDI track can only hold MIDI regions.
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Regions have several “hot spots” that can be modified using the left mouse button when in Object or Smart-
Object mode. Object edits follow the Grid selection, so operations will snap to the nearest Grid location if it
is turned on.

Move Click in the waveform area to drag the region in time or across tracks.

The fastest way to learn about region actions is to right-click on a region. This will provide
a list of operations that you can apply to the selected region(s). The items in the Region
menu (in the main application menu) may also be applied to any selected regions. If you
don’t have any regions selected, then most of the items in the Region menu will be
disabled.

*
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Start/End
Trim

Click on the colored bar at the bottom to trim the start/end of the region.
If you are nearer the start of the region, you will trim the start time.
If you are nearer the end of a region, you will trim the end time.

Fade In/
Out Grab the handle in the top corner on either end to change the region’s fade.

Fade
Length

Grab the handle in the lower corner to lengthen or shorten the region’s fade time, while
leaving the endpoint of the fade fixed.

Additional mouse commands on regions include:

Middle-
click drag

Drag the region, overriding the edit mode. If the mode is Slide, then the region will be
locked in time and will only move up/down across tracks. If the edit mode is Lock, then this
will override the lock and allow the region to slide side-to-side in time

Ctrl/Cmd-
click drag Drag the region, while making a copy

left-click
on trim
bar

Trim the start of the region to this point

middle-
click on
trim bar

Trim the end of the region to this point

Ctrl/Cmd-
left-click
on trim
bar

Slide the contents of the audio file inside the region, leaving the region
start and end times intact

Tip: When you move/drag a range, it becomes visibly transparent. This allows you to see
the regions underneath. This sometimes helps if you are recording an overdub or replacing
one drum sound with another.
*

Tip: You can select multiple regions at the same time using Ctrl/Cmd-click or selecting them
with a rubberband box. Regions selected this way will edit together: you can move, trim, or
fade them all at the same time.
*

Tip: Combining the Trim, Fade In/Out, and Fade Length, you have complete control when
assembling a crossfade between two regions. With these operations you can find the
perfect location and length of a crossfade with a minimum of effort.
*
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right-click
anywhere
in a region

Open the Region Context menu (see below)

right-click
in the
crossfade
area

Change the shape of the fade in/out

For more keyboard shortcuts view Keyboard Shortcuts

Region Layers

Regions may be stacked on the same location in the timeline. This is called “layering”. Normally only the top
region is heard; it covers the audio regions below it. However there are cases where the region below can
be heard. One example is the top region’s fade-in or fade-out. Region fades operate as crossfades. If a
region is stacked on top of another region, then the region underneath will audibly “fade out”, while the
topmost region “fades in” across the length of the crossfade. The second way to hear a region below the
topmost region is if the topmost region is not *opaque *(the Opaque flag can be turned off in the Region
menu and/or the right-click Region context menu).

Region layering can be changed on-the-fly by the user. Try right-clicking on a region to change its layering.
Layering is one way to manage multiple “takes” of a performance. Each time a track is recorded, a new
region is written onto the topmost layer. But the layers underneath still exist. There are global options that
define the default behavior of crossfades and layers. While the defaults are suitable for most users,
understanding these options can be very important for advanced users (see Crossfade and Layer Modes in
Section 26.0 Mixbus Options).

Audio region fades

Every Audio Region has a fade-in and fade-out. By default, the region fade is very short, and serves to de-
click the transitions at the start and end of the region. By adjusting the region’s fade length, a more gradual
transition can be accomplished. Important: In Mixbus, each region’s fade is a crossfade with the audio below
it. In other words, if the beginning of a region overlays a region(s) below it, you will hear a gradual fade from
the underlying region(s), and a fade-in of the topmost region.

Note: For many region operations, you don’t have to actually select the region. Just hover
the mouse over the region, and use the shortcut key. The shortcut keys are listed in the
Region menu. This is a fast way to mute/unmute regions in a session, for example.
*
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You may right-click on a region’s fade-in or fade-out to choose the shape of the fade.

Deactivate: The fade is completely deactivated. The audio in the region will be heard exactly as-is.
Linear: Cuts off abruptly at lower levels. Used as a crossfade between 2 audio regions. The signals are
each -6dB attenuated at the midpoint. This is the correct crossfade to use with highly-correlated signals
(such as test tones) for a smooth transition. This mode is rarely used on “real” material because you will
hear a distinct dip in the middle of the crossfade.
Constant Power: Used as a crossfade between 2 audio regions. The signals are each attenuated -3 dB at
the midpoint. This is the correct crossfade to use when you want to smoothly fade from one sound into
another.
Symmetric: This is not mathematically correct like the Equal Power or Linear curves, but it provides a
slower fade-out at low volumes. This is sometimes useful when editing 2 entire music works together so that
the transition is more gradual.
Slow: Normally used as a region fade-in or fade-out. This curve is similar to gradually lowering a fader. It
starts very gradually but then rapidly fades to silence. It is well-suited to fading out the end of a song.
Fast: Normally used as a region fade-in or -out. The level is reduced at a constant-dB rate, so it sounds
very smooth.

Region Context Menu

The region context menu (launched by right-clicking a region) has many of the same operations as the main
Region menu. The Region context menu always operates on the single region that was right-clicked on,
while the Region menu operates on all selected tracks. Many items in the Region Menu are self-explanatory.

Region Gain

Every region in Mixbus has a level control (called Region Gain in some menus) that applies to the whole
region. The Region’s level can be modified by the Region menu, or from the right-click context menu:

• Increase/Decrease Region Gain (Increase is limited to +10 dB)

While it can be tempting to manipulate the crossfade shape, the location of a crossfade is
far more important than the crossfade shape. Placing a short crossfade before a loud
transient (like the downbeat of the new material) is generally the best and easiest way to
make a crossfade, and the “shape” of the fade is essentially moot.

*

NOTE: MIDI regions do not have have fades*
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• Reset Region Gain to Unity
• Normalize (Raises or lowers gain so that the highest value in the region is 0 dBFS, limited to +10 dB

max gain)

The Normalize entry will say “Denormalize” if the region is already normalized. This will return the region
gain to unity.

Description of Region Properties:

• Mute
• Opaque
• Lock
• Lock to Video: this is set when a video is imported with sound. The resulting regions have the “video

lock” enabled so you can’t accidentally nudge them out of time with the video. This is separate from
the normal region Lock function. You must disable this lock before you can move the region on the
timeline.

Note: If you normalize a region, it will raise the region gain so that the waveform shown in
the region reaches 0 dBFS. If the region is extended to represent more of the underlying
audio file, this audio may reach above 0 dBFS.
*

Note: Mixbus has 5 built-in gain stages in a track: Region Gain, Region Envelope, Input
Trim, Fader, and Makeup Gain (when compressor is enabled). Each gain stage serves an
important purpose, and the combination of these stages makes it easy and fun to mix in
Mixbus.

*

Tip: Simply point the mouse at the region and use the gain up/down key to quickly adjust
region gain. You can also select multiple regions at once and then use the region gain key
commands to raise or lower all the regions simultaneously.
*
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Editing Tools & Modes

Click above for video instructions.

Edit Modes

The edit mode selector is to the far left, directly underneath the transport controls. There are 3 different
editing modes when moving regions:

circled in red in the image above, you may select:

1. Slide is the normal mode that allows regions to be moved without any limitations.
2. Lock allows trimming, fades and track shuffling, but does not allow the region to be moved in time.
3. In Ripple mode, changes to a region are “rippled” to other regions on that track in the future. For

example, deleting a Range or Region will move the regions after (to the right of) it, to the left. Thereby
closing the gap.

Editing Tools

The Edit Toolbar allows selection between several different editing tools. Each tool also has an associated
shortcut key, and can be changed via the Edit menu.

Object Tool ( see Region Editing )

Harrison Consoles Mixbus v3 - 1

Page 128 of 420

https://www.youtube.com/embed/x7L6gc2lmHQ?rel=0
https://www.youtube.com/embed/x7L6gc2lmHQ?rel=0


The object tool appears as a “pointer finger” icon while hovering over regions. Just a few of the operations
of the Object tool include:

• Click on a region to select it for editing, or drag a region to move it.
• Click inside the colored bar at the bottom of a region to trim the start or end points.
• Click on a region’s fade-in or fade-out handle to adjust the fade length

Range Tool

The Range tool allows the user to select and drag across a range of time. The time-range can span across
multiple tracks and regions, as if the range were a contiguous piece of audio tape. Tracks that are selected
in the current range are highlighted red in the edit window. You can add or remove tracks to the selection by
clicking with the mouse.

• Drag across a range of time to create a contiguous selection.
• Grab the edges of the selection to lengthen or shorten each end of the selection.
• Right-click on the selection to launch a menu that allows looping, bouncing, exporting, consolidating,

or analyzing the selection.
• Use the functions in the Edit menu to cut/copy/paste or otherwise manipulate the selection.

( see: Range Editing for more details about the Range tool)

TimeFX Tool

The TimeFX (“stretch”) tool allows the user to stretch regions to be longer or shorter, without changing the
region’s pitch.

To use the TimeFX tool, drag on a region to lengthen or shorten the region. This will launch a dialog:

• Strict Linear: Click this to force Mixbus to use a simple resampling method (not typically used with
musical content).

If the “Smart” button is selected, the Object tool will also gain many features of the Range
tool; see “Smart Editing” below for more details.*
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• Contents: Choose an advanced resampling mode that best matches the sound of the region.
• Stretch/Shrink: Initiates the stretch operation.

Audition Tool

• Click on a region to hear the region through the auditioner path (this means without processing).
• Drag on a region to “scrub” the audio in the direction of mouse movement.

Draw Tool

The Draw tool allows the user to draw midi notes and automation control points.

• Click inside a MIDI region to create a MIDI note event. Drag to set the length of the note
• Click on a region to create a new gain automation point. For more details, see “Region Gain and

Automation”.
• Click on an automation track to create a new automation control point

Contents Tool

The Contents tool allows the user to edit the “internal” contents of a region. For example you can use this
tool to select midi notes inside a region and move or delete them.

• Click and drag inside an audio region to select region gain control points
• Click and drag on a MIDI note to move it
• Click and drag inside a MIDI region to select one or more MIDI events
• Click and drag inside an automation track to select automation control points, and then move or delete

them

“Smart” Editing
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When Smart Mode is engaged, the “Object” Mouse mode takes on some of the features of the Range mode.
The top-half of a track operates in range mode (allowing the user to drag-select a time range on one or
multiple tracks). The bottom-half of the track operates like Object mode, allowing the user to grab a single
region, or rubberband-select a group of regions. Other features of Object mode (such as trimming regions or
adjusting fade lengths) are still possible in this mode. The cursor will change to show either Range or Object
tools when the user transitions from the top of the track to the bottom of the track. “Smart” mode is only
lighted when the Object (hand) tool is engaged, but the Smart setting is remembered at all times.

Follow Edits Mode (previously called “Join Playhead Mode”)

Follow Edits Mode is enabled via the horizontal button right of the transport control buttons. Follow Edits
Mode automatically moves the playhead to allow quick auditioning of selected ranges and/or the most
recently-edited Region.

Behaviors with Follow Edits Mode on:

• Starting playback (with the spacebar or any other means) will play the Range selection, if there is one.
• A single click in Range (or Smart-Range) mode will locate the playhead to that location.
• When a Range selection is made, the playhead will be located to the beginning of the range.
• When a region is selected with Object mode, the playhead will be located before the region, with the

user-defined pre-roll.
• When a fade-in or fade-out is adjusted, the playhead will be located before the fade, with the user-

defined pre-roll.
• When a region is start- or end-trimmed, the playhead will be located before the start or end, with the

user-defined pre-roll.

Behaviors with Follow Edits Mode off:

• Editing clicks (such as object grabs or range selections) will have no effect on the playhead location.

Tip: The combination of Follow Edits Mode and Auto-Return mode provide a wide variety of
possible operations. If you are familiar with another workstation’s conventions, you should
experiment with these settings to see if one of them matches your expectations.
*
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Selection conventions

Selected items ( Regions, Tracks, MIDI Notes, Plug-ins, or Automation Control Points) will be outlined in
RED.

Selection categories ( tracks, plugins, regions) are mutually exclusive. In other words, you can only have
Region(s) or Track(s) selected at one time. For example, if you have a Region selected, and you select a
Track, then the Region will be de-selected.

A Range selection implies a single time range selection and one or more Track selections. Range and Track
selections work together, they are not mutually-exclusive. You can’t have a Range selection without a track.
A Range selection implies that one or more tracks are selected. However you CAN have one or more Tracks
selected without a time range.

This convention makes it clearer, for example, what will be deleted when you click the “Delete” key.

Pressing the ESC (Escape) key will clear all selections.

Operation Priority

When an editing operation occurs, Mixbus must determine where the operation applies. This depends on
many factors including the type of operation, the location of the Edit point, the existence of a selected
Range, and Track Selections. Most of the time Mixbus will do exactly what you expect it to. If not, then it
might be due to an unexpected operation priority. See the table below.

Delete Functions: Object (Region)
Editing Functions: Edit Point Functions: Range Editing

Functions:
Nudge
Functions:

Example: Delete,
Backspace

Example: Mute,
Normalize, Reverse,
Transpose

Examples: Split, Trim,
Align

Examples:
Separate,
Crop,

Examples:
Nudge

Priority:
1. Any Selected

Range,
2. Any Selected

Regions,
3. The region

directly under
the mouse (even
if the region isn’t

Priority:
1. Any Selected

Regions,
2. Any regions on

selected tracks
under the edit
point (even if
the regions
aren’t selected)

Priority:
1. Any Selected

Regions at the
Edit point,

2. Any regions on
selected tracks
under the edit
point (even if the

Priority:
1. The

selected
Range

Priority:
1. Any

Selected
Regions

2. The
Playhead
(if
nothing
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selected), IF the
Edit Point is
“Mouse”

4. Selected Plug-
ins

5. Selected MIDI
Notes

6. Selected
Automation
Control Points

3. A region directly
under the
mouse (even if
the region isn’t
selected), IF the
Edit Point is
“Mouse”

region isn’t
selected),

3. The region
directly under
the mouse (even
if the region isn’t
selected), IF the
Edit Point is
“Mouse”

else
selected)

The Edit Point

Functions on regions such as splitting, trimming, and pasting will happen at the currently defined edit point.
The edit point can be the mouse cursor or the playhead. Mixbus allows you to choose between the two
modes on the fly using the edit point button.

in the above image the Edit Point is set to “mouse”.

The settings for Edit Point are:

• Playhead : Mixbus will use the Playhead position to determine the location of an edit.
• Mouse : Mixbus will use the Mouse cursor position to determine the location of an edit.

Note: In order to use the Mouse edit point, the mouse must be located inside the editing
area. This means you can’t use commands from the “menu”, because Mixbus doesn’t know
where you are trying to apply the edit. So if you want to use the Mouse as your edit point,
you’ll need to learn some of the basic editing keybindings ( such as “S” for split, and “J”/“K”
to trim the start/ends of regions)

*
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Tip: Another advantage of using the mouse is that Mixbus can guess which track you want
to edit without having the track explicitly selected. In other words: in Playhead mode,
Mixbus has to know which tracks (or regions) are selected before it can edit. In Mouse
mode, if no tracks or regions are selected, then Mixbus will assume you want to edit the
region you’re currently pointing at. For these reasons, the Mouse mode can be faster for
experienced users.

*

Tip: However some users like to edit with their “ears”, and in this case choosing Playhead
as the Edit Point might be the preferred choice. Using Playhead mode, you can use your
ears to start fades, trims, and selections while the playhead is rolling. Selecting the track(s)
that you want to work on means that you can operate the editor using only the keyboard and
your ears, without referring to the screen at all!

*

Tip: In both Mouse and Playhead mode, all of the keybindings work. For example, the “,”/”.”
keybindings can be used to mark the start and end of a range selection while playing
through a section in Playhead mode.
*
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Snap Mode
Snap mode controls how regions, playhead, and the cursor move about the edit canvas.

When snap mode is turned on a timing grid can be used to determine the placement of regions, playhead,
and the cursor. Various timing units can be chosen for the grid.

Available Snap Modes:

• No Grid: Timing grid is not active and movement of objects are continuous and infinite within its
range.

• Grid: Timing grid is active and all movement of objects will snap to the selected grid unit.
• Magnetic: The benefits of grid mode but less restrictive. The timing grid is active and movement of

objects will snap to the selected grid unit only when its near. This mode is often preferred over Grid
mode; because in Grid mode, items will always snap, even if it is off-screen. Whereas Magnetic snap
will only have an effect if you explicitly move near a grid point.

Region Grid, versus Contents Grid.

To facilitate editing the regions (which might have No Grid) and Notes inside a MIDI region (which might
snap to a 16th note Grid), Mixbus maintains 2 different Grid settings. When you switch to a “Content Editing”
tool, like Draw or Edit, then the “Content” Grid setting will be used. When you switch to Object or Range
tool, then the overall grid setting will be selected.

The grid consist of lines running vertically in the edit canvas. If the grid is not visible, try
zooming in, or check “View->Show Measure Lines” in the main menu. Mixbus tries not to
show “too many” or “too few” grid lines depending on the zoom level; so you might find that
items snap in-between the grid lines sometimes. That’s expected behavior.

!

If the Grid setting seems to be changing arbitrarily, it’s probably because you are switching
between Region-editing and Content-editing tools. This is intended operation.

!
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Snap override:

To temporarily disable the Grid while dragging, hold “ALT” while dragging. ( this option can be changed in
“Preferences->User Interaction”)

Relative Snap:

Sometimes you want a region to move in units of the grid ( eight-notes, quarter-notes, or whatever ), but you
want it to maintain the same offset from the grid. In this case, hold “Shift+ALT” while dragging, and the
region or note will retain it’s relative offset from the grid. ( this option can be changed in “Preferences->User
Interaction” )

Sync Point:

By default, a region’s leading edge will snap to the grid but often this edge is not relevant to musical timing.
By setting a sync point within a region (ex: on the downbeat) the region can be snapped to the grid in a
musically meaningful way.

To set a sync point:

Select the region and place the cursor where you would like the sync point. Press the “v” key and a yellow
line will appear. Now the region can be snapped to the grid using the sync point as the reference.

To move a sync point:

Simply repeat the procedure above (there can be only one sync point per region).
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To remove a sync point:

Select the track with sync point then choose: Menu>Region>Position>Remove sync. (This effectively sets
the sync point back to the beginning of the region)

Grid Units: (Menu>View>Snap to)

This setting determines the “Snap to” resolution. Two time references are available; absolute time which
refers to a fixed clock (real time), and relative time which mostly refers to music time such as meter and
tempo.

CD Frames For CD mastering. The CD Frame is the smallest data entity in the Red
book standard.

Timecode; Frames/Seconds/
Minutes The timecode duration refers back to the session settings.

Seconds/Minutes Real time units.

Beats (in fractions) Grid units consisting of fractions of a beat: 128, 64, 32, 16, 8, 7, 6, 5, 4, 3,
2.

Beats Whole beats.

Bars Whole bars.

Markers Snap to the nearest marker.

Region Starts Snap to the nearest region start (see below).

Region Ends Snap to the nearest region end.

Region Syncs Snap to the nearest region sync point.

Region Bounds Snap to the nearest region start or end.

To use Region Starts/Ends/Syncs/Bounds as “Snap to” resolutions, you must have either
• No tracks selected, which allows “Snap to” regions on any track.
• One or more tracks selected, which allows “Snap to” regions on all selected tracks.
*
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Range Editing

Click above for video instructions.

Range editing allows you to select and delete contiguous selections of times, on multiple tracks, without
worrying about the individual regions in the track. Once a range is selected, the most common operations
are:

• Delete everything inside the Range by clicking Delete or Backspace
• Cut or Copy the Range to the paste buffer
• Use the Edit menu to operate on the range
• Right-click on the Range to perform one of many tasks

• Play Range : Locates the transport to the start of the range, plays through it, and stops at the end.

• Loop Range: Sets loop makers in the ruler bar and loops the range.

• Zoom to Range: Re-sizes the canvas to accommodate the range.

• Spectral Analysis: Performs spectral analysis on the regions within the range.

• Optimize Polarity click here for more

• Move Range Start to Previous Region Boundary, etc: these functions help to fit the range to the
boundaries of nearby regions ( you can also use the Grid for this task )

The fastest way to learn about Ranges is to create a range on the timeline, and then right-
click on it. This will provide a list of features that you can accomplish with the selected
range. Most of the items in the “Edit” menu are also applicable to the selected range.
*
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• Separate : Splits the Region(s) inside the range, on each of the start/end boundaries of the Range.

• Convert to Region in Region List : Combines all the selected regions in the range, and creates a
single audio file that will appear in the Region List of the edit window.

• Select All in Range : Selects all the regions that are touched by the Range selection. ( Note: there’s
also “Edit->Select->Select all within Edit Range” which only selects the regions completely inside the
range)

• Set Loop from Selection : Sets the Loop Start/End markers to match the Range selection
• Set Punch From Selection : Sets the Punch In/Out markers to match the Range selection
• Set Session Start/End from Selection : Sets the Session Start/End markers to match the Range

selection

• Add Range Markers : Creates a new “Range Marker”, which is a persistent pair of start/end markers
that can be used to re-select later, name CD track indexes, or stored as an export range (for example,
a song in a multi-song project, or an excerpt of a song).

• Crop Region to Range : Trims the region start and end points to fit within the Range
• Fill Range with Region : Using the selected Region in the Region list, this fills the range with enough

copies of that region to fill the range.

• Consolidate Range : Removes all the region data in the Rage, and renders all the regions into a
single region (and audio file). This file incorporates all region gain setting, region gain automation, and
fade in/out settings for the included regions.

• Bounce Range to Region List : Combines all the selected regions in the range, and creates a single
audio file that will appear in the Region List of the edit window.

• Export Range… : Launches the Export Dialog with the selected range defined as the export time
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Automation Range Editing

This is an extremely powerful feature. Especially for dialog.

• Click the “R” key to select the Range tool.
• Sweep a range across a Region, OR on an automation track.
• Click “D” to switch to the Draw tool.
• Click in the selected range, and drag up/down to move the automation line up/down during that time.

Harrison Consoles Mixbus v3 - 1

Page 140 of 420

https://www.youtube.com/embed/x7L6gc2lmHQ?rel=0
https://www.youtube.com/embed/x7L6gc2lmHQ?rel=0
https://www.youtube.com/embed/x7L6gc2lmHQ?rel=0


Align Regions
Aligning regions means moving one or more regions based on the edit point. An alignment operation moves
the region(s) so that some part of the region is positioned at the edit point. Available alignment commands
include:

• Align Region starts
Selected region(s) are moved so that their start is located at the current edit point

• Align Region ends
Selected region(s) are moved so that the end is located at the current edit point

• Align Region sync points
Selected region(s) are moved so that their sync point is located at the current edit point

• Align Region starts relative
Selected region(s) are moved so that the start of the earliest region is located at the current edit point,
and all others maintain their relative position relative to that region
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Playlists

Playlist Overview :
A track has a series of Regions on a timeline. Each Region represents a part of a sound file (or MIDI file).
The order of these regions, and additional region properties such as gain/controller curves, fades, and mute/
unmute status, are stored in the track’s playlist.

Tracks can have multiple playlists, and you can create a new playlist, copy a playlist from another track, or
link 2 tracks to use the same playlist. This provides some interesting possibilities. Some users like to use
playlists to separate the different “takes” of a tracking session. Some users like to link playlists so that the
tracks can be processed separately, but any edit on one track will be applied to the other.

Clicking the “P” button on a track header opens the Playlist menu:

You can see the stacked “takes” by right-clicking on a track and choosing Layers->Stacked.
Mixbus can create a loop and record stacked takes. Just define your loop range, then define a “punch”
range inside it, and start rolling.
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Polarity Optimization

What is Polarity Optimization?
Polarity optimization is a way to take multi microphone recordings and automatically determine the best
polarity setting for each of the tracks. The resulting analysis uses RMS level as the criteria for deciding the
“best sound”. This mathematically optimized solution saves the user from comparing the many combinations
generated by individually toggling the polarity switches of every track, in every possible combination.

Polarity optimization can be used in any situation where you have multiple microphones recording the same
source, and it is important to find the polarity switch positions that generate the best sound.

The Polarity Optimizer finds the optimum polarity setting for your tracks, and then it utilizies the channel’s
polarity invert switches within the Mixbus mixer strip to implement the optimum polarity settings. After the
Optimizer runs, you can further view and edit the polarity selections by using the mixer-strip polarity buttons.

Using Polarity Optimizer
To initiate the polarity optimizer, use the Range tool (or Smart Tool) to select a time-range. It is important to
select a period of time that represents all of the instruments being played.

Right click in the range, and choose “Optimize Polarity” from the context menu .

A mixture of mono and stereo tracks may be used in the analysis. Left/right sides of a
stereo track are treated as 2 separate mono sources.*
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Results Dialog Box:

Preprocessing Options:
The top row of the dialog box lists the 7 preprocessing options. Click on any of these buttons and roll the
transport to audition the results. To accept the results simply close the dialog box.

Explanation of the preprocessing options:

The preprocessing options help you make sure the the optimum polarity is found.

• The “normalization” options are provided to accomodate unusually quiet or loud tracks, which cause
the tracks to be over- or under- represented. Normalization can be implemented as “peak”
normalization, or “RMS” average normalization.

The preprocessing options are applied only to the signal as it is being processed. The
processing isn’t actually applied to the tracks, it is just applied while the the Polarity
Maximizer is performing its calculations.
*
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• A low shelf boost emphasizes the low end response (+6 dB at 160 Hz) and biases the analyzer to
prefer alignment of low frequency content which may result in a more obvious low-end boost.

Optimization Results:

The Results dialog shows a grid of the selected tracks and the applied preprocessing options. The buttons
across the top can be used to set (and audition) the calculated polarity settings, for each of the selected
pre-processing modes.

• Old: The polarity of the selected tracks before Polarity Optimization was applied
• N/N: Polarity optimization applied with no emphasis, and no normalization of the tracks
• Peak: Peak normalized. Normalizes the peak volume before processing.
• RMS: RMS normalized. Normalizes the RMS volume before processing.
• L:N/N: Low emphasis, not normalized.
• L:Peak: Low emphasis, peak normalized.
• L:RMS: Low emphasis, RMS normalized.

When “Old” is selected and the transport is rolled you will audition without the results of the Polarity
Maximizer. When any other option is selected and the transport is rolling, you can audition the results of the
Polarity Maximizer with the corresponding preprocessing options applied.

In practice, you will find that most of the different preprocessing methods result in the same settings. In
most cases, you should select one of the options that has the most “agreement” with the other selections.
This indicates that the polarity settings are robust enough to apply even when subsequent level and
equalization is applied.

Track name results list:
The name of all tracks used in the analysis are listed and whether the track has had its polarity inverted as a
result of the analysis.

The underlying technology of the Polarity Maximizer was provide by Jim Davis Ph.D. MIT, 2000 Dept. of
Computer Science and Engineering at Ohio State University.
http://web.cse.ohio-state.edu/~jwdavis/

The Polarity Maximizer applies a high pass filter (DC offset removal) to attenuate signals
below 5Hz to remove it from the computation. This processing, like the processing options
listed above, is not applied to the audio tracks.
*
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Mixing
When multiple tracks are played at the same time, the goal is to:

• Make the overall timbre of the mix convey the feeling that the creator has chosen.
• Make each element clearly heard, so that a listener can focus on a single instrument if s/he wishes.
• Make the volume level consistent enough that the user isn’t required to constantly adjust the volume

knob.

Of course all of these rules are subject to the artistic wishes of the creator.

Here are some of the techniques that we use to create a “mix”:

• Balance the volumes of each element (instrument) so they don’t occlude each other.
• Dynamically adjust the volume of elements to accentuate parts of interest at different times of the

piece.
• “Pan” the signals into the available speakers so they can be separated by position.
• Create a “space” around each element so they can be perceived as close or distant.
• Tweak individual elements to accentuate their desirable character, or attenuate undesirable character.
• Change the frequency range of elements, so that more elements can be distinguished at the same

time.

You’ll find that Mixbus provides tools for all of these tasks right underneath your fingertips.
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Mixer Window Overview

Mixer Strips
When viewed in the Mixer Window, Mixbus resembles a traditional analog console. Input Channels are on
the left, while the busses and master are located on the right side.

The audio signal flow is generally left-to-right. The signal starts at the input channels (which might be live
inputs or playback tracks), progresses through the mix buses, and into the master. The channel’s EQ, Filter,
Compressor, panning, bus summing, and master bus processing are performed inside the proprietary
Harrison channel plug-in.

In Mixbus, like other audio workstations, each recording track has its own mixer strip. These mixer strips
resemble the input channels of a traditional analog mixing console. Input channels can be configured to be
mono or stereo, virtual instrument or MIDI, and by default include all the DSP processing that makes up a
real console channel. This is the major difference between Mixbus and other DAW mixers. No time is
wasted searching for and adding the necessary high-quality mixing tools.

Just to the right of the input channels are the 8 mix bus channels. Mix bus channels are used to collect the
outputs from the input channels into groups. For example, in a typical music project, you might send the
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drums to mix bus 1, the vocals to mix bus 2, instruments to mix bus 3, and use mix bus 4 as a parallel
effects bus, like reverb. This allows you to easily adjust the relative levels of these groups and apply
processing to them.

The master channel is the final mixer strip on the right. Typically, the master channel will be connected to
your monitoring system (speaker outputs). The output of the Master channel is the final output of your
project i.e. your 2 track master file. This output is rendered to the final .wav file when you export the
session.

The monitor section on the far right has been made available for those who do not have access to a
dedicated external monitoring section.

Tip: Shift+Ctrl+Click ( Shift+Cmd+Click on Mac ) on a track’s Mute, Solo, or Rec enable to
toggle ALL the tracks in a session.*
Tip: You can Ctrl+click (Cmd+click on Mac) on the track’s name slate, and make the track
wide or narrow. Shift+Ctrl+click (Shift+Cmd+Click on Mac) to make ALL the tracks or ALL
the buses narrow/wide.
*

Tip: You can also control the mixer page via the keyboard. Select a channel by clicking on it
with the mouse, then you can use the ‘S’ to solo, ‘M’ to mute, ‘R’ to record-arm the track.
The up/down arrow keys nudge the fader up and down, while the left/right keys scroll the
mixer left & right.

*
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Mixer Sidebar
On the left side of the mixer window, there is a sidebar that allows you to manage tracks.

At the top of the list is a “+” button which allows you to add a new track or bus.

The “track/bus” list shows a list of available tracks and buses.

• Click the ‘show’ box to hide or show a strip in the mixer page.
• Click and drag an item to reorder the strips in the mixer page.

A right-click menu provides these options:

• Hide/Show all.
• Hide/Show all tracks.

Reordering the mixer strips will also reorder the tracks in the Editor window.*
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• Hide/show all buses.
• Show tracks with regions under playhead (only shows the tracks that have active audio regions right

now).

Below the track/bus area is a list of the mix buses which can be shown or hidden.

Below the mixbus area is the Group section. For more information about grouping, visit the Groups topic.
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Signal Flow
The Mixbus signal flow is modeled on an analog console.

Mixbus may have an unlimited number of mono and stereo channelstrips (Track). Each channsltrip may be
assigned to any of the mixbuses, and/or directly to the master bus. Each of the mixbus assigns have level
controls, so each of the mixbuses can be used as either an “aux send/return path” (using the level controls
to adjust the send level) or a “grouping bus”, (using the hard assign buttons with the level control at unity)
depending on the user’s needs.

Harrison Consoles Mixbus v3 - 1

Page 152 of 420



Harrison Consoles Mixbus v3 - 1

Page 153 of 420



The “redirect” areas are represented by the black box at the top of the mixer strip. Sends, Inserts and
Plugins are “redirects”, and they may be placed in any order, before or after the fader. If a redirect is above
the fader, then it is considered a pre-fader redirect.

An important tip about signal flow: The Mixbus “bussing” structure (mix buses + master
bus) is stereo-only. Typically a channel has one (mono) or 2 (stereo) inputs. This defines
the channel width through the channelstrip. However, it is possible to change the channel
width via plugins. For example you can have a mono-input, stereo-output effect (such as a
chorus or autopanner effect). The last redirect (plugin) in the post-fader redirect box will
define the signal width just before it goes into the panning/bussing section. If the last plugin
has a single (mono) output channel, then the mono panner will be used. If the last plugin
has 2 (stereo) output channels, then the stereo “balance” panner will be used. If the last
plugin has 3 or more channels, then the stereo “balance” panner will be used and the
remaining channels will be ignored by Mixbus.

*

Not shown in the diagram is the Pre-Fader and Post-Fader send mutes. Sometimes when
you mute a track, you still want a Send to remain active (for a headphone feed, for
example). It is possible to disable the mute for pre- and post- fade sends separately. To
enable or disable the pre- and post-fader send mute, right-click on the Mute button in the
editor window.

*
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Input Strip
The input channel strip is the fundamental element in the mixing window. This is where an audio signal is
routed, processed, and then sent to either a mix bus or the master channel. An input channel strip can be
mono or stereo.
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Mixbus Strip
There are 8 “mix bus” channels. These are fed from the mix bus sends of the input channels.
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Master Strip
Mixbus provides a single Master channel. The Master channel provides the final output signal for listening
via speakers or exporting to wav files.
The Master channel has a built-in transparent signal limiter (with look ahead) to avoid the distortion that
occurs in overly loud digital signals (The plug-in shown in the redirect box is for display purposes and may
require separate license).
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Monitor Section
The “monitor section” is a signal path that may be inserted between the master bus and your speakers. The
Monitor allows you to control what you hear, without affecting the main mix which will be exported. It is
important to avoid using the master bus fader as your “volume control” while mixing, because changes to
the master fader will be applied to your final mix. Instead you should use the master bus to set the level of
the final mix, and use a separate volume control to adjust your “listening level”.

This “listening level” can be provided by your laptop speaker volume, your powered speaker volumes, a
mixer, or a dedicated monitoring solution. In many cases the Mixbus “monitor” section might be the
preferred option for controlling your listening volume.

The monitoring section serves these functions:

1. It provides a “volume control” that can be used to adjust your listening level, without affecting the level
of your actual mix.

2. It allows some conveniences such as “mono”-izing your mix, or muting speakers, so you can audition
your mix in mono.

3. Because the monitor path provides a separate listening path outside of the mixer, it is possible to
send Solo’ed tracks to the monitor, without affecting what is happening to the main mix. This is called
AFL or PFL soloing. (more details below)

4. It allows the insertion of plugin processors. These processors can be used for room EQ or other
corrective measures. The processors only affect the listening path, not the main mix.

5. It allows the selection of any physical output ports on your D/A converters. This can be used to switch
between alternative monitoring systems.

To enable the monitoring section, go to Session> Properties->Monitoring, and click “Use monitor section in
this session”. Once activated, the monitor section will be visible on the rightmost side of the Mix Window.
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The Monitor volume knob does not adjust the volume of the Metronome ( “click”). By default,
the outputs of the click are connected directly to the first 2 outputs on your soundcard,
which typically feed your speakers directly. You can adjust the volume level of the click by
visting Preferences->Misc->Click. And you can change the outputs of the click by visiting
Window->Audio Connections.

*
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The Mixbus Monitoring Section:
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Examining the Various Volume Controls in a Typical System

The Volume Control on Your Monitors:

Usually you can find a volume control on your monitors (if they are active) or on an outboard amp (if they
are passive). This volume control is suited to calibrating your monitors to a reference SPL. Once calibrated
you can forget about this control other than periodic re-calibrations (SPL calibration of monitors is beyond
the scope of this document but much information is available on the internet).

The Master Fader

The pitfall of using your master fader as a monitor level control:
Lets say you adjust your master fader to achieve the ideal monitoring level, and later you attenuate it to give
your ears a break. If you forget about this attenuated setting it could easily lead you to make some poor
mixing decisions later. Additionally, you may print your mix at this attenuated level (bad mix decisions and
all) and not realize it.

The Audio Interface

Some audio interfaces allow control of the output after the master fader with either a hardware or software
based volume control that accesses the internals of the interface. Some are elaborate and some are simple.

Whether your monitors are calibrated to a reference SPL or not, a monitoring section is still
vitally important in achieving a consistent sound.*
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Gain Staging

Click above for video instructions.

Digital Audio: Headroom and clipping
Digital audio represents the audio waveform as a series of numbers, each number indicating a voltage in the
electrical signal when it was converted from (or to) an analog signal. More numbers (voltage levels)
represents more accuracy in the signal’s representation. Too few numbers introduces “quantization noise”.

For our purposes, the “noise floor” of a signal is the noise level in the quietest part of the recording; this
might include noise that was picked up by the microphone, or dither noise that was used to cover up
quantization noise inherent to digital maths. If the noise floor is less than the noise in your environment,
then you won’t even notice it.

Generally speaking, 16-bits worth of numbers can recreate everything between a typical quiet-room noise
and a very loud sound (i.e.“CD quality sound”). A 24 bit number can store signals from an infinitesimally
small noise floor (lower than a very quiet studio), all the way up to a roaring jet-engine volume.

Regardless of the number of voltage steps, there will be a value that indicates “maximum volume”, and if
you exceed that value, then the system must “clip” the excessive values to the largest possible value.

Quantization noise happens whenever you represent the signal with fewer steps than you
had before. This happens quite often inside the computer, where the bit depth changes
depending on many factors. Quantization noise is slightly more offensive than “regular”
(random) noise. For these reasons, we must make sure there’s enough random noise to
cover up any quantization noise that we’ve introduced. This technique is called Dithering,
and careful use of dither is one of the reasons that Mixbus sounds great.

*
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A very short “clip” is almost always unnoticeable (just at the peak of a snare-drum hit, for example). But
sustained clipping, when the signal is significantly outside the bounds of the “real world”, creates lots of ugly
distortion that we want to avoid.

So our goal is to prevent signals from clipping, but keep them well clear of and above the noise floor. Luckily
with modern 20+ bit converters, this is very easy to do.

With modern A/D converters, we recommend that you record your signals with the peak meter never
exceeding -15 dB. This indicates that the signal was far from the clipping level when it was converted to
digital. With the increased low-level resolution of modern converters, it is not necessary to record at high
levels.

Floating-point processing
Internally, Mixbus uses a technique called floating-point math. For our purposes, this means that some extra
bits are reserved to store numbers outside the range (both louder and quieter) than the range of the analog
world. This means that it is essentially impossible to “clip” the math inside Mixbus. In practice, this means
that you can boost a signal very loud – even louder than would normally be allowed in the analog realm –
and as long as you reduce it by the same amount later, it won’t be clipped when it is heard at the output.

To this end, Mixbus provides many levels of gain adjustment which will allow you a wide range of creative
options.

Region Gain and Region Gain Curves

• Region Gain and/or Gain Automation: Increasing a region’s gain in the editor will provide:
◦ Each region has a volume setting (accessed with the Cut Gain and Boost Gain shortcuts). The

gain increase/decrease visibly affects the waveform display
◦ Region gain curves allow the gain to change through the length of the region

Channel Strip Gain stages

1. Channel Input Trim: This stage is used to bring the overall level of the track to a usable level. The
trim knob is located near the fader for easy access.

2. Fader: Used to achieve an overall balance of all tracks in a session. This is also a good place to
make artistic changes such as bringing an instrument forward during a solo.

3. Make up gain within the In-line compressor: Make up gain is used to restore perceived level loss
during compression. If the compressor meter is hitting -3 dB during transients, a make-up gain of 1 or
2 dB may be useful. It can also be used as a fast and easy way to adjust the level post fader.
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Mix bus

1. Input Trim: This knob is used to adjust the volume at the input of the master bus.
2. Tape saturation: The tape saturation meter does not monitor level, rather it monitors the amount of

saturation effect. This effect will add harmonic density which can result in an increase in perceived
loudness. Turning the tape saturation knob off will allow signal to pass unaffected.

3. Fader Used to achieve an overall balance of all tracks in a session.
4. Make up gain within the In-line compressor Make up gain is used to restore perceived level loss

during compression. It can also be used as a fast and easy way to adjust the level post fader.

Master bus

1. Input trim This knob is used to adjust the volume at the input to the master bus. This is a useful tool if
you’ve balanced the mix with the track faders, but the overall level is still too low or high.

2. Tape saturation The tape saturation meter does not monitor level, rather it monitors the amount of
saturation effect. This effect will add harmonic density which can result in an increase in perceived
loudness. Turning the tape saturation knob off will allow signal to pass unaffected.

3. Fader Used to achieve an overall volume of all tracks in a session.
4. Make up gain within the In-line compressor Make up gain is used to restore perceived level loss

during compression. It can also be used as a fast and easy way to adjust the level post fader.
5. Final Limiter The final limiter is a brickwall, lookahead limiter with a very fast attack and release. The

threshold is preset at -1 dBFS. If a signal peak is going to exceed -1 dBFS, the lookahead limiter will
reduce the volume slightly before and after the peak. Yellow indicators show gain reduction in
increments of 1 dB.

Monitor Section (if enabled)

1. Attenuator provides an output level for the speakers, as well as mute and a configurable “dim”
control. Use these controls to reduce the volume in your speakers WITHOUT affecting the level of the
master bus output. For more details, visit the Monitoring Section
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Mute and Solo

Exclusive Solo:
ctrl + alt + click on a Solo button (OSX: command +control + click)

On the solo/mute controls left-button (button 1) mouse clicks do the following, depending on holding these
keyboard modifiers:
no mod: toggle solo on/off

• Primary mod: override track group
• Primary + Secondary modifiers: exclusively solo this track
• Primary + Tertiary modifiers + click: apply to all

Middle-click (button 2)

• no mod. : momentary toggle (until release)
• Primary mod: assign generic MIDI. (if generic midi control surface is enabled)

Right-click (button 3) brings up a context menu:

• Solo Isolate
• Solo Safe
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• Mute-points

These shortcuts (group override, apply to all) are also available for other controls where applicable (e.g
meter-point,..)

*PC-keyboards: Primary = Ctrl, Secondary = Alt, Tertiary = Shift
*Apple-Keyboards: Primary = Command , Secondary = Control

If the session has a monitor section (Session > Properties > Monitoring), there are additional controls for
Exclusive Solo, Mute/Solo overrides and Pre/After Fader Listen available. click here

When you solo a track, the other tracks are “implicitly muted”. The yellow frame around the “mute” button
shows you which tracks are muted by another solo.
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Like a real console, the mixbuses are a separate mixing stage. Imagine the 8 mixbuses are like a second,
standalone mixer. So when you solo a mixbus, the other mixbuses are “implicitly muted”. There’s no
interaction between the inputs and the mixbuses, so soloing a mixbus does not implicitly mute or solo any
tracks.
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Utility buses aren’t really a mixing stage at all; they are just a signal path where you can combine other
paths (or split them out from a multichannel plugin, for example). In this case, when you solo a utility bus
then it also has to solo all the things feeding into it. Similarly, if you solo anything, it has to make sure that
the “utility buses” that it feeds are soloed and this causes other stuff to get implicitly muted.

The best plan is to keep your signal paths simple, and you’ll get the best results. Just because you “can”
add a bunch of buses and options, doesn’t mean that you “should”.
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Redirects: Plug-ins, Sends & Inserts…
The black box near the top of each channel strip, mix bus, and master bus is the “redirect box”. Mixbus uses
the term “redirect” for the items that can be inserted into a channel strip: plug-ins, sends, and inserts. In
the image below, the track on the left has the “XT-BC Bass Character” plug-in, the track on the right has an
insert and a send. The XT-BC Bass Character plug-in and the send are pre-fader (because they are above
the fader entry) while the insert is post-fader. The signal flow of Mixbus is very flexible: you can order sends,
inserts, plug-ins and the fader arbitrarily (XT-BC plug-in shown are for display purposes and may not be
included).

• Plug-ins
• Sends and Inserts

Plug-in Control Sliders

Below each plug-in, you may add one or more “Plug-in Control Sliders”. Each Slider controls a single control
parameter for the plug-in it is under. You may show or hide plug-in control sliders by right-clicking on a plug-

Note: By default, plug-ins and inserts will be created pre-fader, while sends will be post-
fader. But you can drag them into any order you choose.*
Channel strips are created preconfigured with an EQ and Compressor plug-in already
installed (the top two reddish plug-ins in the above image). Signal routing can be changed
by reordering here. The controls for these are found within the GUI of each channel strip.
*
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in and selecting “Controls”. In the above image the “XT-BC” plug-in has control sliders shown for “Body –
Freq” and “Clarity -In”.

The Redirect Menu

Right-clicking in a redirect box will launch the redirect menu. These choices are available in the menu:

• New Plug-in>
◦ Favorites: a list of favorite plug-ins, pre-selected from the Plug-in Manager (more here).
◦ Plug-in Manager: launch the Plug-in Manager (more here).
◦ By Creator: a list of plug-ins, sorted by their creator.
◦ By Category: a list of plug-ins, sorted by type (note: this is only useful for plug-in formats that

support this).

• New Insert: create a new Insert (Send and Return).
• New External Send: calls up routing matrix
• New Aux Send: create a new Send.

—————————————-
• Controls: Allows the addition of one or more “Plug-in Control Sliders” to be displayed.
• Send Options: Link panner controls.

—————————————-
• Clear (all): Remove all redirects from this track/bus.
• Clear (pre-fader): Remove all redirects from this track/bus pre-fader.
• Clear (post-fader): Remove all redirects from this track/bus post-fader.

—————————————-
• Cut/Copy/Paste/: Cut/Copy/Paste/ the selected redirect.
• Delete: delete the selected redirect (you can also shift-left-click any redirect to delete it).

—————————————-
• Rename: Rename the redirect (yes … even inserts and sends)

—————————————-
• Select All: Selects all redirects
• Deselect All: Deselects all redirects

—————————————-
• Activate/Deactivate All: Activate/deactivate all redirects on this track/bus.

—————————————-
• Edit: Pop open the editor for the selected redirect (you can also double-click on any redirect to edit it).
• Edit with generic controls
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Redirect Box Signal Routing

Within the redirect box, and in between the plug-ins, are a series of green and/or red dots called “pips” that
represents the signal routing between plug-ins.

Mono audio = one green pip: In the image above the channel strip on the left is a mono audio track. A
single green pip representing one channel of audio is routed to the EQ, then to the compressor, and on to
the fader.

Stereo audio = two green pips: In the image above the channel strip in the center is a stereo audio track.
Two green pips representing two channels of audio is routed to the EQ, then to the compressor, and on to
the fader.

MIDI data = red pip(s): In the image above the channel strip on the right is a MIDI track. One red pip
representing MIDI data is entering the MIDI plug-in. The MIDI plug-in then generates audio based on that
data. In this example the audio is stereo as can be seen by two green pips passing to the EQ, on to the
compressor, and then to the fader. MIDI data is also passing thru the MIDI plug-in. The EQ, compressor,
and fader are not processing this MIDI data, just passing it thru.
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Processor Signal Flow

Signal Flow through the Processor List:
The “processor list” is the black box at the top of every Mixbus channel strip. You can imagine the
“processor list” as a container for a series of guitar-pedal processors; each processor must be connected to
the processor before and after it.

Often, the signal flow is very simple. For example, a mono track will most likely have a series of mono
effects applied. In this case, you’ll see a picture like this:

In this example, the signal is processed by the channelstrip EQ, the Compressor, the
Fader, and finally a Gate plugin. The signal flow proceeds from top to bottom, and the
green “pips” between each plugin show the audio signal connections between each
redirect.

But what happens if you want to use a plugin that has stereo I/O? Just like a guitar pedal,
you might choose to use only the left-side signal for the mono track. But there are other possibilities as well.
The plugin might have 1 input, and create a stereo output (such as an auto-panner, or reverb/delay effect).
Or the plugin might have an extra “sidechain” input to trigger a gating or compression effect. Or the plugin
might be an instrument that has 16 individual outputs for different drum sounds.

Starting with Mixbus version 3.3, the signal path between redirects is highly flexible, while also using
sensible defaults.

Sessions created with Mixbus versions before 3.3 will have tracks that preceded these
rules. For backwards-compatibility, we will load those sessions with the old rules. In some
cases you might want to use “Pin Connections” (described later on this page) to improve the
routing of those old sessions.

!
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Why is this so complicated?
Mixbus tries to do the “right thing” by default. Mono channels will get mono plugins, and stereo channels will
get stereo plugins. Virtual instruments will appear with stereo outputs, by default. But if you want to change
these settings, there are quite a lot of variables that must be considered.

There are several challenges inherent to the signal flow through a channel using plugins:

• Plugins may be drag/dropped into any order
• Some plugins can be fed a “sidechain“signal which should allow the possibility of being sourced from

any other track.
• Often you need to use a plugin in ways that it wasn’t intended (only using one side, for example)

Additionally, each of the Mixbus-supported different plugin formats provide different rules:
1) LV2 and LADSPA plugins typically have fixed I/O such as 1->1, ( 1 input, 1 output ) or 2->2
2) VST plugins (Windows) typically have a fixed I/O configuration, but can be told that some signals aren’t
connected.
3) AudioUnit plugins (Mac) allow the HOST to define how many connections they will have. So Mixbus can
request a mono (1->1) or stereo plugin as-needed. But the user also has the option to change the
configuration, if they want to do something unusual.

Finally Mixbus can “replicate” plugins. If you try to insert a mono plugin on a stereo strip, Mixbus will
automatically create 2 plugins, and send the controls from the first plugin to the second. This allows you to
process both sides of the stereo signal using the same settings of an EQ, for example. You can add or
remove replicated plugin instances using “Pin Management” ( see below )
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Pin Connections
Right-click on a plugin to reveal the “Pin Configuration” dialog:

By clicking on the pin connections, you may drag a connection between the channelstrip signal flow, and the
embedded plugin processor. Right-click on a pin to remove all connections to that pin.

One can also bypass plugin instances with a ‘thu’ connection by dragging an input pin directly to an output
pin. This connection is latency compensated to match the delay through the plugin.

The “Pin Configuration” dialog provides these additional features:

• Manual Config : click to enable the configuration buttons, below:
◦ Instances : increase/decrease the number of plugin instances inside the processor
◦ Audio Out : increase/decrease the number of audio outputs that the plugin can access
◦ MIDI Out : increase/decrease the number of MIDI outputs that the plugin can access

• Output presets ( virtual instruments only ) : click to choose how many outputs the instrument will
provide

• Side Chain : click to enable a sidechain input for the plugin.
◦ When Side Chain is enabled, the sidechain source may be managed with the buttons below it.
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Plug-ins
Plug-ins are small pieces of signal-processing software that Mixbus can load inside itself and assigned to
channels. Channels may have an unlimited number of plugins, inserts and sends on a channelstrip.

You can add plug-ins in several ways:

• double-click in the black “redirect” area to launch the Plug-in Manager
• right-click in the black area, and choose New Plug-in, then:

◦ Favorites
◦ Plug-in Manager
◦ By Creator
◦ By Category

When you first install Mixbus, it does not recognize your installed plug-ins. To scan your
plug-ins (and tell Mixbus to scan for plug-ins on startup in the future), please visit Mixbus-
>Preferences->Plug-ins and click the “Scan” button.
*
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Adding, Removing, Reordering, and Disabling Plug-ins

Each plug-in is displayed as a rectangle in the redirect box. Plug-ins are red if they are pre-fader (above the
fader), and green if they are post-fader (underneath the fader)

• double-click the plug-in to show the plug-in control panel
• click the plug-in to select it ( it will turn red ). Now click “Delete” to delete it.
• click & drag the plug-in to change its order in the signal flow
• click the small green indicator on the plugin to enable/disable the plug-in

A note about categories: some plug-in formats (such as LV2) provide a very well-defined
method to categorize plug-ins. Most older formats (including VST2 and AudioUnits) do not
provide good support for categories.
*
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◦ (you can also middle-click on a plug-in to enable/disable it)
• right-click on a plug-in to see the plug-in context menu
• shift+right-click a plug-in to delete it

Plug-in Favorite Window

In the upper left side of the mix window is the Plug-in Favorite Window. You can drag and drop plug-ins to
and from a channel strip.
A new favorite can be save and even a preset for the plug -in can be saved and recalled from this window.
Multiple channel strips can be selected and a plug-in can be inserted.
Left clicking on a plug-in or preset name is another way of adding plug-ins to the channel strip.
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Sends and Inserts
Sends

When a new send is created, a window for configuring the Send will immediately appear.

By default, Sends have no outputs and must be configured as needed. Click “add” to add ports, and connect
them to the destination that should receive the output of the send.
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• Add/Remove: adds/removes a port to the send.
• Disconnect All: disconnects all ports (does not remove ports).
• Available connections: This is a list of all the available connection ports, with one tab for each

application, and one for the system sound I/O (“system”).

After a send has been configured, a double-click on the send will launch the Send Editor:

Note: The number of “ports” created will define the channels of the send. Sends can have 1
(mono), 2 (stereo) or more (multichannel) ports assigned.*
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In addition to the output management, The Send Editor also has a volume slider and a panner (if the
number of outputs is > 1).

Note: Sends are created “deactivated”, you must Activate the send before it will work.*

Sometimes when you mute a track, you still want a Send to remain active (for a headphone
feed, for example). It is possible to disable the mute for pre- and post- fade sends*
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Inserts

An Insert incorporates a “send” output and a “return” input. The Insert send/return allows the audio signal to
be routed out of a channel and back into it, after performing some external processing. Inserts are often
used to “patch in” a piece of outboard gear that is not available as a plug-in (just like you might do with a
patch bay on an analog console)

• Measure Latency: Once your insert is connected to an external piece of gear, then click this button to
measure the latency. If the Insert is used on a track or mix bus, this delay will be accommodated
automatically.

Outputs

• Add/Remove: adds/removes a port to the insert “send”.
• Disconnect All: disconnects all sending ports (does not remove ports).
• Available connections: This is a list of all the available connection ports, with one tab for each

application, and one for the system sound I/O (“system”).

Inputs

• Add/Remove: adds/removes a port to the insert “return”.
• Disconnect All: disconnects all return ports (does not remove ports).
• Available connections: This is a list of all the available connection ports, with one tab for each

application, and one for the system sound I/O (“system”).* Available connections: This is a list of all
the available connection ports, with one tab for each application, and one for the system sound I/O
(“system”).

separately. To enable or disable the pre- and post-fader send mute, right-click on the Mute
button in the editor window.

Note: Inserts are created “deactivated”, you must Activate the insert before it will work.*
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Bussing

A bus is a common signal path that one or many audio signals share to arrive at a common place.
The routing of a bus determines which audio tracks will be bussed and where they go.

Bussing will send the audio from one place to another, usually one or more channel strips to Mixbus 1
through 8 (or optionally to a “utility bus”). This allows for better organization of a session and an easier way
of producing a “pre-mix” of specified tracks (ex. Drums, Guitars) before they are bussed to the master fader.

Bussing is also less taxing on your computer. Inserting a plug-in, such as a reverb, on a bus saves the need
of inserting a reverb across many individual tracks. This also ensures the plug-in applies the same effect
across all the tracks being bussed for a more coherent and realistic sound.

Utilizing a mixbus

By default 8 busses are already set up and routed to the 8 corresponding channels labeled Mixbus (you may
change the name by right clicking on the label). You can send audio to any of these mix busses by clicking
on the appropriate “Send button” on the channel strip above the fader. Using Ctrl click will automatically turn
off the master send at the same time. Next, set the gain of your new send to the desired level using the
knob to the right of the send button.

You may “send” audio from many channels strips to a bus using this method.

A mix bus has no recorded audio stored in it like an audio track does. A mix bus serves to
sum and processes audio signals and than pass that audio, usually to the master channel
strip.
*

By leaving the master send on and engaging a Mixbus send you may hear both audio feeds
simultaneously. The result will be an increase in volume in-which you may perceive as a
better sound, when in actuality its just simply louder.

!
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Bussing shortcuts

• Control clicking (Command on Mac) a bus will exclusively-assign the track to that bus (other buses
will be turned off, so the track ONLY goes to the selected bus

• Shift+Control clicking on a bus will assign ALL tracks to that bus. This is a quick way to send (or
remove!) every track from a bus.

In the picture below a Send from the track on the left, labeled VOX, has been routed to Mixbus 1 and the
gain of that send attenuated from a default of 0 dB to about -18 dB. The amount of gain or attenuation is
displayed in the slate area while making changes (in this image the slate has a label of “VOX”). The master
send on the VOX track is turned off as denoted by the absences of the blue indicator. The name of the send
is tied to the name of the mixbus (i.e. if you rename mixbus 1 it will relabel the send to reflect the change).

Sub Groups
Similarly to the above example, a sub group is comprised of 1 or more audio channels routed to a mix bus.
A common scenario would be to send multi‑miked drum kit to a single mix bus.

Like an actual hardware console, Mixbus has dedicated channels (Mixbus 1 through 8) with
routing already configured for a fast and efficient work flow. Furthermore, these dedicated
channels are uniquely designed for this task.
*
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Utility Buses
Utility buses are audio channels, just like tracks, but they do not record or play back audio. Instead, they
accept audio at the input, process it, and send it to the mixing buses. ( In Pro Tools, these are called Aux
Tracks )

Setting up a Utility Bus

• Click on the + (plus) button at the top of the group box slide out drawer on the leftmost side of the mix
window and select “Busses” from the drop down menu. Name your buss if you like, review all settings,
and click the “Add” button.

• Click on the Input button to select the soundcard input, or any combination of tracks and buses that
you want to feed into the utility bus.

◦ OR, if you want to use the bus as an “aux” with a level-controlled send from each source: Right
click in the redirect box within the channel strip you wish to bus and select “New aux send”. A
list will appear with your newly created bus.

In this example 1 mono bus has been selected for addition to the session.

After creating the Utility Bus, to route audio from a channel strip to the bus, right click in the redirect box of a
channel strip and select “New Aux Send…” from the context menu.

A Send will appear in the redirect box with a gain control slider.
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The context menu Send Options > Linking Panners is not available at this time.

A utility bus, like a mix bus or master bus, has no recorded audio stored in it. A utility bus
serves to sum and processes the audio.*
Utility Buses allow arbitrary routing ( even loops). For this reason, utility buses currently do
NOT provide latency compensation. If you add a plug-in to the utility bus, it may cause a
discernible delay if it is summed back into the “clean” signals. If you use utility buses as a
convenience to combine several signals into a single path, and you don’t also assign those
signals to a different path, then you likely won’t find the delay bothersome. Similarly, if you
use a utility bus as a “reverb” aux bus, then the slight delay caused by the plug-in latency
will probably be unnoticeable. If you want flexibility to assign signals to multiple parallel
paths, AND maintain perfect latency compensation, then you should use the 8 provided
mixbuses.

!
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EQs
Channel Strip EQ

The Channelstrip EQ provides a very wide range of frequency and gain changes ( up to 15dB! ) to help tame
your tracks. The high and low bands are shelving filters for general tone sculpting, while the middle band is
a “proportional Q” design.

The proportional-Q design was used in the original Harrison consoles to allow an engineer to use the EQ as
either a subtle tone shaping tool, or a steep filter problem-solver, with only 2 knobs. As the gain is
progressively increased (or cut), the Q becomes progressively narrower. A typical technique is to increase
the gain to maximum, sweep the frequency to find the offending sound, and then turn the gain to minimum
to “notch” out the unwanted frequencies.

Specifications:

Gain Range +/- 15dB

Frequency Ranges (adjustable):

• HI: 800 Hz to 15,000 Hz Q=1.0 Shelf
• MID: 200 Hz to 4000 Hz Proportional-q bell
• LO: 40 Hz to 400 Hz Q=1.0 Shelf

HPF 12 dB/octave, frequency ranges 20 to 1,000 Hz

Mixbus EQ

The Mixbus EQ provides carefully chosen center frequencies, and wide tone-shaping shapes, to provide
overall tone control of the signal on the bus. The gain range is slightly lower than the channelstrip EQs, to
provide more nuanced controls.
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Specifications:

Gain Range +/- 9dB

Frequency Ranges (fixed):

• HI: 2000 Hz Q=1.0 Shelf
• MID: 800 Hz Q=0.7 Bell
• LO: 300 Hz Q=1.0 Shelf

Master Bus EQ

The Master Bus EQ provides very fine control of the final output tone. The band frequencies are carefully
chosen to address the problem areas of a typical pop music mix: very low frequencies, mid-low frequencies,
and “very high” frequencies ( leaving the primary mid-band relatively unchanged, as the reference ) The
limited gain range ( +/- 6dB ) provides for very fine adjustments.

Specifications:

Gain Range +/- 6dB

Frequency Ranges (fixed):

• HI: 4000 Hz Q=1.0 Shelf
• LO/MID 300 Hz Q=0.7 Bell
• LO 90 Hz Q=1.0 Shelf
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You can copy EQ settings from one track to another by dragging the EQ processor (in the
processor list at the top of the channelstrip) onto another channel’s EQ processor.*
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EQ Techniques
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Compression Techniques

What is a compressor?
A compressor is a device that automatically reduces the volume of a signal when it exceeds a threshold
volume level. Knob settings determine how fast it will decrease the signal, as well as how strong the effect
is. Compression can serve the technical purpose of reducing the dynamic range of a signal; or it can be
used as an artistic effect by changing the sound’s volume envelope.

Basic controls of a compressor

• Threshold: The “threshold” defines a level at which the compressor will start to activate. Signals
quieter than the threshold will not be affected by the compressor. For more dramatic compression,
drag the threshold “down” so that it overlaps more with the input meter.

• Ratio: Ratio defines the strength of the compression once the signal exceeds the threshold. With a
ratio of 10:1, exceeding the threshold by 10 dB will only result in an increase of 1 dB at the
compressor’s output.

• Attack/Release: the attack and release speed affect how fast the volume change can happen. You
can adjust these settings to avoid objectionable artifacts of the compression effect (if used for
dynamic-range control), or to accentuate the effect (if used for artistic purposes).

• Makeup gain: A compressor reduces the loudest signals of a track. Makeup gain is used to bring the
complete track back to the level before it was compressed. The makeup gain applies equally to the
loud and quiet signals, so the quiet parts are effectively made louder after compression and makeup
are applied.
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Mixbus provides a compressor on each channel strip. Each compressor has 3 modes (Leveler, Compressor,
Limiter) which can be selected. In the section below, we explain the most common compressor techniques
and how to achieve them using the Mixbus channel strip compressors.

Compression Techniques

It is commonly touted that ‘a great compressor makes everything sound better’…. but what does that mean,
and is it really true? Ignoring the crosstalk, noise, frequency-response irregularities, and distortion inherent
to these boxes, why are compressors desirable? In this section we will try to objectively evaluate why some
mixers like to use compression on their tracks. It’s worth mentioning that some of the best mixes were made
with little or no audio compression. But if we know what a compressor does, then we can make sensible
decisions whether to apply compression or not.

1. Leveling: The “leveler” mode has a very low ratio, a very fast release, and an adjustable attack (via
the “Speed” knob). Due to mic technique or other elements out of our control, sometimes a signal has
a very wide dynamic range. The “leveler” with a fast attack can be used to transparently reduce the
level of the loudest parts, so that the track has a more consistent level. Reducing the dynamic range
of our tracks can make them easier to mix, although it might rob some of the performance’s natural
dynamics. The leveler with a slow attack allows the initial sound (the first syllable of a word or phrase,
for example), to be passed through at full volume, while reducing the “body” of the sound slightly. This

Harrison Consoles Mixbus v3 - 1

Page 198 of 420



retains and enhances the character of the recording, and it can help improve intelligibility of words
and instruments in a busy mix.

2. Compression: The “compressor” mode is more aggressive than the Leveler. It has a fixed attack/
release time, and an adjustable “ratio” (compression strength). Compression dramatically reduces the
dynamic range of the signal, and it is less transparent than the leveler. Compression is a natural effect
of amps driven to their limits, or vocal shouting. Therefore our brains perceive compressed signals as
“louder”, regardless of their actual volume. Because the loud signals are brought much lower, it
makes the quiet signals sound as loud as the loud parts. This means that mouth noises, valve noises,
and other ancillary sounds will sound more pronounced. This can impart a “nearby, in-your-face”
effect.

3. Limiting: The “limiter” mode has a nearly-instant attack, and a variable release. A limiter is a very fast-
acting compressor, and these were initially designed to capture signal peaks before they were passed
on to sensitive broadcast antennas, disc-cutting lathes, or speaker systems. Limiters have a very fast
attack and a very high ratio, making them destructive to most signals. A limiter can be used to blunt
the very short peaks of drum hits, and therefore allow the overall level to be increased. It must be
used very sparingly though, or the signal will sound distorted.

The mixbus strips provide a 4th mode, “Sidech”. See Sidechain compression for more details.

In addition to the channelstrip compressor, the master bus provides a final limiter. This is a look ahead
brickwall limiter set at -1dB, and it protects your final mix from exceeding full-scale digital. The “lookahead”
feature is a delay that reduces the distortion it applies your mix, at the cost of some latency. See Mastering
Techniques for more details on how (and when) to use this limiter.

The Harrison Mixbus Compressor Modes:
1. Leveler: The attack is adjustable and the ratio/release are preset. Turning the knob clockwise

increases the attack time ( makes the attack slower ).

Harrison Consoles Mixbus v3 - 1

Page 199 of 420



2. Compressor: The ratio is selectable and the attack/release are preset. Turning the knob clockwise
makes the ratio higher.

3. Limiter: The release is selectable and the attack/ratio are preset. Turning the knob clockwise
increases the release time ( makes the release slower ).

These 3 modes are designed to provide the most common compressor settings for music.

Additional Harrison developed compressor plug-ins and Compression
Techniques:

You can copy compressor settings from one track to another by dragging the compressor
processor (in the processor list at the top of the channelstrip) onto another channel’s
compressor processor.
*
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Sidechain Compression

Compression is an automated way of reducing a signal’s level, dependent on the signal’s own loudness.
The louder the signal is, the more the compressor will reduce it. Side-chain compression reduces the level
of the signal using a different signal to trigger the volume reduction.

In pop/rock music, this technique is sometimes used to “duck” the bass guitar on each kick-drum hit, making
the bass and kick drum sound like a single instrument. In dance/EDM styles, it is often used to generate a
“pumping” effect using the kick drum or a “ghost” kick drum track that is not actually heard. In this case the
release is set very slow; after each beat the signal slowly rises, reaching full intensity just before the next
beat.

Mixbus provides 2 different methods of sidechaining: a fast and simple built-in method, and a more
complicated method that uses 3rd-party plugins.

Simple sidechain technique using Mixbus’s built-in
Sidechain bus:
A sidechain “send” toggle is built-in to the channel strip, just to the right of the master bus assign button.

image above: the sidechain toggle is highlighted red when active
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This is the signal that gets assigned to the sidechain bus. The signal is generated at the very end of the
channelstrip; this guarantees that it incorporates all the necessary timing offsets so that any plug-in latency
on the track(s) is accommodated.

Mixbuses have a mode, “Sidechain”, which uses the signal on the sidechain bus to compress, or “duck”, the
signal on the mixbus using the onboard compressor. To guarantee time-coherence, the channel strip
compressor element should be located before (above) any plug-ins that cause latency (otherwise, the main
signal will be delayed in comparison to the sidechain send).

Multiple tracks can be assigned to the sidechain bus (their signals will be summed together). Multiple
mixbuses may pick from the sidechain bus.
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Advanced sidechain technique using third-party plugins and
the plugin pin-management dialog
This technique is much more complicated and depends greatly on the plug-ins you have available, the
quality of the plug-ins, and many other factors including the effect of latency on the signal flow. However it
does provide more flexibility; firstly you will have more compressor parameters to change, and secondly you
have more options where to place the plug-in, including other input channels or the master bus.
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Mastering Techniques
“Mastering” is the process of preparing a sound track for distribution.

“Mastering” might involve, but is not limited to:

• Critical listening, to verify that there are no technical errors in the final product.
• Fixing equalization problems that were caused by poor acoustics in the original production/mixing

room.
• Applying final tone control to match the overall tone of other tracks in the collection, or comparable

tracks in the same genre.
• Applying final loudness adjustments to match the level of other tracks in the collection, or comparable

tracks in the same genre.
• Sequencing of tracks into a collection ( i.e. sequencing songs on a CD ).
• Applying frequency-limiting and dynamic-range adjustments, to match the media that will be

distributed.
• Creation of metadata (such as track markers, song name(s), performance rights, etc ) for the

distribution media.
• Exporting/packaging the distributable in a format that is suitable for the next stage of duplication/

distribution.

Although many of these tasks are outside the scope of Mixbus, Mixbus provides several tools that can help
with the mastering process.

Master Bus Processing and Metering
The master bus provides a suite of processing and metering that helps achieve the overall tone and
loudness that the artist wants.

Master bus strip tone controls

The master bus provides a 3-band EQ (“tone”) control for the final output. The tone control has a fairly
limited range ( +/-6dB) for fine control. The center frequencies are optimized to solve problems that are
commonly used in the final stages of mixing:

• Low: a low-frequency shelf at 90Hz : the Low band is provided to balance the low bass content of the
track, without having to re-mix the bass instruments.
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• Low Mid: a wide bell shape at 300Hz : many instruments have strong output in the low-midrange, and
they can combine to make too much energy in this range. This range is also a site for tape-saturation
harmonics. The “Low Mid” band is provided to increase or decrease the main band of music.

• High: a high-frequency shelf at 4,000Hz : A high-frequency shelf at 4 kHz allows you to brighten the
entire track without unduly affecting individual instruments.

Master bus strip compressor

The master bus strip compressor operates like the channelstrip compressors. ( see : Compression
Techniques )

Because the master bus strip compressor is applied before the Master Limiter, this provides a chance to
level-match parts of a song (using the leveler mode), or to clip outstanding transients before they reach the
master limiter (using the limiter mode).

Typically a very small amount of compression is needed on the master bus, therefore the master bus limiter
threshold has a very different “scaling” than the channelstrip compressors. You have to pull the threshold
down much lower before it has any effect.

The order of master bus compressor, fader, and EQ may be manipulated to achieve a wide range of desired
effects before the signal is finally sent to the master bus limiter.

Master Limiter

The master bus limiter. It has no controls other than an on/off indicator.

The Master Limiter is a lookahead limiter with a very fast attack and release time. The “lookahead” is a short
delay, that allows the limiter to “look ahead” and begin reducing the gain before a loud peak occurs. This
dramatically reduces the distortion that is caused.

Each segmented LED represents 1 dB of gain reduction.

Compared to Mixbus v2, the release time of the Master Limiter has been dramatically shortened. This allows
the master limiter to operate more aggressively without noticeably lowering the volume of the track’s
average level, or pumping.
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Plug-ins

There are many plug-ins that are developed specifically for the master-bus output, for the purpose of
increasing the master output level. These may be placed in the channelstrip signal flow, and used instead
of, or in conjunction with, the Mixbus master bus processors.

Stereo Correlation (“Phase”) Meter

The stereo correlation meter provides an indication of the “mono compatibility”, or stereo width, of your mix.
The indicator uses a bright bar which simultaneously indicates the range of in-phase (highly correlated) and
out-of-phase (decorrelated) sounds in your mix.

• If the indicator is fully to the right, and yellow, this indicates a completely “mono” mix. (the signals in
the left and right channels are the same)

◦ many signals (such as a spoken-word recording with one microphone) should be mono.
• If the indicator is fully to the left, and fully red, this indicates a mix that is completely “out of phase”, in

other words the left and right channels are equal, but one is inverted with respect to the other. This
almost certainly indicates a technical fault which should be investigated.

• If the indicator is largely to the right, and green, then it indicates a mix with some stereo width, but
largely mono compatible. This is optimal for pop music recordings that might be played in a variety of
playback systems.

• If the indicator is in the center, showing a range of red and green, then the mix is very wide stereo.
This is probably not optimal for pop/rock recordings, but can be acceptable for natural or orchestral
recordings. Mono compatibility of this mix is questionable.

Mono compatibility is largely defined by low frequencies. If your mix indicates poor mono compatibility ( red
bar on the left ), then you can probably solve this by reducing the number of bass instruments in the mix,
high-pass filtering any non-bass instruments, and high-pass filter any stereo effects, such as reverb, in the
mix.

K-14 Meter

The K-14 meter is an RMS (averaging) meter, originally specified by mastering engineer Bob Katz as a
means to compare and help control the dynamic range of pop music mixes. (see : http://www.digido.com/
how-to-make-better-recordings-part-2.html )

The K-Meter displays the level of the signal directly before the output of the master bus. The K-Meter comes
after the fader, EQ, plugins, and final limiter in the master bus.
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If the K-14 meter indicator is straight up, at 0, this indicates that the sound’s average level is at -14dBFS.
This was selected as a good target for most pop/blues/jazz/rock recordings. At this level, a song will sound
quieter than most contemporary pop music, but when the listener turns the volume up to match, the
increased dynamic range of this mix will allow the song to sound much better than a typical pop song played
at the same volume.

Increasing the volume beyond the “0” indicator will result in a louder mix, at a cost of decreased fidelity and
impact when the user turns the volume up.

In the past, it was highly encouraged for mastering engineers to create music at the highest
possible average level, because this made the songs noticeably louder when they were
played adjacent to other performer’s songs on a CD or mp3 player. However, in the case of
modern radio broadcast, online channels such as YouTube, and internal processing in
iTunes and iPods, it is now likely that your music will be level-matched (based on average
loudness) with other songs. In this case, it is advantageous to mix at a lower volume, and
leave more headroom for short musical peaks which will make your mixes sound louder and
better than the more heavily-processed tracks that were popular in the early digital era.

*
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Automation

Region Gain and Automation

Mixbus has 2 separate types of automation: Region Gain and Automation. Region Gain envelopes are often
used for repair work, such as reducing unwanted breaths, accentuating syllables, or reducing noise.
Automation is often used for creative changes such as fading elements in and out during a song. Region
Gain only adjusts the volume (level) of the region across time. Automation can be applied to many different
mixing parameters including the input trim, fader, panning, or plug-in parameters.
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Fader, Pan and Plug-in Automation

Automation
The short video below demonstrates how to open an automation lane:

Automation is used to automatically change the setting of a knob, based on the time of the timeline. For
example you might want to increase the volume of a delay effect during the “chorus” part of a song, or
automate the master fader to make a smooth fade-out at the end of a track.

Many mixer parameters may be automated: fader, mute, pan, mix bus sends, eq, compressor, and plug-in
settings.

Real-time (“Touch”) Automation:

In Real-time automation the parameter is put into a “record” mode. While the transport is rolling, the user
moves a knob, and these moves are recorded.

In the Mixer window there is a dedicated automation button below every fader because this is a very
commonly-automated control (circled in red, below).

In the Editor window additional functions can be automated by going to the track header and clicking the “A”
button. Under “Processor Automation” are EQ parameters, Compressor parameters, and under “POST are
the Pan and mix bus sends and levels.
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Here is a description of the modes:

Manual Automation is ignored.

Play Whenever you locate, the parameter will jump to the value that is recorded in the automation.
You cannot change the value manually.
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Write
When locating, the value will stay as it is (no playback of automation). During playback (only),
the current value will be written to automation. You can move the control manually and your
move will be written to the automation.

Touch The parameter will act like it is in Play, unless you “touch” it with the mouse. Then it will
record your moves until you release the mouse button.

The mouse wheel has a slightly different automation mechanism. When the wheel is turned, it “touches” the
parameter and begins recording the move. The automation continues to record until the transport stops.
This is sometimes called “Latch” mode.

Automation Thinning:

When automation is recorded in real time, the automation data points are “thinned” so that only enough
control-points are created to adequately capture the moves. The points will appear very sparse if the control
is moving slowly, and will be created very close together during fast moves. The aggressiveness of thinning
can be adjusted if necessary via menu Edit>Preferences>Misc.

Punching in your automation with “Touch” mode:

When you punch-in, 2 points are created: one to hold the previous value, and one to start the new changes.
Similarly, when you release the control (or stop a pass in Write mode) then 2 points are also created: one
which ends the new changes, and one to hold the previously-existing value.

Graphical Automation Editing: Automation tracks

You hide and show automation lines using the “A” button on the track header, or right-click on the track
header and select the parameter for automation.

Tip: “Write” automation is a quick way to copy settings from one place to another. Locate
the playhead while the parameter is in “play” to pick up the value you want to apply
somewhere else. Now change the mode to Write, and locate to the new place. Then play
through the desired section to apply the setting.

*

Automation is only recorded during forward playback. However it is possible to record
automation while the transport is looping! Using this feature you can audition several
different passes of the automation. When playback is stopped, the most recently-recorded
moves will be kept. For example, if you loop 3 times and then stop halfway through the
looped section, the resulting automation will be the first half of the 4th pass and the last half
of the 3rd pass.

*
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Automation appears in a separate track from the audio. Multiple automation tracks may be shown
simultaneously. If the automation track is associated with an audio track, a “ghost” of the region’s audio will
appear in the track. Buses do not show waveforms in the automation tracks.

Automation may be graphically edited using either the Draw, Grabber or the Edit (Contents) tool. The rules
for each are slightly different (and may change in the future)

Grabber tool

• Click a control point to grab it and move it
• Click a line to move the gain points on either side of the line.
• Right-click on a control point to Edit or Delete it.

Range Tool

• Drag a Range, then you can:
◦ Click Delete (or Backspace) to delete the automation in that range ( with guard points that

prevent you from adjusting data outside your range selection )
◦ Switch to the Draw tool, and drag up/down to move all the points in that range ( with guard

points )

Draw tool

• Click anywhere in the track to create a new control point, and connect it to the points on either side.
• Click a control point to grab it and move it. ( now it is selected so you can delete it )
• Click a line to move the gain points on either side of the line.
• Right-click on a control point to Edit or Delete it.

Edit Tool

• Click a control point to grab it and move it.
• Shift+right-click a control point to delete it.
• Click anywhere in the track to start a “box select”, then:

◦ Click Delete ( or Backspace ) to delete the selected points
◦ Grab one control point, and move them all together

• Right-click on a control point to Edit or Delete it.
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Clicking with the Draw tool will create the first control point, and also draw a line to the very beginning of the
track.

• Click anywhere in the track to create a new control point, and connect it to the points on either side.
• Click a control point to grab it and move it.
• Click a line to move the gain points on either side of the line.
• Use the Range tool (or Object+Smart mode) to create a “range”. Now switch to the Draw tool, click

inside the range, and you can drag the entire range up/down.

Note: The Grabber tool can grab an automation point, and move them up or down, but it
can’t move their location in time.*

Note: Using the Edit tool, you can click in empty space, and begin a “box selection” to select
multiple points at once. You can then click on a point to move them all, or you can press
Delete(or Backspace) to delete them together.
*

Note: Remember that in order for the automation to be auditioned, the parameter must be in
“Play” mode. You do NOT have to be in write or Touch mode to graphically edit the
automation though.
*

Note: Past the extents of the automation line, the “Play” value is the value of the last control
point.*
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Region Gain Automation
Region Gain

Click above for video instructions.

Region Gain is a volume envelope that extends for the length of the region. By default, the region envelope
is “unity” (i.e. no change) across the entire region and it is hidden. To adjust region gain with the mouse,
you must use the Draw tool.

In many situations you may find it useful to turn grid mode off. Clicking on a region with the Draw tool will
cause a control point to be placed. By default, a region has 2 control points, one each at the start and end of
the region.

Tip: If you want to quickly change the gain over the entire region, then click on the region to
show the line, and then grab the line and move it up/down. This is an alternative to Region
Level.
*

Tip: This is an excellent way to tweak a syllable or reduce a section of noise, and it is often
more transparent than deleting it entirely. Also, looking through a waveshape and finding a
few of hot the spots and reducing the gain will allow the compressor to be set more
conservatively, providing a more transparent sound.

*
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Mouse operations using the Range, Draw, and Edit tools inside a Region:

Range Tool

• Drag a Range, then you can switch to the Draw tool, and drag up/down to move all the points in that
range ( with guard points )

Draw tool

• Click anywhere in the region to create a new control point, and connect it to the points on either side.
• Click a control point to grab it and move it.
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• Shift+right-click on a control point to delete it.
• Click a line to move the gain points on either side of the line.
• Right-click on a control point to Edit or Delete it.

Edit Tool

• Click a control point to grab it and move it.
• Shift+right-click a control point to delete it.
• Right-click on a control point to Edit or Delete it.

Temporarily bypassing region gain

Menu>Region>Gain>Envelope Active
or
Right click on the region and click on the track name>Gain>Envelope Active
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Groups

Click above for video instructions.

Tracks (and busses) may be assigned to a “group” which imparts some special behaviors. For example, you
might want to put the drums in a “group”; in this case, adjusting the fader on one track will apply to the
others.

Options within a Group
Grouping tracks allows the sharing of certain functionality and the functions available within a group are
customizable. Right-clicking on a group tab calls up these options:
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• Active: makes the group active/inactive
• Gain: syncs all faders to the same level

◦ Relative: preserves fader differential between tracks
• Muting
• Soloing
• Record Enable
• Selection: links selections made in the editor canvas
• Active state
• Color
• Monitoring

Left-clicking on a group will enable or disable the group.

YOUTUBE short-video: dragging to create a new group

New in Mixbus v3 is the ability to assign and control groups via the “group bar” at the top of
the mixer strip, and the side of the edit window.*
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The Group section of the mixer window, showing the +/- and Enable/Disable for each group

What is a Group?
A group of tracks should not be confused with a mix bus. Confusion sometimes comes from the fact that
much of the time a mix bus has more than 1 track bussed to it. Likewise, a group has more than 1 track
associated with it. However, a group of tracks will not sum their audio, but will group certain software
functionality which allows for better session organization and more efficient mixing and editing. That’s
not to say you can’t have all tracks in a group bussed to its own mix bus. It’s quite common in fact.
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For instance, a session may have 6 drums tracks and after finding the right balance between those tracks
you might group them so that moving one fader moves all in that group, causing all the drum tracks to
change level. Or soloing one track in the group solos all in that group. Clicking on the group header will
disable the group allowing individual changes to the tracks, after which the group can be re-enabled.

Creating a group can be done several ways

Creating a Mix Group with the new Group Bar:

In the mix window, a group can be be created by dragging in the black bar above the channel strips. While
holding the left click, slide the mouse horizontally over the channel strips you wish to group. This will create
a group tab that extends the length of the tracks being assigned to that group. Many times it is convenient
for a group to contain tracks adjacent to one another but it is not absolutely necessary. You may have any
tracks in a group.

Right clicking on the tab calls up this dialog:

Click here to view a video on groups and bussing, and here for a video on subgroups.*

Groups created from the mixer window will have the Gain, Mute, Solo, and Rec-Enable
options enabled by default. Selection, Active, Color, and Monitoring will not be selected.
You can change these settings in the dialog when the group is first created, or by right-
clicking on the group bar and choosing “Edit”

*
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Alternatively, a group may be created or altered by clicking on the “Grp” button below the track fader. Once
the group is named the “Grp” will be replace with the groups new name or a shortened version of it.

Creating an Edit Group with the new Group Bar:

In the edit window, a group selection can be be made by clicking in the black bar to the left of the track
header. While holding the left click, slide the mouse vertically along-side the tracks you wish to group. Right
click on the name of the group to rename it. To add tracks to that group just left click and slide the mouse
alone-side the track you would like to add. This will create a group tab that extends the width of the tracks
assigned to that group. Many times it is convenient for a group to contain tracks adjacent to one another but
it is not absolutely necessary, a group of tracks does not have to be contiguous.

Groups created from the Edit window will have the Mute, Solo, Rec-Enable and Selection
options enabled by default. Gain, Active, Color, and Monitoring will not be selected. You can
change these settings in the dialog when the group is first created, or by right-clicking on
the group bar and choosing “Edit”

*
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Right-clicking on a group tabs calls up a context menu for groups:

• Create New Group : creates a new group, but doesn’t assign any channels to it
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• Create New Group From->Selection : creates a group and assigns it to the selected tracks
• Create New Group From->Solo : creates a new group and assigns it to any soloe’d tracks
• Create New Group From->Record Enabled : creates a new group and assigns it to any rec-enabled

tracks
• Edit Group : launches the group editor, (see below)
• Collect Group : Moves the grouped tracks together into a contiguous series
• Remove Group : Deletes the Group (but not the tracks in it)
• Add new Subgroup Bus : Creates a New Bus, and assigns the output(s) of the grouped tracks to it
• Add New Aux Bus (pre-fader) : Creates a New Bus, and creates a pre-fader Send to it, from each of

the grouped tracks
• Add New Aux Bus (post-fader) : Creates a New Bus, and creates a post-fader Send to it, from each of

the grouped tracks
• Fit to Window : Sizes the grouped tracks to completely fill the edit window
• Enable all groups
• Disable all groups

Alternatively, a group may be created or altered by clicking on the “G” button located in the track header.

Grouping behaviors when the “Gain” is enabled
• Dragging a fader will affect all the others in the group

◦ By default, this a “relative” move. ( the faders will retain whatever dB offset they have prior to
the move )

◦ You can disable the “relative” checkbox, and all the faders will be forced to the exact same
value, whenever you move one fader in the group

• Muting or soloing will affect all the others in the group
• Assigning or de-assigning a mixbus will affect the others in the group

Group Override
Holding “Shift” will override the group, resulting in these behaviors:

• Dragging a fade will affect only the current channel, not the others in the group
• Muting or soloing will affect only the current channel, not the others in the group
• Assigning or de-assigning a mixbus will affect only the current channel, not the others in the group
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Group Window
With in the Mix window, at the lower left corner, is the Group Window. Here all groups that have been
created for the session are listed. A check box labeled “Show” is provided. Un-checking this box will hide a
group from the edit and mix window. Hiding a group is a convenient way of un-cluttering your sessions.
Groups can also be added or deleted clicking the + or – buttons at the bottom of the window. Clicking on the
name of the group allows you to rename it.
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Importing Files

Click above for video instructions.

Files may be imported to Mixbus by dragging and dropping them from a file browser into the editor window.
Although using the import window (Session->Import) is a much more flexible and powerful way to import
files to Mixbus.

The Import dialog allows you to add existing media and has 3 tabs at the top: “Browse Files”, “Search Tags”,
and “Search Freesound”.

• The Path Bar: Shows your current path and allows you to navigate back “up” the directory tree.
• The Location Bar: Allows you to directly type in the name of a file in this directory or enter the entire

path via text (the “notebook” button shows or hides the Location bar).
• Places: A list of common locations on your computer. The top two items, “Search” and “Recently

Used”, are always there. Clicking “Search” allows a text entry to search your system. Warning: This
can take a LONG time. The lower section provides shortcuts to commonly-used locations. You can
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Add and Remove these locations using the buttons underneath. You can also remove or rename
locations by right-clicking on them.

The main area shows a list of files in the current directory. They can be sorted by Name, Size, or Modified
Date by clicking on the headers at the top of the columns. Underneath is a selector to show “Audio Files,
MIDI Files, Audio and MIDI Files” (files with recognized audio file extensions such as .wav), or it can show
“All Files”.

To the right of the file selector is the Sound File Information area. When a file is selected in the browser, you
get a report of the number of channels, sample rate, and in the case of broadcast wave files, the timestamp
when it was recorded. There is also an area to enter metadata “tags” for the audio files. Tagging files this
way makes it very easy to find them in the future. If a MIDI file is selected you get a report of number of
channels, Format, Length, and Timestamp.

Finally, there are options to Audition the files. You can click “Play” to play the file, Stop to stop playing, or
choose auto-play so that files automatically start playing when you click on them. By default files will play
when you double-click on them. There is also a level-fader on the right side that allows you to trim the
audition level.

Add Files as:

• As New Tracks: Each file will be imported to a new track.
• To Region List: The imported files will be imported to the region list but no tracks will be created. This

is useful if you are importing individual hits or effects into the region list, where you will use them to
replace existing sounds.

• As New Tape Tracks: Creates destructive “tape” tracks which can be recorded into. When you record
into a Destructive track, you actually overwrite the data in the audio file. This is not recommended
for most users !!

Insert at:

• Use File Timestamp: After importing the file will be located at the file’s time stamp (if it is a bwav file).
• At Edit Point: After importing the file will be located at the edit point.
• At Playhead: After importing the file will be located at the playhead location.
• At Session Start: After importing the file will be located at the session’s start marker.

The most important buttons are underneath. These buttons control the modes that will
dictate how files are imported.

!
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Mapping:

• One Track Per File: Each file will be appear on one track. If the file is stereo, it will be a stereo track.
If there are more than 2 channels then they will be ignored.

• One Track Per Channel: Each channel of each file will appear as a track. If a file is stereo, it will be
converted to 2 mono tracks. An 8-channel wav file will be converted to 8 mono tracks.

Conversion quality:

If the file has a different sample rate than the current session, it is necessary to do sample rate conversion.
This determines the quality and it is always recommended that “Best” is used.

Instrument:

If MIDI data files are imported this option will install a basic synth plugin on those tracks called
“ReasonableSynth”. This built-in utility allows you to audition your MIDI performances without any plug-in
parameters to set incorrectly. It may be deselected and substituted with another plugin via the drop down list
or after the track has been added to the session.

Audio and MIDI files:

This drop down menu selects either audio, MIDI, or both for importing.

Copy Files to session:

IMPORTANT!! If you want to use a file as-is, you can uncheck “Copy Files to session” box.
This saves disk space by not duplicating the file into the session. No sample-rate
conversion is performed. Your files can sound sped-up or slowed-down if their sample rate
does not match the sample rate of the session. By default, files are always copied to the
session with appropriate sample rate conversion. If “Edit> Preferences>Misc->Always Copy
Imported Files” is enabled, then this option will be grayed-out.

!

Note: If a file is “linked” into the session without being copied into the session, then the
sound won’t be available if the file is moved or deleted. For example, if the file is on a
removable hard drive then it might not be available next time the session is used. Use this
at your own risk.

*
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Tags:

If you have used the Tag feature to “tag” files that are used in the past, then you can use the Search Tags
tab to find those files quickly. In this case, we searched for the term “shout” which was added to the files on
the previous page. They instantly appear in the file area to be auditioned and imported.

Search Freesound:
http://www.freesound.org is an online repository of searchable sound files. The “Search Freesound” tab
allows you to search the Freesound database, download & audition files from within the Import dialog.

Tags: Enter the “tags” that you would like to search. You may enter multiple search terms separated by
spaces. For example “drums 120bpm” will search for files that are tagged “drums” OR “120 bpm”.

Sort: Choosing one of the sort options will cause Freesound to order the files before returning
the list of available files. This can save time if you know (for example) the sound you need is
very short.

Search: Click this button to initiate the search. Freesound will begin returning pages of information,
with 20 items per page. You may click “Stop” to stop downloading.

The file list: Click on a file to download it from Freesound. Double-click the file to auto-play it in the
auditioner.

Files imported with Freesound will automatically include any Tags that are associated with the file, and
these tags will be included in a search when you use the “Search Tags” tab.

Note: Files at Freesound are licensed with one of several Creative Commons licenses. All
Creative Commons licenses allow you to include the sounds in a non-commercial work. If
you wish to use a Freesound sound in a commercial work, you must abide by the license for
the specific file. Many files only require attribution to be used in a commercial work, but
others have a more restrictive license. Please visit http://www.freesound.org to investigate
the license requirements of the file.

*
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Exporting Files
Please watch the following video for an overview of exporting features in Mixbus:

Differences between Bounce, Consolidate, and Export

Mixbus has multiple ways of “rendering” audio into contiguous audio files.

Bounce

The least-used method, “Bouncing” is a way to store a drum hit or sound effect that will be reused later in
the project. A new region will be created in the region window. The bounced region will have the region’s
gain, gain curve, and fades applied to the audio. You can later drag this region back into the project
wherever you need it.

To initiate a Bounce action, right-click on a region and choose “Bounce”. A new region will appear in the
Editor List, inside the “Region” tab.

Consolidate

“Consolidate” allows you to select a time-range consisting of many regions, and create a single region on
the timeline. This can simplify future edits or exporting operations, because the various layers, gain curves,
fades, and other region properties are made into a single contiguous audio region which can be manipulated
more easily.

To initiate a Consolidate action, you will select a time-range with the Range tool (this can consist of multiple
tracks), right-click on the Range, and choose Consolidate. The regions under the selection will be
consolidated into contiguous audio regions.

Exporting

“Exporting” is used to generate one or more files, outside of the Mixbus session, in the file-location and
format that the user defines. “Exporting” is how you create the final stereo output file of a song, or a series
of songs and markers for a CD, or a video for posting on YouTube.
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There are many ways to initiate an “Export”, and Mixbus supports many, many options. A single Export
event might generate multiple files, in multiple formats, with multiple different , and with or without metadata
such as CD markers, song names, etc. Exporting is probably one of the most complicated (but powerful)
features of Mixbus.

Exporting to an Audio File
Once a mix is ready for delivery, you will need to generate a final output from Mixbus. There are several
ways to initiate an Export from Mixbus; each method helps to define the tracks that will be exported, the
start/end times of the exported file, and the format of the files to be created.

Initiating an Export

There are 5 common ways to initiate an export:

• Session>Export>Export to Audio File(s)
• Session>Export>Stem Export
• Session>Export>Export to Video File
• (Selected Region)->Right Click->Export
• (Range Selection)->Right Click Menu->Export

Export to Audio File(s)

This method initiates the most common export. The Export dialog will appear, prompting you for details such
as the exported filename and location, the file format, and the time-ranges that you would like to export.

Stem Export

This initiates an export of individual tracks. In the “Channels” tab, you may select whether to apply the
channel processing, or to leave the track contents unaffected. Each track or bus will generate a separate
audio file. If you choose multiple timespans, then you will receive a separate audio file per time span.

When choosing “Export to Audio File(s)”, Mixbus will automatically choose the master bus
output, and the session start/end markers for an export. But you can override the settings to
choose a different track output, and/or a different time span, in the Export dialog window. If
you choose multiple track outputs, then the export track will be the “sum” of the track
outputs, into a single stereo file. If you choose multiple timespans, then you will receive one
audio file per time span. This allows you to export ranges that are non-contiguous,
overlapping, or even nested.

*
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Export to Video File

This initiates an export similar to the main session export, but it generates a video file by combining the
video track with the master-bus outputs.

Region export

This simply exports the selected audio region into any format that the user chooses. This does not include
any mixer-strip or plugin effects.

Range export

This initiates an export, just like the session export, but it automatically selects the selected time-range as
the start/end times for the exported file.

Setting the format for the export:
In the Export window are 3 tabs across the top:

• File format
• Time Span
• Channels

File Format tab

The File format tab allows control of settings such as bit depth, sample rate, compression type, location to
be saved, and file name structure.

Additionally,options for generating a “Loudness Report”, as well as automated uploading to SoundCloud is
available (must first have a SoundCloud account via www.soundcloud.com).

Multiple format exporting:

Many files formats may be generated and exported at one time by clicking “+ Add another format”.

• Export Session to Audio File (the most common option): This exports the entire range from the Start
marker to the End marker.

• Export Selected Range to Audio File: This exports the current Range selection to an audio file (Note:
this can also be triggered by right-clicking on the selected range and choosing “export range”).

• Export Selected Regions to Audio File: This exports a length of time starting at the first selected
region, and continuing to the end of the last selected region.
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• Export Range Markers to Multiple Audio Files: This very powerful feature allows you to export several
ranges (songs) at one time. The resulting files will use the region names as the file names.

Before the export is initiated, you must choose the location and format of the exported file.

Export to File: Enter the path and file name that you wish to create. This defaults to the sessions “export”
folder. Click “Browse” to see a file browser and navigate to a different folder.

• Export Source: Under the “Channels” tab choose “Master Output” to export the master bus output of
Mixbus. additionally you can export individual tracks separately, or control the Left/Right assignment
of tracks to the file.

• Channels: Chooses whether the resulting file will be Stereo or Mono.

Once a format(s) is chosen it may be edited.
The formats are editable using this dialog box:
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Edit Export Format Profile:

• File Format: (the list depends on the system’s available options). For CD quality,
choose WAV.
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• Sample Format: The “32-bit” setting means 32-bit integer format. This is ultra-high resolution but does
not accommodate signals over 0dBFS. The “float” setting is 32-bit floating point which accommodates
signals over 0 dBFS which is preferred in most cases. For CD quality audio choose 16-bit.

• Sample Rate: For CD-quality audio choose 44.1 kHz.
• Conversion Quality: This is only enabled if the export sample rate is not the same as the session. The

setting “best” is recommended.
• Dither Type: None, Rectangular, Shaped Noise, or Triangular. The “None” or “Shaped” settings are

recommended.
• CD Marker File Type: CUE & TOC. These file types may be utilized by CD-burning software to define

track indexes, track names, and other metadata.

If a project is intended to be published as a CD, you will want to create CD markers so Mixbus will generate
a TOC (table of contents) text file for the CD.

You can cancel an Export operation at any time by closing the dialog and/or clicking Cancel.

Time Spans tab

This tab allows you to choose one or more time-spans. Each selected time-span will be exported, using the
settings in the “Format” and “Channels” tabs. For example if you have 2 different formats chosen, and 2
different time spans, then 4 files will be created during the export.

Time-spans include:

• Session Start/End ( this is selected by default if you trigger a Session->Export to Audio File )
• Range Selection ( this is selected by default if you trigger the export by right-clicking on a Range ). If

no range is selected, then this does not appear
• Named ranges: If you have created named ranges ( for example, your session has multiple songs on

the timeline, and each is assigned a named range) then they will appear here.

Realtime Export

Use this option if your session makes use of external hardware audio processing.

Normally, Mixbus maximizes your CPU to perform the fastest-possible export. However,
some users have external devices, such as rackmount analog gear or external MIDI
synthesizers, which cannot be used at faster-than-realtime speed. In the past, we required
these users to manually create a bounce track and mixdown to it, rather than using the

*
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Channels Tab

The Channels tab allows the user to choose which tracks or buses will be exported. The operation is slightly
different, depending on the way the export was initiated.

When “Session->Export to Audio Files” is selected, Mixbus will select the Master bus for export. But the
user may change this selection to choose any tracks and/or buses. Mixbus will “sum” the track outputs into a
single file.

When “Session->Stem Export” is selected, Mixbus will not select any tracks or buses by default. The user
must select which tracks or buses to export. Each selected track will result in one exported file. The track’s

normal Export features. Realtime Export provides all the same features as a regular export,
but it limits the engine to run in “real time” so external gear can be utilized during the export.

When exporting the session, the user may choose multiple independent tracks instead of
the master bus, but the user must choose how to combine the tracks into the stereo output,
since some tracks may be mono.
*
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output is used to define the number of channels in the exported file. If a track is mono throughout, then it will
result in a mono audio file. If the track has 2 outputs (stereo) then the resulting file will be stereo.

The selection of the “Channels” tab is combined with the “Format” and “Time Range” tabs. If you are doing a
“stem export”, with 8 tracks selected, and 2 formats, in 2 different time spans, then this will result in 8×2×2 =
32 different files on export!

SoundCloud Export:

SoundCloud is an online service that hosts your audio files for others to browse, search, and annotate.
Uploading files to SoundCloud is an easy way to get your music posted to the Internet without having to
encode the file and transfer it to a server. For faster uploads and best quality, it is suggested that you export
files in the FLAC format before uploading to SoundCloud.

• Also Upload to SoundCloud: Enable this option to automatically upload the file to SoundCloud.com
• Make file public: The resulting SoundCloud object will be available for the public to view if this is

turned on. If not, the file will only be visible to you.
• Track Title: The name that this item will have on SoundCloud. This defaults to the session name.
• User Email: This is your user name for SoundCloud. This defaults to the User Email stored your

Metadata settings (see section 19, Metadata).
• Password: SoundCloud user password is required to upload files to SoundCloud.

The black bar at the bottom of the window is the progress indicator. The progress indicator displays the
progress of the file export as well as SoundCloud upload, if engaged. If “Also Upload to SoundCloud” is
engaged, then a browser window will open to display the file at SoundCloud.com when the upload is
completed.

When stem exporting, the user may choose whether to apply the track’s processing ( fader,
mute, eq, compressor, and plugins ) or to export the raw audio without processing.*
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Export Analysis:

If you enable the “Export Analysis” checkbox, then Mixbus will display a summary of the exported file:
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Export Report and Analysis

The Export Analysis dialog may be displayed after an export The export analysis window provides these
features:

• LUFS loudness measurement
• LU (Loudness Unit) histogram
• LU Range
• Waveform display, with peak indicators
• Peak Sample value + True Peak value
• Spectrogram view
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These tools provide you an extra level of confidence that your track sounds great and meets common
deliverable requirements for distribution and broadcast.

The following video describes the export report and analysis tool in more detail.

The following video describes how to “bounce” the master bus down to a new stereo track:

The following video describes how to export multiple ranges into separate audio files:

The following video shows the “Export” features of Mixbus v2; this additional information is still sometimes
useful for v3 users:
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Clocks & Synchronization

Clocks
Mixbus provides two clocks which display the current position of the playhead. Having 2 clocks is a
convenience: for example you can leave one clock showing “musical” time (such as bars/beats) while the
other clock shows time in hours:minutes: seconds.

Right-click on a clock to change the mode of the clock. A menu appears with the available options.

Some clock modes have smaller sub-displays which show the current meter/tempo, SMPTE format, or
sample rate (in applicable modes).

It is possible to click on a clock and directly enter a time code location directly. Pressing “Enter” will locate
the playhead to the new time.

Synchronization
Mixbus allows selection of several synchronization sources: Internal, LTC, MTC, and JACK

• Internal: The playhead position is defined by Mixbus; all transport commands come from Mixbus.
• LTC: The playhead position and transport state will be determined from incoming LTC (SMPTE)

timecode.
• MTC: The playhead position and transport state will be determined from incoming MIDI Time Code.
• JACK: The playhead position and transport state will be determined from JACK. Transport commands

initiated from Mixbus will be applied to all JACK-synchronized programs. (JACK is a third party

Note: There are several other clocks in Mixbus, such as the Nudge clock and the SMPTE
offset clock. These clocks can also be set to any mode, so you can (for example) set the
nudge clock to advance in bars:beats instead of minutes:seconds.
*

Tip: you can point at a clock element (minutes, seconds, beats, or whatever) and use the
mouse-wheel (or 2-finger scroll on a touchpad) to quickly tweak the value without entering it
manually.
*
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program, and is not included with Mixbus 3, however, MB3 can utilize JACK if it is installed in your
system.)

• Time Master (JACK only): Only one JACK-synchronized program can be the “Time master”. When
JACK sync is used the timelines of the synchronized programs are located using the sample-clock
offset. Since different programs may have different tempo maps, or methods of handling musical time,
the “time master” identifies the machine that will define the musical time (bars/beats) position of the
song. This is for advanced users only.

Note: A list of JACK-aware programs is listed at: http://jackaudio.org/applications*
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External Synchronization

Synchronization
Mixbus can synchronize to external hardware or software in three ways:

• LTC (Linear Time Code, sometimes called SMPTE)
• MTC (Midi Time Code)
• JACK

In all 3 cases, Mixbus can be the Master ( it sends the timecode to the other devices or software) or a Slave
(in which case Mixbus will “chase” the other source). In most cases, the digital workstation should be the
Master device, so Mixbus will normally be the Master. But there are cases when you need to do it the other
way, too.

Each method has different requirements and capabilities.

• LTC (sometimes called SMPTE) uses a channel of audio to encode a continuously-running timecode
position. The master device generates this signal, and the slave devices use this stream to determine
the master’s position and speed. LTC has the benefit of using everyday audio signals for sync, but the
underlying software has to be pretty smart to decode the position. Implementations vary from very
good to very bad.

• MTC is similar to LTC, but uses a MIDI channel to encode the position. It is much easier for
developers to interpret, and it uses widely available MIDI cables and connections. However it slightly
less robust because of the decoupling between the MIDI and the audio clocks in most computers.

• JACK allows 2 or more software applications on your computer to share their timecode position and
speed, without any audio or MID connections required by the user. JACK synchronization has several
benefits over MTC & LTC, but it is not likely to be available on most commercial software, or external
gear like a drum machine.

The “Internal/External Sync” button enables or disables external chase. If external sync is disabled, the
button shows “Internal”, and Mixbus will use its own internal clock and transport controls.

Regardless of the “Internal/External Sync” button, Mixbus always sends sync, so other
machines can follow it.*
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You select the synchronization source from the Preferences. Sync source is globally selected, it doesn’t
change with the session you have open. This matches most people’s needs, since most people have a
studio setup that doesn’t change depending on the session they are using.

Mixbus’s timecode sync functions are largely developed by the Ardour open-source community. For more
details, see the applicable chapters in the Ardour manual: http://manual.ardour.org/synchronization/
timecode-generators-and-slaves/
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External Transport Control

Transport Control
Mixbus transport (Play, Stop, Locate, etc.) can be controlled by an external input in 3 ways:

• MMC ( Midi Machine Control )
• OSC ( an Ethernet network protocol) ( NOTE: this feature was disabled for the initial launch of Mixbus

3.0, but will be re-enabled in a future release )
• JACK ( using the JACK server, if it is installed on your computer )

Mixbus’s external transport functions are largely developed by the Ardour open-source community. For more
details, see the applicable chapters in the Ardour manual: http://manual.ardour.org/synchronization/
overview-of-timecode-related-settings/
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Tempo, Click, & Grid

Defining a Song’s Tempo and Meter
Mixbus allows simple creation and editing of a musical time/tempo map for each session. The meter and
tempo map is controlled with the Meter and Tempo rulers. To show these rulers, right-click in the ruler area
underneath the transport buttons and check the boxes for the Meter and Tempo rulers. Alternatively, you
can use the View menu to hide/show the rulers.

There are 2 reasons that you might want to set the Meter/Tempo for your song:

1. To record with a “click” or metronome to help maintain consistent time among different performers and
parts.

2. To use the Grid to facilitate editing (if the audio follows the tempo map of the song).

By default, Mixbus starts with the tempo set to 120 bpm and 4/4 time signature. In many cases, you will use
a single tempo for the entire song. In this case, you can click on the “tempo” text inside the main clock, and
this will launch the Tempo dialog.

In other cases, you may want the tempo to change at different times during the session. In this case you will
right-click on the existing markers and set the tempo to the desired tempo and time signature. Right-clicking
in the Meter/Tempo rulers allow you to create new Meter or Tempo markers.

Using the Click
To play the click sound (metronome) during playback and recording, enable the “Click” button near the top-
right of the edit window. The rate of the click is defined by the session’s Tempo and Meter rulers. The sound

Note: Currently, Meter and Tempo changes can only occur at the beginning of a new
measure, so that the beats stay lined up.*
Tip: Here’s an easy way to set the tempo for a song: record a portion of the song, and then
select one bar with the Range tool. Now click “Edit->Tempo->Set Tempo from Edit Range”
to set the tempo.
*
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of the click can be modified from the Preferences Window (see the section on Preferences).
The audio output of the metronome can be modified via “Window>Audio Connections”. Mixbus Misc tab

Tempo from Clock Window

When the primary or secondary clock is set to display “Bars:Beats”, clicking the word “Tempo” in either
clock window will open the edit tempo dialog box. Here you can assign a new tempo for the tempo marker
just behind the current playhead location. If the marker exist anywhere other than 001|01|000 then the ability
to choose a bar and beat is given. A tap tempo function is also provided.

Using the Grid
Editing with the “Grid” allows you to make edits perfectly aligned with other events. If the grid is set to
musical time (and the audio was recorded to a click) then editing can be done very quickly without zooming
in, because you know all edits will happen on a musically-sensible time. Setting the Grid to SMPTE frames
will guarantee that all edits happen in sync with the video frames, etc.

Tip: It is common practice to leave some time at the beginning of a song, rather than
starting from the zero indication. Some common choices are 8 measures, 1 minute, 10
minutes, or 1 hour. This allows space at the beginning of the song to add an intro, place a
sync click or test tones, or just make editing
easier by allowing some unallocated space at the beginning of the track.

*
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The settings for the Grid menu are:

• No Grid: No grid is applied.
• Grid: the grid is applied; any mouse move in the editing canvas will “jump” between grid locations.

Operations at the Edit Point will be snapped to the nearest grid point.
• Magnetic: When the Edit point is very near a grid location, it will snap to the location. But in-between

the locations it will remain manual (no grid).

Grid Modes

The edit point may snap to:

• Clock time (CD frames, SMPTE, Seconds, Minutes)
• Musical Time (Bars, Beats)
• Markers
• Region events (start, stop, etc.)

Note: Some DAWs use the term “Snap” instead of “Grid”. We use the term “Grid” to refer to
the settings, and “snap” to refer to the operation of the Grid on the edit point.*

Note: To use Region starts/ends/syncs/bounds as snap choices, you must have either (a)
NO tracks selected, which means that Mixbus will snap to regions on any track, or (b)
several tracks selected, and Mixbus will only snap to regions on those selected tracks. If
you are moving items on a track, and only the current track is selected, then you will only be
able to snap to other regions on the same track. This means that the Option “Sync Track
Selection to Region Selection” will make the “Region” grid units unusable. Avoid the use of
this option if you are going to use any of the Region grid units.

*
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Menu Reference
This menu reference documents selections available to the user. In many cases menu selections are self
explanatory and require no elaboration. Other items may require explanation, in which case a brief passage
will be provided. In other cases links to specific pages of this manual will be provided.
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Session Menu
When a new project is started Mixbus will create a session file where it stores all information regarding that
particular project. When a project is saved and later opened up Mixbus will reload the appropriate session
file so that all work previously done can be recalled. You might create a Session for your band’s live
recording, a song, or a compilation of songs for a CD.

The Session menu provides the main functions of session management:

• New: More here
• Open: More here
• Recent: More here
• Close: More here

• Save: More here
• Save As: More here
• Rename: More here
• Snapshot (& keep working on current session): More here
• Snapshot (& switch to new version): More here
• Save Template: More here
• Metadata: More here

• Add Track or Bus:More here

• Import: More here
• Open Video: Will import video with audio (the audio embedded within a video can also be extracted).
• Remove Video: Removes video from the timeline but not from the session folder.
• Export: More here
• Clean-up: More here

• Properties: More here

• Quit: Saves the currently opened session and closes Mixbus.

A session file itself will contain no audio although the session folder, by default, will contain
audio.*
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Metadata

Session files include “metadata” which can include information about the project including the composer(s),
engineers, etc. Metadata is stored inside the session file in a simple XML format.

The Metadata dialog is launched from the Session menu:

The User tab includes information about the primary user of Mixbus. This includes the Name, Email, Web,
Organization and Country information. This is a global setting and will be applied to future sessions. This
information is purely for convenience and for documentation purposes.

There are 3 specific ways that this information is used within Mixbus:

Email: automatically entered into the Freesound entry box in the Export dialog.
Organization: This text is stored in broadcast wave file metadata.
Country: This text is stored in broadcast wave file metadata.
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The User information is stored outside the session file and is persistent across sessions.

The remaining tabs (Track, Album, People, and School) record data that is stored in the session file. The
data is stored in an industry-standard XML format, and can be easily read and manipulated by 3rd party
applications or scripts. Contact Harrison if you are interested in further development of Mixbus metadata.
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Session Properties
Session properties are settings for the currently loaded session. These are session-specific controls such as
the timecode format, audio file format, and monitoring setup for this session.

Menu Options

Timecode Tab
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Sync Tab

Fades Tab
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Media Tab

The audio data format that Mixbus uses internally. New audio recordings will be stored in this format, and
files will be converted to this format when imported.

• Float (floating point 32 bit) (default value) Allows extra headroom above 0 dBFS for JACK-enabled
connections and/or bounces within Mixbus.

• 24 bit: If you plan to record live sources from a A/D converter and do not use internal bouncing-to-
disk, then 24 bit will save some disk space.

• 16 bit: If working with audio sourced from a CD, this uses half the storage space of “float” option.

Audio File Format: File Type

The file type that Mixbus uses internally. New audio recordings will be stored in this format, and files will be
converted to this format when imported.

• Broadcast Wave: Industry standard .wav files with an additional time-stamp that may be used in some
software. File size is limited to 4GB.

• Wave: Industry standard PCM file. File size is limited to 4GB.
• Wav64: Industry standard PCM file. Uses 64 bit length value in the header allowing nearly limitless

recording length at any sample rate.
• CAF: Same as Wav64, but this format is only common on OS X.
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Locations Tab

Filenames Tab
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Monitoring Tab

Meterbridge Tab
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Misc Tab
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Clean-up
Bring all media into session folder:

This function will locate all audio and MIDI data that may be scattered across multiple folders, or even
multiple hard drives, and copies or moves all audio and/or MIDI associated with that session into the
session folder. Once this is done the user can be assured that the session folder will contain all the
necessary audio/MIDI in one convenient location.

A real world example:

While working with a session you may pull new material from many different locations on your hard drive,
CD drive, or network. After saving the session, Mixbus will know where to find all of these bits of audio the
next time the session is opened on that particular computer. But if your session file is on a portable hard
drive and most (but not all) of your audio files are also on that portable hard drive and you take that hard
drive to a different computer, or studio, expecting to open the session, you may be confronted with a
dialogue box indicating the session was unable to located certain audio files. Running the “Bring all media
into session folder” alleviates this problem.

The same is true for archiving of a session. If the user does not invoke the “Bring all media into session
folder” function before archiving then the archive may be incomplete.

Clean-up unused sources:

Clean-up will move all unused files to a folder labeled “dead” within the session folder. Clean-up is a
destructive operation and all undo/redo history will be lost.

Located under Session>Bring all media into session folder. This important function serves
2 purposes:
• Allows portability of sessions
• Allows for the archiving of sessions

!

It maybe useful to run the clean up function located under Session>Clean up in conjunction
with “Bring all media into session folder”. There maybe no need to transport or archive
unused material.
*
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Flush Waste Basket:

Deletes audio files located in the “dead” folder.

A note about Session Cleanup.

There are a few reasons why cleanup might not save much space:

1. Because all of the session snapshots are inside the session folder, Mixbus knows when a region is
used by a different snapshot. So it may not “clean up” as much as you expect.

2. If you recorded a very long file, but only use a very small snippet, this reference to the file will keep
the file from being cleaned up. If you “bounce” the regions (making a new, short file of exactly the
length of the region) then you might see a bigger space savings. But note that this means you can no
longer extend the fade handles for that region; there’s no longer any information left outside the
region.
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Transport Menu
• Start/Stop
• Play >

◦ Play Selected Regions
◦ Play Edit Range
◦ Play Selected Range
◦ Play Selection with Pre roll
◦ Play from Edit Point and Return
◦ Play Loop Range

• Stop and Forget Capture
• Enable Record

• Set Loop from Selection
• Set Loop from Selection
• Set Session Start/End from Selection

• Forward
• Rewind
• Transitions To Roll
• Transition To Reverse
• Playhead >

◦ Playhead to Mouse
◦ Playhead to Active Mark
◦ Center Playhead
◦ Nudge Playhead Forward
◦ Nudge Playhead Backward
◦ Move to Next Transient
◦ Move to Previous Transient
◦ Playhead to Next Grid
◦ Playhead to Previous Grid
◦ Playhead to Next Region Boundary
◦ Playhead to Previous Region Boundary
◦ Playhead to Next Region Boundary (No Track Selection)
◦ Playhead to Previous Region Boundary (No Track Selection)
◦ Playhead to Next Region Sync
◦ Playhead to Previous Region Sync
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◦ Jump to Next Mark
◦ Jump to Previous Mark
◦ Goto Zero
◦ Goto Start
◦ Goto End
◦ Goto Wall Clock

• Active Mark >
◦ To Next Region Boundary
◦ To Previous Boundary
◦ To Next Region Sync
◦ To Previous Region Sync

• Markers >
◦ Add Mark from Playhead>Tab
◦ Remove Mark at Playhead> Shift>Tab
◦ Locate to Mark 1
◦ Locate to Mark 2
◦ Locate to Mark 3
◦ Locate to Mark 4
◦ Locate to Mark 5
◦ Locate to Mark 6
◦ Locate to Mark 7
◦ Locate to Mark 8
◦ Locate to Mark 9
◦ Set Session Start from Playhead
◦ Set Session End from Playhead

• Time Master
• Punch In/Out
• Punch In
• Punch Out
• Auto Input: When a input strip is record armed it will automatically switch to the input.
• Follow Edits: Playhead follows range selections and edits
• Auto Play : The transport will automatically play whenever you locate the playhead to a new position.
• Auto Return: Returns playhead to last position when stopped
• Click: Metronome
• Follow Playhead : The edit window will scroll to follow the playhead when the playhead reaches the

edge of the editing canvas.
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• Stationary Playhead : If enabled, AND Follow Playhead is enabled, then the timeline will scroll behind
the playhead. This requires significant CPU and disk resources, so it is not recommended for large
sessions.

• Panic: Sends MIDI note off to all channels more here
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Edit Menu
• Undo
• Redo
• Undo Selection Change
• Redo Selection Change
• Cut
• Copy
• Paste

• Select >
◦ Select All Objects
◦ Selects All Tracks
◦ Deselect All
◦ Invert Selection
◦ Select All After Edit Point
◦ Select All Before Edit Point
◦ Select All Overlapping Edit Range
◦ Select All Inside Edit Range
◦ Select All in Punch
◦ Select All in Loop Range
◦ Move Range Start to Previous Region Boundary
◦ Move Range Start to Next Region Boundary
◦ Move Range End to Previous Region Boundary
◦ Move Range End to Next Region Boundary
◦ Start Range
◦ Finish Range
◦ Select Next Track or Bus
◦ Select Previous Track or Bus

• Delete

• Crop

• Split/Separate

• Separate >
◦ Separate Under
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◦ Separate Using Loop Range
◦ Separate Using Punch Range

• Align >
◦ Align Start
◦ Align Start Relevant
◦ Align End
◦ Align End Relevant
◦ Align Sync
◦ Align Sync Relevant

• Fade >
◦ Set Fade In Length
◦ Fade In
◦ Set Fade Out Length
◦ Fade Out

Remove Last Capture

• Edit Point >
◦ Change Edit Point
◦ Change Edit Point Including Marker

• Snap Mode >
◦ No Grid
◦ Grid
◦ Magnetic
◦ Next Snap Mode
◦ Next Snap Choice
◦ Previous Choice
◦ Previous Musical Snap Choice

• Snap to >
◦ Snap to CD Frame
◦ Snap to Timecode Frame
◦ Snap to Timecode Seconds
◦ Snap to Timecode Minutes
◦ Snap to Seconds
◦ Snap to Minutes
◦ Snap to One Twenty Eighths
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◦ Snap to Sixty Fourths
◦ Snap to Thirty Seconds
◦ Snap to Twenty Eighths
◦ Snap to Twenty Fourths
◦ Snap to Twentieths
◦ Snap to Sixteenths
◦ Snap to Fourteenths
◦ Snap to Twelfths
◦ Snap to Tenths
◦ Snap to Eighths
◦ Snap to Sevenths
◦ Snap to Sixths
◦ Snap to Fifths
◦ Snap to Quarters
◦ Snap to Thirds
◦ Snap to Halves
◦ Snap to Beat
◦ Snap to Bar
◦ Snap to Mark
◦ Snap to Region Start
◦ Snap to Region End
◦ Snap to Region Sync
◦ Snap to Region Boundary

• Tempo
◦ Set Tempo from Region
◦ Set Tempo from Edit Range

• Smart Object Mode: More here

• Preferences: More here
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Preferences Window
OS X: The Preferences window can be found under the menu item Mixbus->Preferences.
Linux & Windows: The Preferences window can be found under the menu item Edit->Preferences.

The preferences window has several tabs across the top:

The Preferences window defines your global preferences. These preferences apply to all of
the sessions on your machine. Global preferences define the way you like to work, and the
way your system is set up (such as your MIDI control surfaces or timecode sources). If you
want to change settings for a particular session, go to Session Properties.

*
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Misc Tab – The “Misc” tab defines some general behaviors of Mixbus

DSP CPU Utilization:

• This defines how many “threads” Mixbus will create to process audio signals. If you use a lot of tracks
and plug-ins, then Mixbus will require significant CPU resources. This setting allows Mixbus to use
multiple processors in parallel, thereby taking advantage of modern computers with 2, 4, or more CPU
cores.
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• “all but one processor” is the default setting. This setting reserves one processor so your computer
does not feel sluggish when Mixbus is heavily loading your CPU.

• “all processors” might allow Mixbus to run more tracks/plug-ins with the risk of causing other desktop
applications feeling sluggish.

Undo:

• Limit Undo History: This should be enabled to limit the memory and disk space that Mixbus will use to
store Undo information. Select a number of operations that you’d like Mixbus to remember.

• Verify removal of last capture: Displays a confirmation message before removing a capture.
• Make periodic backups of the session files: If this is enabled, then Mixbus will occasionally store a

“pending” file. If Mixbus crashes or the computer loses power, you will be prompted to open the most
recent “pending” file of the next startup; this will likely restore you to the state slightly before the
power outage. In addition to the pending file, Mixbus creates a date stamped snapshot in the sessions
“backup” folder. As an added precaution, these snapshots must be dragged into the main session
folder before they can be loaded. If you need help with this, email our support line at
mixbus@harrisonconsoles.com

Session Management:

• Always Copy Imported Files: If this is enabled, then (a) the “copy to session” checkbox will be
automatically selected, and cannot be changed. (b) Files that are drag & dropped into the session will
be copied into the session, rather than “referenced”

• Default Folder for new Sessions: select a folder here, and this will be the default location that appears
in the New Session dialog pulldown.

• Maximum Number of Recent Sessions: this defines how many sessions will be displayed in the New
Session dialog list.

Click:

• Click audio file: Browse to define the sound file for the “click” used by the metronome. If no sound file
is defined, Mixbus will use an internally-generated click sound.

• Click emphasis audio file: Browse to define the sound file for the “emphasis click” used by the
metronome. The emphasis click occurs on the first beat of each measure.

Regardless of the “periodic backup” setting, Mixbus stores a “pending” file whenever you
start a new recording. This makes it very likely that, even in the case of a crash or power
outage, a recording in process can be recovered.
*
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• Click gain level: Adjustable from – infinity to +6 dB

Automation:

• Thinning factor: Removes data points within the automation draw points. Excessive draw data may
reduce system responsiveness with little to no audio benefit.

• Automation sampling interval: Determines the rate at which automation points are acquired. If the
density of automation points is too high system responsiveness may be reduced.
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Transport Tab

• Keep recorded enabled on stop: To prevent accidental overwriting this is off by default
• Stop recording when an xrun occurs: A buffer xrun will produce noise. Checking this option prevents

this noise from accidentally being recorded.
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• Play loop is a transport mode: When enabled the loop button does not start playback but forces
playback to always play the loop. When disabled the loop button starts playing the loop, but stop then
cancels loop playback.

• Create markers where xruns occur:
• Stop at the end of a session: When enabled if Mixbus is not recording, it will stop the transport when it

reaches the current session end marker. When disabled Mixbus will continue to roll past the session
end marker at all times.

• Do seamless looping (not possible when slaved to MTC, LTC etc): When enabled this will loop by
reading ahead and wrapping around at the loop point, preventing any need to do a transport locate at
the end of the loop. When disabled looping is done by locating back to the start of the loop when
Mixbus reaches the end which will often cause a small click or delay.

• Disable per-track record disarm while rolling: When enabled this will prevent you from accidentally
stopping specific tracks recording during a take.

• 12 dB gain reduction during fast-forward and fast-rewind: This will prevent the unpleasant increase in
perceived volume that occurs when fast forwarding or rewinding through certain kinds of audio.

Sync/Slave:

• External timecode source: Select between MIDI Timecode, MIDI Clock, or LTC
• Match session video frame rate to external timecode:

This option controls the value of the video frame rate while chasing an external timecode source.
When enabled the session video frame rate will be changed to match that of the selected external
timecode source.
When disabled the session video frame rate will not be changed to match that of the selected external
timecode source. Instead the frame indication in the main clock will flash red and Mixbus will convert
between the external timecode standard and the session standard.

• Sync lock timecode to clock – Disable drift compensation: When enabled Mixbus will never varispeed
when slaved to external timecode. Sync Lock indicated that the selected external timecode source
shares clock-sync (Black and Burst, Wordclock, etc) with the audio interface. This option disable drift
compensation. The transport speed is fixed at 1.0. Varispeed LTC will be ignored and cause drift.
When disabled Mixbus will compensate for potential drift, regardless if the timecode sources share
clock sync.

• Lock to 29.9700 fps instead of 300000/1001: When enabled the external timecode source is assumed
to use 29.97 fps instead of 30000/1001.
SMPTE 12M-1999 specifies 29.97 fps as 3000/1001. The spec further mentions that drop-frame
timecode has an accumulated error of -86 ms over a 24 hour period. Drop-frame timecode would
compensate exactly for a NTSC color frame rate of 30 * 0.9990 (i.e. 29.970000). That is not the actual
rate. However, some vendors use that rate – despite it being against the specs – because the variant
of using exactly 29.97 fps has zero timecode drift.
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LTC Reader:

LTC incoming port: allows selection of the appropriate port.

LTC Generator:

Enable LTC generator:
Send LTC while stopped: When enabled Mixbus will continue to send LTC information even when the
transport (playhead) is not moving.
LTC generator level: Specify the peak volume of the generated LTC signal in dBFS. A good value is 0
dBu^= -18 dBFS in an EBU calibrated system.
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Editor Tab

Allow Dragging or Playhead: (default: ON) Allows clicking on the red playhead to drag it. Disable this if
you want your clicks to bypass the playhead and click on the thing behind it.
Move relevant automation when regions are moved: (default: ON) When you drag a region, this will also
move any automation points that are within the region’s bounds. NOTE: this will overwrite any existing
automation in the destination location.
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Show Meters on Tracks in the Editor: (default: ON) Disable this to hide the small meters at the right edge
of track headers in the editor.
Display Master-Meter in the toolbar: (default: ON) Disable this to hide the master level meter that appears
in the top-right corner of the editor window.

Regions in Active Edit Groups are edited together:
**only if they have identical length, position and origin (Default) grouped selection/drags will only occur if the
regions are likely from the same source material, and have been edited in sync.
**whenever they overlap in time: if a region has any overlap with the currently-selected region, then it will
move with the region.
Layering Model:

• Manual Layering (Default) : in this mode, the user is expected to manually control each region’s layer.
• Later-is-higher: in this mode, region layering is defined so that later regions will be assigned a higher

layer.

Waveform Scale:
• Linear: Displays the audio waveform in a linear fashion. This setting does not change the gain of the

signal, it is strictly a visual aid.
• Logarithmic: Displays the audio waveform so that quiet sounds can be more easily seen on the

screen. The display is disproportionate. This setting does not change the gain of the signal, it is
strictly a visual aid.

Waveform Shape:
• Traditional (Default): Waveforms are drawn around a “zero” axis in the middle of the region.
• Rectified: Waveforms are drawn with “zero” on the bottom of the region, and the wave values are

shown in an absolute-value (rectified) magnitude offset

Name New Markers: When a new marker is created this will allow a name to be made (You can always
rename markers by right-clicking on them).
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Audio Tab

Buffering:
A smaller buffer allows mixbus to load sessions and locate faster. If you receive a message like “your disk
was not able to keep up with Mixbus”, then you should increase the buffer size. If you have fewer tracks
(8-16), and/or a very fast disk (SSD), then you can use very low buffer sizes, and Mixbus will feel extremely
responsive. Generally speaking, Mac requires larger buffers than Windows and Linux.
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Denormals

Denormals relate to 32 bit floating point processing used by Mixbus. Some plugins, when used in Mixbus,
generate “denormals” which is an invalid processor state that causes random high CPU spikes. If you
believe a plugin is generating denormals, you can enable this checkbox for the track, and see if it helps the
problem.

• Use DC bias
• No processor handling:
• Use Denormals Are Zero
• Use Flush To Zero & Denormals Are Zero

for more on denormals click here
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Solo/Mute Tab
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MIDI Tab
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User Interaction Tab
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Control Surfaces Tab

To learn more about Control Surfaces, visit External Control

Video Tab

• Advanced Setup (remote video server): When enabled you can specify a custom video server URL
and docroot.

• Show Video Export Info before export: When enable an information window with details is displayed
before video export dialog.
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• Show Video Server Startup Dialog: When enabled the video server is never launched automatically
without confirmation.

Plug-ins Tab

• Scan for plug-ins: Click this button to initiate a “scan” along the paths listed in the VST path box. A
pop up dialog window shows the progress of the scan operation.

• Clear Paths & Cache: Clicking this button will erase the VST path box. It also clears the “cache” which
is a list of plug-ins that have been scanned. Mixbus will only load plug-ins that have been scanned
and are in the cache. So clicking this button will VST plug-ins in Mixbus until paths have been
scanned.

• Clear VST Blacklist: When a plug-in crashes on scanning, it is placed in the “blacklist” and will not be
scanned in the future. Click this button to clear all blacklisted plug-ins so they can be scanned.

• Scan for [new] VST Plugins on Application Start: New VST plugins are searched, tested and added to
the cache index on application start. When disabled new plugins will only be available after triggering
a ‘Scan’ manually.

• Verbose Plugin Scan: Addition information for every plugin is added to the log Window.
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• VST Path: the VST path is a list of directories that Mixbus will use to scan for plug-ins. This path may
not be directly edited by the user, but can be cleared, added to, and set to defaults with the buttons
below it.

• Add: Clicking this button will allow the user to select a folder which contains VST plug-ins. Highlight
the folder and click “OK” to select a plug-in folder and add it to the VST path.

• Delete: Will remove the selected path from the VST scan.
• Restore to Default: This will set the VST path to those folders that are defined as VST paths in the

Windows system. This includes paths set in the registry as well as the environment variable
VST_PATH.
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GUI Tab
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Metering Tab

Metering: Fall Off Rate
The decay rate of audio meters, ranging from Off (instant decay) to Slowest (6.6dB/sec decay rate)

Metering: Hold Time
The hold time for the peak-hold indicators. Ranges from Off (no display) to Slowest (5 second hold). Note:
This is only shown in Mixbus for compatibility with Ardour.
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Theme Tab

• All floating windows are dialogs: Mark all floating windows to be type “Dialog” rather than using
“Utility” for some. Requires restart of Mixbus. This can help if you find that some popup dialogs are
appearing behind the main window, or otherwise not being managed correctly by your desktop.

• Transient windows follow front window: Makes transient windows follow the front window when
toggling between the editor and mixer. Requires restart of Mixbus.
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• Draw “flat” buttons: Removes gradients from the buttons (may result in easier viewing on some
monitors).

• Blink Rec-Arm buttons: blinks the track rec-arm buttons; this can be a more obvious indication when a
track is armed

• Color regions using their track’s color: if disabled, all regions will be the same color, not affected by
the track’s selected color

• Show waveform clipping: if disabled, regions will not show red indicators when a region exceeds
0dBFS

• Timeline item gradient depth: this defines the amount of “color gradient” applied to the audio regions
in the timeline. Reducing this value will result in a flatter, less 3d-look.
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Region Menu
This menu give the user access to many editing features for regions or tracks in the canvas.
The region you intent to work with must first be selected or the menu selections with be grayed out.

Region menu includes:

• Insert Region From Region List
• Play
• Loop
• Rename…
• Properties…
• Edit >

◦ Combine
◦ Uncombine
◦ Pitch Shift…
◦ Split at Percussion Onsets
◦ Make Mono Regions
◦ Close Gaps
◦ Place Transient
◦ Rhythm Ferret…
◦ Strip Silence…

select track(s) or region(s) you would like to detect silence. Batch processing possible by
selecting multiple tracks or regions. Once the analysis has completed the areas that have met
the criteria for silence will be highlighted.

• Threshold: This sets the audio level for detecting silence and is adjustable by 1 dBFS increments.
Any audio below the set threshold will be considered silence.

• Minimum length (in milliseconds, default =1000 (1 second)): Allows control of the shortest time
period that will be considered silence.

• Fade Length (in samples, default =64): This setting adjusts the length of fades at the transitions of
detected silence and detected audio.

• Layering >
◦ Raise to Top
◦ Raise
◦ Lower
◦ Lower to Bottom
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• MIDI>
◦ Transpose
◦ Insert Patch Change
◦ Quantize…
◦ Legatize
◦ Remove Overlap
◦ Unlink from other copies
◦ List Editor…

• Gain >
◦ Opaque
◦ Mute
◦ Normalize
◦ Boost Gain
◦ Cut Gain
◦ Reset Envelope
◦ Envelope Active

• Position >
◦ Move to Original Position
◦ Snap Position To Grid
◦ Lock
◦ Glue to Bars and Beats
◦ Lock to Video
◦ Set Sync Position
◦ Remove Sync
◦ Nudge Later
◦ Nudge Earlier
◦ Nudge Later by Capture Offset
◦ Nudge Earlier by Capture Offset
◦ Sequence Regions

• Trim >
◦ Trim Start at End Point
◦ Trim End at Edit Point
◦ Trim Loop
◦ Trim Punch
◦ Trim Previous
◦ Trim Next
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• Ranges >
◦ Set Loop Range
◦ Set Punch
◦ Add Single Range Marker
◦ Add Range Marker Per Region
◦ Set Range Selection

• Fades >
◦ Fade In
◦ Fade Out
◦ Fades

• Duplicate >
◦ Duplicate
◦ Multi-Duplicate
◦ Fill Track

• Export…
• Bounce (without processing)

• Remove
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Strip Silence
The Strip Silence command can be found under Region>Edit>Strip Silence. You must first select the
track(s) or region(s) in which you would like to detect silence. Batch processing is possible by selecting
multiple track or regions. Once the Strip Silence dialogue has been opened Mixbus will begin analysis on all
selected tracks or regions (allow time based on CPU speed and track/region length). Once the analysis has
completed the areas that have been determined to contain silence will be highlighted.

There are 3 adjustments available:

• Threshold: This sets the audio level for detecting silence and is adjustable by 1 dBFS increments.
Any audio below the set threshold will be considered silence.

• Minimum length (in milliseconds, default =1000 (1 second)): Allows control of the shortest time
period that will be considered silence.

• Fade Length (in samples, default =64): This setting adjusts the length of fades at the transitions of
detected silence and detected audio.
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Track Menu
The Track header must first be selected to access many of the items in this menu.

• Add Track or Bus… Learn more here
• Import
• Toggle Record Enabled
• Toggle Solo
• Toggle Mute
• Insert Time
• Cut Time: Deletes selected range and markers (from ALL tracks). Everything to the right moves to

close the gap.
• Move Selected Tracks Up
• Move Selected Tracks Down
• Height >

◦ Fit Selection (Vertical)
◦ Largest
◦ Largest
◦ Large
◦ Normal
◦ Small

• Toggle Active
• Remove
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View Menu
• Maximise Editor Space
• Maximise Mixer Space
• Show Toolbars
• Reattach All Tearoffs
• Primary Clock >

◦ Focus On Clock
◦ Timecode
◦ Bars & Beats
◦ Minutes & Samples
◦ Samples

• Secondary Clock >
◦ Timecode
◦ Bars & Beats
◦ Minutes & Samples
◦ Samples

• Zoom >
◦ Zoom In
◦ Zoom Out
◦ Zoom to Session
◦ Fit Session
◦ Fit Selection
◦ Fit Selection
◦ Toggle Zoom State
◦ Expand Track Height
◦ Shrink Track Height

• Zoom Focus >
◦ Zoom Focus Left
◦ Zoom Focus Right
◦ Zoom Focus Center
◦ Zoom Playhead
◦ Zoom Mouse
◦ Zoom Focus Edit Point
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◦ Next Zoom Focus

• Rulers >
◦ Min:Sec
◦ Timecode
◦ Samples
◦ Bars & Beats
◦ Meter
◦ Tempo
◦ Ranges
◦ Loop/Punch
◦ CD Markers
◦ Markers
◦ Video

• Video Monitor >
◦ Original Size
◦ Letterbox
◦ Always on Top
◦ Fullscreen
◦ Timecode
◦ Frame Number
◦ Timecode & Background

• Scroll >
◦ Scroll Tracks Down
◦ Scroll Tracks Up
◦ Scroll Forward
◦ Scroll Backwards

• Views >
◦ Save View 1
◦ Goto View 1
◦ Save View 2
◦ Goto View 2
◦ Save View 3
◦ Goto View 3
◦ Save View 4
◦ Goto View 4
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◦ Save View 5
◦ Goto View 5
◦ Save View 6
◦ Goto View 6
◦ Save View 7
◦ Goto View 7
◦ Save View 8
◦ Goto View 8
◦ Save View 9
◦ Goto View 9
◦ Save View 10
◦ Goto View 10
◦ Save View 11
◦ Goto View 11
◦ Save View 12
◦ Goto View 12

• Show Editor Mixer
• Show Editor List
• Show Measures
• Show Summary
• Show Group Tabs
• Show Marker Lines
• Show more UI preferences
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Window Menu
• Audio/MIDI Setup More here
• Mixer: More here
• Meterbridge: More here
• Toggle Editor+Mixer
• Locations
• Key Bindings: More here
• Big Clock: A scalable clock window for distance viewing. Right Click for formats
• License Manager: Displays the status of your Mixbus and Harrison LV2 plugin licenses
• Video Monitor: Display video content
• MIDI Tracer
• Audio Connections: More here
• MIDI Connections
• Log
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Locations Window
The Locations window provides another view of the Location Markers, Loop Range, Punch Range, Ranges,
and CD Ranges that appear on the “rulers” of the Editor window. This window allows you to see all of the
existing markers in one window with all of the parameters displayed.

• Go: Moves the Playhead to the associated Marker or the start/end of the associated Range.
• Use PH: Assign the current Playhead location to the marker or the start/end of the associated Range.
• Hidden: Markers and ranges may be shown or hidden.
• CD: For locations, this is CD Indexes. For ranges, this indicates that the range represents a CD

Track.

Items with the CD box checked will also get the ISRC, SCMS, Pre-emphasis, Performer, and Composer
entry boxes which will be incorporated into the CUE/TOC file during session export and can be imported by
CD burning software.
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Rhythm Ferret Window
The Rhythm Ferret dialog provides a method to quickly “split” an audio region (or selection of regions)
based on events. This can be useful when separating a recorded performance into its component strikes or
notes for further editing.

• Mode: Determines whether the Ferret will trigger on percussive onsets for unpitched percussion
instruments, or note onsets (for pitched instruments).

• Threshold, Sensitivity: adjust these parameters to refine the detection of events
• Trigger gap: the shortest distance between events that the Ferret will allow. Increase this number if

you get multiple triggers on a single note.
• Analyze: displays the results of the analysis on the selected track(s).

Once you are satisfied with the points that the Ferret has chosen to split, you can click “Split on Onsets” to
automatically split the selected regions on the marks.
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Tracks and Buses

Click above for video instructions.
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Meterbridge
The Meterbridge can be found under Window>Meterbridge and can be toggled via a check box.

The Meterbridge window is a compact and re-sizable view of all meters for all tracks, mix buses and master
bus levels available during a session. 10 metering standards are available and are user selectable by right
clicking on each meter.

Available metering:

• Peak
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• RMS + Peak
• IEC1/DIN
• IEC1/Nordic
• IEC2/BBC
• IEC2/EBU
• K20
• K14
• K12
• VU

Most users involved with music production will find Peak metering a good choice during tracking. This meter
type helps the user avoid digital clipping. This is because peak meters are calibrated to 0 dBFS (decibel full
scale). When the meter reads 0 no more bits are left to capture dynamics.

Most music production users may find Peak+RMS Metering, K Metering, or VU metering useful on the
master bus.

The 4 remaining metering standards are of the IEC type and are typically used for broadcast work and
allows for consistency of volume within the broadcast industry.

Located at the bottom of each meter is a rec-enable button. Under the rec-enable button is the track name.
Right clicking on the track name allows the user to change the height of this area. Advanced configuration
allows the addition of Solo, Mute, Monitor Playback and Monitor Input.

At the top of each meter is a button to reset peak warning indicators. You can Ctrl+left click to reset the
group or Ctrl+Shift+left click to reset all peak warning indicators.

It is possible for a recorded signal to be clipped before being digitized and displayed on a
meter. As a result, a safe level can be displayed on any meter and in any DAW. No DAW
meter will show if a signal has clipped before being digitized.

!

The K system is extremely useful and is a new standard that has gained traction. K14 is
suitable for the vast majority of music production. As the name suggest it allows for 14 dB of
headroom. K20 allows for 20 dB of dynamic headroom and is useful for less compressed
“audiophile” recordings or large movie theater soundtracks. K12 is useful for Television
broadcast etc. The K metering system has been devolved by Bob Katz.

*
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Meterbridge properties:

The Meterbridge is user customizable by going to to the menu Session>Properties>Meterbridge

Advanced configuration of the meters is available in Edit > Preferences > Metering.
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Help Menu
• About
• Manual: Links to this manual
• Videos: Links to Mixbus Instructional videos
• User Forums: Links to The Mixbus user forum
• Developer Chat: Links to IRC (Internet Relay Chat)
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Keyboard Shortcuts
Mixbus has a standard keyboard shortcut layout that provides alternate keystrokes that are available in
other digital audio workstations. In the following tables, “NumPad” is used to reference the number pad on
the right side of the keyboard. Key bindings are user definable via Menu>Window>Key Bindings.

Windows/Linux
Mac
Using a Number Pad
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Windows/Linux
Mixbus has a standard keyboard shortcut layout that provides alternate keystrokes that are available in
other digital audio workstations. In the following tables, “NumPad” is used to reference the number pad on
the right side of the keyboard. Number pad specific keybindings are also listed at Using a number pad.

Session and File Handling
Action Standard Mixbus Layout Alternate 1 Alternate 2

start a new session Control+n

open an existing session Control+o

open a recent session Control+Shift+o

save session Control+s

save session snapshot Control+Shift+s

add track(s) / bus(ses) Control+Shift+n

add existing audio files Control+i

export audio Alt+e

quit Control+q

Common Functions
Action Standard Mixbus Layout Alternate 1 Alternate 2

copy Control+c

cut Control+x

delete Delete BackSpace

paste Control+v

redo Control+r Control+Shift+z Control+y

undo Control+z

Transport and Recording Control
Action Standard Mixbus Layout Alternate 1 Alternate 2
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roll playhead spacebar NumPad 0

play from edit point & return Control+Shift+spacebar

roll record Shift+spacebar NumPad 3

toggle roll & forget capture Control+spacebar

rewind Shift+left arrow NumPad 1

fast forward Shift+right arrow NumPad 2

transition to reverse Shift+down arrow

transition to play Shift+up arrow

toggle auto play 5

toggle auto return 6

toggle click 7

set tempo from region 9

toggle follow playhead Control+f

toggle follow edits shift+f

toggle track rec-enable shift+b

toggle master rec-enable Shift+r

set playhead to cursor location p

play selected region(s) h

loop play (the loop range) L NumPad 4

key focus on main clock NumPad /

MIDI panic Control+Alt+p

Changing What’s Visible
Action Standard Mixbus Layout Alternate 1 Alternate 2

toggle keybinding editor Alt+k

fit selected tracks vertically f

tracks page down Page_Down

scroll tracks down (step) down arrow

select next track down Alt+down arrow

select next track up Alt+up arrow
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tracks page up Page_Up

scroll tracks up (step) up arrow

toggle edit / mix window Alt+m Control+=

show editor mixer Shift+e

toggle maximized editor Control+Alt+f

toggle maximized mixer Control+Shift+f

toggle zoom Shift+z

toggle audio connection manger Alt+n

toggle MIDI connection manager Alt+Shift+m

zoom (x) to selected region(s) z

zoom in =

zoom out -

zoom to session (Start / End markers) _ (Underscore)

save visual state 1 Control+F1

save visual state 2 Control+F2

save visual state 3 Control+F3

save visual state 4 Control+F4

save visual state 5 Control+F5

save visual state 6 Control+F6

save visual state 7 Control+F7

save visual state 8 Control+F8

save visual state 9 Control+F9

save visual state 10 Control+F10

save visual state 11 Control+F11

save visual state 12 Control+F12

go to visual state 1 F1

go to visual state 2 F2

go to visual state 3 F3

go to visual state 4 F4

go to visual state 5 F5

go to visual state 6 F6
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go to visual state 7 F7

go to visual state 8 F8

go to visual state 9 F9

go to visual state 10 F10

go to visual state 11 F11

go to visual state 12 F12

Window Visibility
Action Standard Mixbus Layout Alternate 1 Alternate 2

toggle marker locations Alt+l

toggle meter bridge Alt+b

toggle preferences window Alt+p

toggle rhythm ferret window Alt+f

toggle session properties window Alt+o

toggle export window Alt+e

toggle import window Control+i

add new track / bus Shift+Control+n

Mouse Modes
Action Standard Mixbus Layout Alternate 1 Alternate 2

range mode r

object range mode y

grab mode g

draw mode d

timefx mode t

zoom to selection mode z

edit contents mode e
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Moving The Playhead
A left click in the rulers positions the playhead unless Mixbus is recording. You can use
(period)>Num>(period) to move the playhead to the n-th marker.

Action Standard Mixbus
Layout Alternate 1 Alternate

2

to start marker Home Enter Return

to end marker End

nudge backward Alt+left arrow

nudge forward Alt+right arrow

to previous region edge left arrow

to next region edge right arrow

step playhead previous grid unit (ignore
selection) Shift+Alt+left arrow

step playhead next grid unit (ignore selection) Shift+Alt+right arrow

to previous region sync Control+Alt+left arrow

to next region sync Control+Alt+right
arrow

to previous transient Control+left arrow (Shift or Alt or Ctrl
)+Tab

to next transient Control+right arrow

to previous mark q

to next mark w

Selecting
Action Standard Mixbus Layout Alternate 1 Alternate 2

select all Control+a

deselect all Escape

export selection Control+Alt+e

invert selection Shift+i

select all after edit point Control+Shift+p Control+Shift+p

select all before edit point Control+p Control+p
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select all between cursors Control+u

select all within cursors u

Editing Features
Most edit functions operate on a single ”Edit Point”. The edit point can be defined as the playhead (default)
or the mouse. The choice of Edit Point is by default linked to the Zoom Focus.

Action Standard Mixbus Layout Alternate 1 Alternate 2

cycle zoom focus 1

cycle snap mode 2

previous snap choice 3

cycle edit point ` (grave)

cycle edit point with marker Control` (Control grave)

trim back k

trim front j

trim to previous region Control+j

trim to next region Control+k

edit mode e

cursor to transient backwards Control+left arrow

cursor to transient forward Control+right arrow

nudge forward Control KP + (plus)

nudge backwards Control KP – (minus)

Markers and Locations
The ”move” commands all move the active marker(s). Jump to the first 9 markers using the keypad digits
1-9 (requires numlock).

Action Standard Mixbus Layout Alternate 1 Alternate 2

playhead to previous mark q

playhead to next mark w

sets new marker at playhead Tab
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go to marker 1 .(period) NumPad 1.(period)

go to marker 2 .(period) NumPad 2.(period)

go to marker 3 .(period) NumPad 3.(period)

go to marker 4 .(period) NumPad 4.(period)

go to marker 5 .(period) NumPad 5.(period)

go to marker 6 .(period) NumPad 6.(period)

go to marker 7 .(period) NumPad 7.(period)

go to marker 8 .(period) NumPad 8.(period)

go to marker 9 .(period) NumPad 9.(period)

Region Operations
Action Standard Mixbus Layout Alternate 1 Alternate 2

mute/unmute region Alt 1

reverse region Alt 4

naturalize region Alt 2

boost region gain Alt 6

cut region gain Alt 7

normalize region Alt 3

quantize region Alt 5

pitch shift region Alt 8

align, sync point relative a

align, regions sync point Shift+a

align, regions end point Alt+a

align, regions start point Control+Alt +a

align, regions start point relative Control+Shift+a

duplicate region (once) d

duplicate region (multi) Shift+d

export selected region(s) Shift+Alt+e

insert region from list i

split / separate s b Alt+x
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crop Alt+c

set region sync point v

nudge backward Alt+left arrow NumPad –

nudge forward Alt+right arrow NumPad +

set fade-in length Control/

set fade-out length Control\

edit fade range / (slash)

Track Operations
Action Standard Mixbus Layout Alternate 1 Alternate 2

rec-enable selected tracks Shift+b

solo selected tracks Alt+s

select all track/bus Control+t

select next track/bus Alt+downarrow

select previous track/bus Alt+uparrow

move selected tracks down Control+downarrow

move selected tracks up Control+uparrow

toggle MIDI input Alt+i

Defining Loop, Punch Range, and Tempo Changes
Action Standard Mixbus Layout Alternate 1 Alternate 2

start edit range , (comma)

finish edit range . (period)

loop start Alt+,

loop end Alt+.

set loop range from edit range ]

set loop range from region(s) Alt+]

select all within punch range Control+d,

set punch range from edit range [
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Mouse Object Mode
This mode provides many different operations on both regions and control points, partially depending on
here you click/drag with the mouse. The ”body” of a region is the area where the waveform is displayed.

Mixbus Function Mouse Command

add control point left-click in auto track

add/remove selection Control+left-click on body

adjust region edges left-drag near ends of trim bar

copy+move region(s) Control+left-drag on body

extend selection Shift+left-click on body

fixed time adjust middle-drag on point

fixed time copy+move Control+middle-drag on body

fixed time move middle-drag on body

fixed time move Control+middle-drag on point

lower region Alt+Shift+middle on body

move control point left-drag on point

move line segment left-drag on line segment

move point+later points Control+left-drag on point

move region(s) left-drag on body

raise region Shift+middle on body

rubber-band select Control+Alt+left-drag on regions

rubber-band select left-drag on empty space

rubber-band select left-drag in auto track

select left-click on body

set region end middle in trim bar

set region start left-click in trim bar

slip audio in region Control+left-drag in trim bar

Mouse Zoom Mode
Mixbus Function Mouse Command
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define the new visible area left+drag

zoom in left-click

zoom out middle-click

zoom to session Control+middle

Mouse Ops on Solo/Mute/Rec-enable
Mixbus Function Mouse Command

apply to all tracks/busses Control+Shift+left-click

apply to group Control+left-click

apply to track or active group left-click

learn MIDI control Control+middle-click

momentary switch middle-click

Mouse Ops on Solo Buttons Only
Mixbus Function Mouse Command

exclusive solo Control+Alt+left-click

temporary latched solo Shift+left-click

Mouse Ops on Faders & Plug-in Controls
Mixbus Function Mouse Command

adjust left-drag

fine-drag control Control+left-drag

finest-drag control Control+Alt+left-drag

learn MIDI control Control+middle-click

reset to default Shift+left-click
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Mac
Mixbus has a standard keyboard shortcut layout that provides alternate keystrokes that are available in
other digital audio workstations. In the following tables, “NumPad” is used to reference the number pad on
the right side of the keyboard. Number pad specific keybindings are also listed at Using a number pad.

Session and File Handling
Action Standard Mixbus Layout Alternate 1 Alternate 2

start a new session Command+n

open an existing session Command+o

open a recent session Command+Shift+o

save session Command+s

save session snapshot Command+Shift+s

add track(s) / bus(ses) Command+Shift+n

add existing audio files Command+i

export audio Control+e

quit Command+q

Common Functions
Action Standard Mixbus Layout Alternate 1 Alternate 2

copy Command+c

cut Command+x

delete Delete BackSpace

paste Command+v

redo Command+r Command+Shift+z Command+y

undo Command+z

Transport and Recording Control
Action Standard Mixbus Layout Alternate 1 Alternate 2
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roll playhead spacebar NumPad 0

play selection Control+spacebar

play from edit point & return Command+Shift+spacebar

roll record Shift+spacebar NumPad 3

toggle roll & forget capture Command+spacebar

rewind Shift+left arrow NumPad 1

fast forward Shift+right arrow NumPad 2

transition to reverse Shift+down arrow

transition to play Shift+up arrow

toggle auto play 5

toggle auto return 6

toggle click 7

set tempo from region 9

toggle follow playhead Command+f

toggle follow edits Shift+f

toggle track rec-enable Shift+b

toggle master rec-enable Shift+r

set playhead to cursor location p

play selected region(s) h

loop play (the loop range) L NumPad 4

key focus on main clock NumPad /

MIDI panic Command+Control+p

Changing What’s Visible
Action Standard Mixbus Layout Alternate 1 Alternate 2

toggle keybinding editor Control+k

fit selected tracks vertically f

tracks page down Page_Down

scroll tracks down (step) down arrow

select next track down Control+down arrow
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select next track up Control+up arrow

tracks page up Page_Up

scroll tracks up (step) up arrow

toggle edit / mix window Control+m Command+=

show editor mixer Shift+e

toggle maximized editor Command+Control+f

toggle maximized mixer Command+Shift+f

toggle zoom Shift+z

toggle audio connection manager Control+n

toggle MIDI connection manager Control+Shift+m

zoom (x) to selected region(s) z

zoom in =

zoom out -

zoom to session _ (Underscore)

save visual state 1 Command+F1

save visual state 2 Command+F2

save visual state 3 Command+F3

save visual state 4 Command+F4

save visual state 5 Command+F5

save visual state 6 Command+F6

save visual state 7 Command+F7

save visual state 8 Command+F8

save visual state 9 Command+F9

save visual state 10 Command+F10

save visual state 11 Command+F11

save visual state 12 Command+F12

go to visual state 1 F1

go to visual state 2 F2

go to visual state 3 F3

go to visual state 4 F4

go to visual state 5 F5
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go to visual state 6 F6

go to visual state 7 F7

go to visual state 8 F8

go to visual state 9 F9

go to visual state 10 F10

go to visual state 11 F11

go to visual state 12 F12

Window Visibility
Action Standard Mixbus Layout Alternate 1 Alternate 2

toggle marker locations Control+l

toggle meter bridge Control+b

toggle preferences window Control+p

toggle rhythm ferret window Control+f

toggle session properties window Control+o

toggle export window Control+e

toggle import window Command+i

add new track / bus Shift+Command+n

Mouse Modes
Action Standard Mixbus Layout Alternate 1 Alternate 2

range mode r

object range mode “Smart” y

grab mode g

draw mode d

timefx mode t

zoom to selection mode z

edit contents mode e
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Moving The Playhead
A left click in the rulers positions the playhead unless Mixbus is recording. You can use
(period)>Num>(period) to move the playhead to the n-th marker.

Action Standard Mixbus Layout Alternate 1 Alternate
2

to start marker Home Enter Return

to end marker End

nudge backward Control+left arrow

nudge forward Control+right arrow

to previous region edge left arrow

to next region edge right arrow

step playhead previous grid unit (ignore
selection) Shift+Control+left arrow

step playhead next grid unit (ignore
selection) Shift+Control+right arrow

to previous region sync Command+Control+left
arrow

to next region sync Command+Control+right
arrow

to previous transient Command+left arrow (Shift or Ctrl or Cmd
)+Tab

to next transient Command+right arrow

to previous mark q

to next mark w

Selecting
Action Standard Mixbus Layout Alternate 1 Alternate 2

select all Command+a

deselect all Escape

export selection Command+Control+e

invert selection Shift+i
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select all after edit point Command+Shift+p Command+Shift+p

select all before edit point Command+p Command+p

select all between cursors Command+u

select all within cursors u

Editing Features
Most edit functions operate on a single ”Edit Point”. The edit point can be defined as the playhead (default)
or the mouse. The choice of Edit Point is by default linked to the Zoom Focus.

Action Standard Mixbus Layout Alternate 1 Alternate 2

cycle zoom focus 1

cycle snap mode 2

previous snap choice 3

cycle edit point ` (grave)

cycle edit point with marker Command` (Command grave)

trim back k

trim front j

trim to previous region Command+j

trim to next region Command+k

edit mode e

cursor to transient backwards Command+left arrow

cursor to transient forward Command+right arrow

nudge forward Command KP + (plus)

nudge backwards Command KP – (minus)

Region Operations
Action Standard Mixbus Layout Alternate 1 Alternate 2

mute/unmute region Control 1

reverse region Control 4

naturalize region Control 2
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boost region gain Control 6

cut region gain Control 7

normalize region Control 3

quantize region Control 5

pitch shift region Control 8

align, sync point relative a

align, regions sync point Shift+a

align, regions end point Control+a

align, regions start point Command+Control+a

align, regions start point relative Command+Shift+a

duplicate region (once) d

duplicate region (multi) Shift+d

export selected region(s) Shift+Control+e

insert region from list i

split / separate s b Control+x

crop Control+c

set region sync point v

nudge backward Control+left arrow NumPad –

nudge forward Control+right arrow NumPad +

set fade-in length Command/

set fade-out length Command\

edit fade range / (slash)

Track Operations
Action Standard Mixbus Layout Alternate 1 Alternate 2

rec-enable selected tracks Shift+b

solo selected tracks Control+s

select all track/bus Command+t

select next track/bus Control+downarrow

select previous track/bus Control+uparrow
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move selected tracks down Command+downarrow

move selected tracks up Command+uparrow

toggle MIDI input Control+i

Defining Loop, Punch Range, and Tempo Changes
Action Standard Mixbus Layout Alternate 1 Alternate 2

start edit range , (comma)

finish edit range . (period)

loop start Control+,

loop end Control+.

set loop range from edit range ]

set loop range from region(s) Control+]

select all within punch range Command+d,

set punch range from edit range [

Mouse Object Mode
This mode provides many different operations on both regions and control points, partially depending on
here you click/drag with the mouse. The ”body” of a region is the area where the waveform is displayed.

Mixbus Function Mouse Command

add control point left-click in auto track

add/remove selection Command+left-click on body

adjust region edges left-drag near ends of trim bar

copy+move region(s) Command+left-drag on body

extend selection Shift+left-click on body

fixed time adjust middle-drag on point

fixed time copy+move Command+middle-drag on body

fixed time move middle-drag on body

fixed time move Command+middle-drag on point

lower region Control+Shift+middle on body
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move control point left-drag on point

move line segment left-drag on line segment

move point+later points Command+left-drag on point

move region(s) left-drag on body

raise region Shift+middle on body

rubber-band select Command+Control+left-drag on regions

rubber-band select left-drag on empty space

rubber-band select left-drag in auto track

select left-click on body

set region end middle in trim bar

set region start left-click in trim bar

slip audio in region Command+left-drag in trim bar

Mouse Zoom Mode
Mixbus Function Mouse Command

define the new visible area left+drag

zoom in left-click

zoom out middle-click

zoom to session Command+middle

Mouse Ops on Solo/Mute/Rec-enable
Mixbus Function Mouse Command

apply to all tracks/busses Command+Shift+left-click

apply to group Command+left-click

apply to track or active group left-click

learn MIDI control Command+middle-click

momentary switch middle-click
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Mouse Ops on Solo Buttons Only
Mixbus Function Mouse Command

exclusive solo Command+Control+left-click

temporary latched solo Shift+left-click

Mouse Ops on Faders & Plug-in Controls
Mixbus Function Mouse Command

adjust left-drag

fine-drag control Command+left-drag

finest-drag control Command+Control+left-drag

learn MIDI control Command+middle-click

reset to default Shift+left-click
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Using a Number Pad
Many full-size keyboards provide a “number pad” on the right side.

To locate to a marker, click the “.” (period), then type the number of the marker ( for example, “12” ) and
then press “.” again. This will locate to the designated location marker (“12”, in this case). Markers are
designated by their location on the timeline, not by their creation time or their name. So when locating
with the number pad, jumping to “3” will always be later on the timeline than “2”, regardless of what the
markers are named.

Markers and Locations
The ”move” commands all move the active marker(s). Jump to the first 9 markers using the keypad digits
1-9 (requires numlock).

Action Standard Mixbus Layout Alternate 1 Alternate 2

playhead to previous mark q

playhead to next mark w

go to marker 1 .(period) NumPad 1.(period)

go to marker 2 .(period) NumPad 2.(period)

go to marker 3 .(period) NumPad 3.(period)

go to marker 4 .(period) NumPad 4.(period)

go to marker 5 .(period) NumPad 5.(period)

go to marker 6 .(period) NumPad 6.(period)

go to marker 7 .(period) NumPad 7.(period)

go to marker 8 .(period) NumPad 8.(period)

go to marker 9 .(period) NumPad 9.(period)

Number Pad Action notes

0 play/stop Performs just like the spacebar.

1 reverse play Click again to increase the rewind speed.

2 forward play Click again to increase the forward speed.

3 record-roll Arms the master record button, and initiates Play.

Harrison Consoles Mixbus v3 - 1

Page 327 of 420



4 loop-roll Starts playing the selected loop range (if any).

5 loop record

6 Toggle Punch On/Off

7 Toggle Metronome On/Off

8 Toggle “Auto Return”

9 Toggle “Follow Edits”

The remaining Number Pad keys are reserved for future use.
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Video
Mixbus can load a (single) video file to associate with the session. The video reference is displayed in a
ruler above the editor, and (optionally) also shows moving video in a separate video window.

Mixbus does not allow editing of the video. However, you can export the video, with your audio mix, into a
new video. And you can set start & stop time for that video.

Video is largely developed by the Ardour open-source community. You can learn more about the video-
display features in the relevant sections of the Ardour manual: http://manual.ardour.org/video-timeline/

Video playback requires an external “server” called Harvid, and (optionally) an external video window.
These utilities are included in the Mixbus package, but installation steps are different for each OS:

Installation on Windows
On Windows, the Mixbus installer provides Harvid (the video server) and Jadeo (the video playback
window). To install them, select the “video tools” checkbox in the installer.

Installation on Mac
On Mac, the Mixbus application already includes Harvid (the video server). The Mixbus package provides
the Jadeo video viewer as a separate application in the DMG. If you want to use the video window, you
must drag the included XJadeo video viewer into your Application folder, so Mixbus can find it.

In the current release of Mixbus, v3.0, video should be considered an EXPERIMENTAL
feature. This feature will improve throughout the v3 series.

!
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Installation on Linux
On Linux, the Mixbus installer provides Harvid (the video server) and Jadeo (the video playback window).
No additional steps are required.

Syncing Mixbus to Non-Linear Editing software
Mixbus can be slaved to an incoming live LTC signal which arrives from a normal audio port (e.g ASIO).

Preferences > Transport > External Timecode Source “LTC”

If the LTC signal source is also generating wordclock for the soundcard, you can disable drift compensation
there, but it’s generally safe to leave “sync-lock” unchecked.
(Hover the mouse over each of the checkbox config items for a detailed explanation in the tooltip.)
Set the (ASIO) audio-port of the incoming LTC signal. The default is in the preferences and can be
overridden per session via Window > Audio Connection Manager > Mixbus Misc “LTC in”

Last step: In the Editor Window, change from “Internal” to “LTC”, the button just right of the global record-
enable.

Generally speaking it is preferable to let Mixbus generate LTC and slave the NLE to it. Varispeed video is
usually less of an issue than vari-speed audio.

(Clocks & Synchronization)

Video Formats Supported:
D = Demuxing supported
E = Muxing supported

• E 3g2 3GP2 (3GPP2 file format)
• E 3gp 3GP (3GPP file format)
• D 4xm 4X Technologies
• E a64 a64 – video for Commodore 64
• D aa Audible AA format files
• D aac raw ADTS AAC (Advanced Audio Coding)
• DE ac3 raw AC-3
• D act ACT Voice file format
• D adf Artworx Data Format
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• D adp ADP
• E adts ADTS AAC (Advanced Audio Coding)
• DE adx CRI ADX
• D aea MD STUDIO audio
• D afc AFC
• DE aiff Audio IFF
• DE alaw PCM A-law
• D alias_pix Alias/Wavefront PIX image
• DE amr 3GPP AMR
• D anm Deluxe Paint Animation
• D apc CRYO APC
• D ape Monkey’s Audio
• DE apng Animated Portable Network Graphics
• D aqtitle AQTitle subtitles
• DE asf ASF (Advanced / Active Streaming Format)
• D asf_o ASF (Advanced / Active Streaming Format)
• E asf_stream ASF (Advanced / Active Streaming Format)
• DE ass SSA (SubStation Alpha) subtitle
• DE ast AST (Audio Stream)
• DE au Sun AU
• DE avi AVI (Audio Video Interleaved)
• E avm2 SWF (ShockWave Flash) (AVM2)
• D avr AVR (Audio Visual Research)
• D avs AVS
• D bethsoftvid Bethesda Softworks VID
• D bfi Brute Force & Ignorance
• D bfstm BFSTM (Binary Cafe Stream)
• D bin Binary text
• D bink Bink
• DE bit G.729 BIT file format
• D bmp_pipe piped bmp sequence
• D bmv Discworld II BMV
• D boa Black Ops Audio
• D brender_pix BRender PIX image
• D brstm BRSTM (Binary Revolution Stream)
• D c93 Interplay C93
• DE caf Apple CAF (Core Audio Format)
• DE cavsvideo raw Chinese AVS (Audio Video Standard) video
• D cdg CD Graphics
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• D cdxl Commodore CDXL video
• D cine Phantom Cine
• D concat Virtual concatenation script
• E crc CRC testing
• E dash DASH Muxer
• DE data raw data
• DE daud D-Cinema audio
• D dds_pipe piped dds sequence
• D dfa Chronomaster DFA
• DE dirac raw Dirac
• DE dnxhd raw DNxHD (SMPTE VC-3)
• D dpx_pipe piped dpx sequence
• D dsf DSD Stream File (DSF)
• D dsicin Delphine Software International CIN
• D dss Digital Speech Standard (DSS)
• DE dts raw DTS
• D dtshd raw DTS-HD
• DE dv DV (Digital Video)
• D dvbsub raw dvbsub
• E dvd MPEG-2 PS (DVD VOB)
• D dxa DXA
• D ea Electronic Arts Multimedia
• D ea_cdata Electronic Arts cdata
• DE eac3 raw E-AC-3
• D epaf Ensoniq Paris Audio File
• D exr_pipe piped exr sequence
• DE f32be PCM 32-bit floating-point big-endian
• DE f32le PCM 32-bit floating-point little-endian
• E f4v F4V Adobe Flash Video
• DE f64be PCM 64-bit floating-point big-endian
• DE f64le PCM 64-bit floating-point little-endian
• DE ffm FFM (FFserver live feed)
• DE ffmetadata FFmpeg metadata in text
• D film_cpk Sega FILM / CPK
• DE filmstrip Adobe Filmstrip
• DE flac raw FLAC
• D flic FLI/FLC/FLX animation
• DE flv FLV (Flash Video)
• E framecrc framecrc testing
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• E framemd5 Per-frame MD5 testing
• D frm Megalux Frame
• DE g722 raw G.722
• DE g723_1 raw G.723.1
• D g729 G.729 raw format demuxer
• DE gif GIF Animation
• D gsm raw GSM
• DE gxf GXF (General eXchange Format)
• DE h261 raw H.261
• DE h263 raw H.263
• DE h264 raw H.264 video
• E hds HDS Muxer
• DE hevc raw HEVC video
• E hls Apple HTTP Live Streaming
• D hls,applehttp Apple HTTP Live Streaming
• D hnm Cryo HNM v4
• DE ico Microsoft Windows ICO
• D idcin id Cinematic
• D idf iCE Draw File
• D iff IFF (Interchange File Format)
• DE ilbc iLBC storage
• DE image2 image2 sequence
• DE image2pipe piped image2 sequence
• D ingenient raw Ingenient MJPEG
• D ipmovie Interplay MVE
• E ipod iPod H.264 MP4 (MPEG-4 Part 14)
• DE ircam Berkeley/IRCAM/CARL Sound Format
• E ismv ISMV/ISMA (Smooth Streaming)
• D iss Funcom ISS
• D iv8 IndigoVision 8000 video
• DE ivf On2 IVF
• D j2k_pipe piped j2k sequence
• DE jacosub JACOsub subtitle format
• D jpeg_pipe piped jpeg sequence
• D jpegls_pipe piped jpegls sequence
• D jv Bitmap Brothers JV
• DE latm LOAS/LATM
• D live_flv live RTMP FLV (Flash Video)
• D lmlm4 raw lmlm4
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• D loas LOAS AudioSyncStream
• DE lrc LRC lyrics
• D lvf LVF
• D lxf VR native stream (LXF)
• DE m4v raw MPEG-4 video
• E matroska Matroska
• D matroska,webm Matroska / WebM
• E md5 MD5 testing
• D mgsts Metal Gear Solid: The Twin Snakes
• DE microdvd MicroDVD subtitle format
• DE mjpeg raw MJPEG video
• E mkvtimestamp_v2 extract pts as timecode v2 format, as defined by mkvtoolnix
• DE mlp raw MLP
• D mlv Magic Lantern Video (MLV)
• D mm American Laser Games MM
• DE mmf Yamaha SMAF
• E mov QuickTime / MOV
• D mov,mp4,m4a,3gp,3g2,mj2 QuickTime / MOV
• E mp2 MP2 (MPEG audio layer 2)
• DE mp3 MP3 (MPEG audio layer 3)
• E mp4 MP4 (MPEG-4 Part 14)
• D mpc Musepack
• D mpc8 Musepack SV8
• DE mpeg MPEG-1 Systems / MPEG program stream
• E mpeg1video raw MPEG-1 video
• E mpeg2video raw MPEG-2 video
• DE mpegts MPEG-TS (MPEG-2 Transport Stream)
• D mpegtsraw raw MPEG-TS (MPEG-2 Transport Stream)
• D mpegvideo raw MPEG video
• DE mpjpeg MIME multipart JPEG
• D mpl2 MPL2 subtitles
• D mpsub MPlayer subtitles
• D msnwctcp MSN TCP Webcam stream
• D mtv MTV
• DE mulaw PCM mu-law
• D mv Silicon Graphics Movie
• D mvi Motion Pixels MVI
• DE mxf MXF (Material eXchange Format)
• E mxf_d10 MXF (Material eXchange Format) D-10 Mapping
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• E mxf_opatom MXF (Material eXchange Format) Operational Pattern Atom
• D mxg MxPEG clip
• D nc NC camera feed
• D nistsphere NIST SPeech HEader REsources
• D nsv Nullsoft Streaming Video
• E null raw null video
• DE nut NUT
• D nuv NuppelVideo
• E oga Ogg Audio
• DE ogg Ogg
• DE oma Sony OpenMG audio
• E opus Ogg Opus
• D paf Amazing Studio Packed Animation File
• D pictor_pipe piped pictor sequence
• D pjs PJS (Phoenix Japanimation Society) subtitles
• D pmp Playstation Portable PMP
• D png_pipe piped png sequence
• E psp PSP MP4 (MPEG-4 Part 14)
• D psxstr Sony Playstation STR
• D pva TechnoTrend PVA
• D pvf PVF (Portable Voice Format)
• D qcp QCP
• D qdraw_pipe piped qdraw sequence
• D r3d REDCODE R3D
• DE rawvideo raw video
• D realtext RealText subtitle format
• D redspark RedSpark
• D rl2 RL2
• DE rm RealMedia
• DE roq raw id RoQ
• D rpl RPL / ARMovie
• D rsd GameCube RSD
• DE rso Lego Mindstorms RSO
• DE rtp RTP output
• E rtp_mpegts RTP/mpegts output format
• DE rtsp RTSP output
• DE s16be PCM signed 16-bit big-endian
• DE s16le PCM signed 16-bit little-endian
• DE s24be PCM signed 24-bit big-endian
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• DE s24le PCM signed 24-bit little-endian
• DE s32be PCM signed 32-bit big-endian
• DE s32le PCM signed 32-bit little-endian
• DE s8 PCM signed 8-bit
• D sami SAMI subtitle format
• DE sap SAP output
• D sbg SBaGen binaural beats script
• D sdp SDP
• D sdr2 SDR2
• E segment segment
• D sgi_pipe piped sgi sequence
• D shn raw Shorten
• D siff Beam Software SIFF
• E singlejpeg JPEG single image
• D sln Asterisk raw pcm
• DE smjpeg Loki SDL MJPEG
• D smk Smacker
• E smoothstreaming Smooth Streaming Muxer
• D smush LucasArts Smush
• D sol Sierra SOL
• DE sox SoX native
• DE spdif IEC 61937 (used on S/PDIF – IEC958)
• E spx Ogg Speex
• DE srt SubRip subtitle
• D stl Spruce subtitle format
• E stream_segment,ssegment streaming segment muxer
• D subviewer SubViewer subtitle format
• D subviewer1 SubViewer v1 subtitle format
• D sunrast_pipe piped sunrast sequence
• D sup raw HDMV Presentation Graphic Stream subtitles
• E svcd MPEG-2 PS (SVCD)
• DE swf SWF (ShockWave Flash)
• D tak raw TAK
• D tedcaptions TED Talks captions
• E tee Multiple muxer tee
• D thp THP
• D tiertexseq Tiertex Limited SEQ
• D tiff_pipe piped tiff sequence
• D tmv 8088flex TMV
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• DE truehd raw TrueHD
• D tta TTA (True Audio)
• D tty Tele-typewriter
• D txd Renderware TeXture Dictionary
• DE u16be PCM unsigned 16-bit big-endian
• DE u16le PCM unsigned 16-bit little-endian
• DE u24be PCM unsigned 24-bit big-endian
• DE u24le PCM unsigned 24-bit little-endian
• DE u32be PCM unsigned 32-bit big-endian
• DE u32le PCM unsigned 32-bit little-endian
• DE u8 PCM unsigned 8-bit
• E uncodedframecrc uncoded framecrc testing
• DE vc1 raw VC-1 video
• DE vc1test VC-1 test bitstream
• E vcd MPEG-1 Systems / MPEG program stream (VCD)
• D vivo Vivo
• D vmd Sierra VMD
• E vob MPEG-2 PS (VOB)
• D vobsub VobSub subtitle format
• DE voc Creative Voice
• D vplayer VPlayer subtitles
• D vqf Nippon Telegraph and Telephone Corporation (NTT) TwinVQ
• DE w64 Sony Wave64
• DE wav WAV / WAVE (Waveform Audio)
• D wc3movie Wing Commander III movie
• E webm WebM
• E webm_chunk WebM Chunk Muxer
• DE webm_dash_manifest WebM DASH Manifest
• E webp WebP
• D webp_pipe piped webp sequence
• DE webvtt WebVTT subtitle
• D wsaud Westwood Studios audio
• D wsvqa Westwood Studios VQA
• DE wtv Windows Television (WTV)
• DE wv raw WavPack
• D xa Maxis XA
• D xbin eXtended BINary text (XBIN)
• D xmv Microsoft XMV
• D xwma Microsoft xWMA
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• D yop Psygnosis YOP
• DE yuv4mpegpipe YUV4MPEG pipe
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Preferences
Your Mixbus preferences are stored in 2 places:

Session->Properties

• This stores the preferences for the current session
• For more details see Session Properties Window

Edit->Preferences ( or Mixbus->Preferences on Mac OSX )

• This stores your global preferences which are applicable ALL sessions
• For more details, see Preferences Window

Preferences file location, and clearing the preferences:
Mixbus preferences are stored in the Mixbus preference folder. The location of the folder varies with each
OS ( Mac, Windows, or Linux )

You can clear your preferences by deleting a single file or the entire Mixbus preferences folder. If Mixbus
cannot find a preferences folder or file, it will create a new one with default contents. More details about the
Preferences folder can be found in Power-User Topics
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External Control

Mixbus can respond to external controllers using 4 different
protocols:

Generic MIDI ( also called “MIDI Learn” )

Mixbus can accept MIDI control-messages from any MIDI-enabled device that sends CC (continuous
controller) or NRPN messages. Many MIDI keyboards include MIDI controller knobs and switches that can
be bound to Mixbus mixer-strip controls or transport controls.

Mixbus can use controls directly by using “MIDI Learn”. With this method, you tell Mixbus exactly what
control you want to adjust on-screen, and then you turn your physical controller to “assign” it to that knob.

Alternatively, you can use a pre-defined “Binding map” which preconfigures your device’s controls to work
with Mixbus. You can choose from a predefined list, or you can create your own binding file, and share it
with other Mixbus users.

Mackie Control

The “Mackie Control” protocol allows controllers with motorized faders (typically 8 or more) to control the
Mixbus mixer.

Presonus Faderport

The Presonus Faderport is an inexpensive controller with 1 motorized fader, one knob, and several buttons.
Mixbus provides a dedicated control mode for the Faderport.

OSC control

OSC ( Open Sound Control ) is a network protocol that allows you to control Mixbus from an ethernet-
connected controller.
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MIDI Control Surfaces
Generic MIDI Control

Mixbus can respond to MIDI control messages such as transport control, knobs, sliders and switches.

MIDI remote-control protocols are largely developed by the Ardour open-source community, and you can
find documentation on the Ardour website.

Mixbus uses 2 different mechanisms for MIDI control surfaces:

• MIDI Learn: http://manual.ardour.org/using-control-surfaces/midi-learn/
• MIDI Binding Maps: http://manual.ardour.org/using-control-surfaces/midi-binding-maps/
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Mackie MCU-compatible fader controllers

Mixbus supports fader controllers that use the Mackie “MCU” protocol

To use a Mackie control device, you must follow these steps:

1. Consult the device’s manual, and configure the device for “Mackie Control” protocol ( not HUI )
2. Open Preferences->Control Surfaces, and click the checkbox to enable “Mackie”
3. Double-click the Mackie line to open the configuration panel.
4. Choose your device, or the closest equivalent, from the “Device Type” list
5. Choose the MIDI input and output ports for the device

…. after step 5, the faders should immediately jump to their correct position.

Because the capabilities of fader controllers vary widely, you may find that some buttons don’t exist, or don’t
work as expected, on your device. The documentation below applies to the original Mackie MCU, and very-
similar devices such as the Behringer X-Touch.

Encoder Assign Buttons:

The Encoder Assign buttons define what the knobs above each fader do.

• Track: To use the Track controls, you must first “select” a channel using a channel Select button. The
8 knobs will switch to show the channel’s Input trim, solo isolate, solo lock, and polarity switches.

• Pan/Surround: This is the default setting. When this is selected, each channel’s knob will control its
pan. Clicking the knob will toggle the master bus assign on/off.
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• EQ: To use the EQ controls, you must first “select” a channel using a channel Select button. The 8
knobs will switch to show the selected channel’s EQ settings (this varies for channels vs mixbuses vs
master bus )

• Send: To use the Send controls, you must first “select” a channel using a channel Select button. The
8 knobs will switch to show the channel’s mixbus send levels. You can adjust the send level with a
knob, or click the send to enable/disable it. You may also click the “Flip” button to control the mixbus
send levels from the fader.

• Plug-In: this feature is currently unimplemented.
• Inst: For Mixbus, “Inst” is used to control the channel compressor. To use the Compressor controls,

you must first “select” a channel using a channel Select button. The 8 knobs will switch to show the
selected channel’s compressor settings.

Global View Buttons:

The Global View buttons select which subset of available channels will be visible on the fader surface.

• Global View : this resets the view to showing channels in sequential order, with the first available
mixer channel on the far left of the surface.

• MIDI Tracks: this shows only the MIDI (instrument) tracks on the surface. Audio tracks and buses will
be skipped over, if you adjust the Channel or Bank buttons.

• Inputs: This shows “buses” that were created with the New Track dialog. Buses are often used as live
inputs to the mixer. MIDI tracks, audio tracks, and mixbuses will be skipped over, if you adjust the
Channel or Bank buttons.

• Audio Tracks: this shows only the Audio tracks on the control surfaces. Midi tracks and buses will be
skipped over, if you adjust the Channel or Bank buttons.

• Audio Inst: This operates the same as MIDI Tracks button.
• Aux: This operates the same as the Inputs button.
• Buses: This shows the mix buses.
• Outputs: Currently unimplemented; this will show the Click (metronome), Auditioner (solo bus), and

Monitor buses in the future.
• User: This shows the first 8 channels that are “selected” in the mixer GUI. This allows you to select a

discontiguous collection of channels, and control them side-by-side on the control surface.

The EQ, Send, and Dyn (“Inst”) modes will follow the selected channel. Selecting EQ mode,
and then selecting a different channel, will continue to show the EQ knobs, but for the new
channel. This is a very nice way to advance through your channels and adjust each
channels EQ, in turn.

!
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Function Buttons:

The 8 Function buttons can be assigned any “action” ( keyboard shortcut ) in the Macke setup dialog.

Modify:

The Modify buttons are used, similar to modifiers on your keyboard, to add additional features to the Mackie
protocols. For example, Shift+Undo is “Redo”. Note that the Mackie modifier keys do NOT affect what you
are doing with the keyboard/mouse. The “Shift” key is largely used for default functions. The “Control,
Command, and Alt” buttons are reserved for users to assign their own actions.

Automation:

The Automation buttons apply to the selected track’s fader. The “Group” button currently turns automation
OFF. “Latch”, and “Trim” are currently disabled, but these features will be added in the future.

Utility:

• Save: Saves the currently-opened session snapshot
• Undo: un-does the most recent editor operation (such as a recording). Shift+Undo to “redo”.
• Cancel: Deselects all tracks and objects.
• Enter: Selects all tracks.

Transport:

• Marker: Creates a new marker. Shift+Marker deletes the marker (if one is currently under the
playhead). Marker+ffwd = next marker; Marker+rewd = last marker

• Nudge: Combined with the ffwd/rewind buttons, this will nudge the playhead forward or back.
• Cycle: This initiates a “loop” playback between the Loop markers, if you are currently playing.

Shift+cycle = use currently selected range as the Loop range.
• Drop: sometimes called “Mark In”: This uses the current playhead location to set the selection start

time. Shift+Drop = Toggle Punch IN.
• Replace: sometimes called “Mark Out”: This uses the current playhead location to set the selection

end time. Shift+Replace = Toggle Punch OUT.
• Click: this toggles the Click (metronome) on and off. Shift+Click = Set Punch range to current range

selection.
• Solo: This clears any track solo’s that are currently engaged. Shift+Solo =
• Fader Bank: this advances the faders by 8
• Channel: this advances the channels by 1
• Scrub: currently no function is assigned to this button.
• Zoom: this modifies the directional arrows and Jog Wheel to “zoom” rather than move the view.
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• Directional arrows: the directional arrows move the editor view. If the Zoom button is engaged, they
zoom the x and y axes.

• Jog Wheel: adjusting the wheel will move the playhead. If the “Zoom” button is engaged, then the
wheel zooms in&out on the timeline

The Mackie MCU protocol support is largely developed by the Ardour open-source community. To learn
more about fader controllers using the Mackie MCU protocol, please visit the Ardour manual pages:
http://manual.ardour.org/using-control-surfaces/devices-using-mackielogic-control-protocol/

The Mackie remote-control protocol talks to the Mixbus session directly, and isn’t directly
related to what you see on the screen. However it does follow the order of tracks in the
mixer page, and it does not show “hidden” tracks.
*

Mixbus does not currently support the older Mackie “HUI” protocol. Many devices provide
the “HUI” protocol because it is the only 3rd-party protocol that can be used with ProTools.
However, the HUI protocol is very limited. Nearly every device implements the newer
“Mackie Control” protocol, which provides higher-resolution faders, more buttons, and other
benefits. Mixbus uses this better protocol to talk with your device. Check your device to see
which modes it provides.

*

Harrison Consoles Mixbus v3 - 1

Page 345 of 420

http://manual.ardour.org/using-control-surfaces/devices-using-mackielogic-control-protocol/


Faderport

Presonus Faderport

The Presonus Faderport is a one-channel controller with a single touch-sensitive motorized fader, pan knob,
and transport controls. Mixbus has a special mode for the FaderPort which provides dedicated features for
this hardware.

Remote-control protocols are largely developed by the Ardour open-source community, and you can find
documentation about the FaderPort on the Ardour website: http://manual.ardour.org/using-control-surfaces/
Presonus_FaderPort/
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OSC Control

The OSC protocol can be used to remotely control Mixbus via Ethernet.

OSC Control provides the ability to initiate any “action” (i.e. anything that can be activated by a keybinding),
as well as direct access to editor, track and bus settings. OSC can be used to “script” events in Mixbus
using an external scripting platform. A complete description of OSC is beyond the scope of this manual.

Mixbus’s OSC implementation is largely developed by the Ardour open-source community. For more
technical details, visit the Ardour manual page on this subject: http://manual.ardour.org/using-control-
surfaces/controlling-ardour-with-osc/

You do not need TouchOSC bridge on any platform.
TouchOSC (with the Mixbus layout ) can talk directly to Mixbus.

TouchOSC layout files:
The zipfile contains 2 files. One is tablet-sized, and the other is more suitable for phones. It is available
here:

http://www.harrisonconsoles.com/mixbus/touchosc/Harrison_Mixbus_TouchOSC.zip

In the future, the TouchOSC developer is going to include these layouts in the default installation package.

For now, you must take these steps to load these templates into your tablet or phone:

1. Purchase the TouchOSC application from your phone/tablet App Store. ( Android and iOS are
supported, but not Windows phones )

2. Also download the TouchOSC editor to your Desktop computer.
3. Launch the TouchOSC editor, and “Open” one of the layout files.
4. In the editor, click “Sync”
5. In the TouchOSC application, click Layout/Add/From Editor
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6. You should see you computer name appear in the “Found Hosts” list

Then, to setup and use your controller, watch the video above. The video may also be found on The
Harrison Mixbus YouTube Channel.

The following is a summary of the features that are available:
Sending this message will trigger the associated keybinding “action” in Mixbus:

• /ardour/access_action (s)

These predefined “global” messages may be triggered by OSC:

• /routes/list
• /ardour/add_marker
• /ardour/loop_toggle
• /ardour/goto_start
• /ardour/goto_end
• /ardour/rewind
• /ardour/ffwd
• /ardour/transport_stop
• /ardour/transport_play
• /ardour/transport_frame
• /ardour/set_transport_speed (f)
• /ardour/locate (ii)
• /ardour/save_state
• /ardour/prev_marker
• /ardour/next_marker
• /ardour/undo
• /ardour/redo
• /ardour/toggle_punch_in
• /ardour/toggle_punch_out
• /ardour/rec_enable_toggle
• /ardour/toggle_all_rec_enables

These “route-specific” messages may be triggered by OSC. In each case, the first integer indicates the
route (channel) index:

Harrison Consoles Mixbus v3 - 1

Page 348 of 420



• /ardour/routes/mute (ii)
• /ardour/routes/solo (ii)
• /ardour/routes/recenable (ii)
• /ardour/routes/gainabs (if)
• /ardour/routes/gaindB (if)
• /ardour/routes/pan_stereo_position (if)
• /ardour/routes/pan_stereo_width (if)
• /ardour/routes/plugin/parameter (iiif)
• /ardour/routes/plugin/parameter/print (iii)
• /ardour/routes/send/gainabs (iif)
• /ardour/routes/send/gaindB (iif)

Note: required arguments for each action are in the form at “i” (integer) “f” (float) and “s” (string)
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Transport and Timecode Sync
Mixbus can respond to external timecode control ( via MMC or OSC ) or timecode sync ( via MTC or
LTC/SMPTE audio )

External Sync is initiated with the “Internal/External” sync button, to the right of the transport buttons on the
editor.

Synchronization sources and options are set in the Preferences Window

Also see External Synchronization

Mixbus’s transport and timecode sync functions are largely developed by the Ardour open-source
community. For more details, see the applicable chapters in the Ardour manual:

• http://manual.ardour.org/synchronization/timecode-generators-and-slaves/
• http://manual.ardour.org/synchronization/overview-of-timecode-related-settings/
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Included Plug-ins
Mixbus is provided with several plug-ins:

Harrison “Essentials” plug-in bundle

• Dyno-Mite ( free; fully operable )
• GVerb+ ( unlicensed demo * )
• 3D Delay ( unlicensed demo * )
• Micro-Glide ( unlicensed demo * )

Harrison XT plugins

• XT-EQ ( unlicensed demo * )
• XT-ME ( unlicensed demo * )
• XT-MC ( unlicensed demo * )
• XT-BC ( unlicensed demo * )
• XT-VC ( unlicensed demo * )
• XT-DC ( unlicensed demo * )
• XT-DS ( unlicensed demo * )
• XT-EG ( unlicensed demo * )
• XT-LC ( unlicensed demo * )
• XT-TG ( unlicensed demo * )
• XT-SC ( unlicensed demo * )

*These Harrison plug-ins are fully operable without being licensed. This allows you to evaluate their
performance, and share your sessions with other Mixbus users who have not yet purchased the plugins. An
unlicensed Harrison plugin will fade to black when the control panel is opened, and will not respond to
mouse clicks after a few seconds. To enable the control panel, please purchase a license for the plugin at
http://harrisonconsoles.com/site/store-mixbus-plugins.html

Others

X42 Metering suite ( unlicensed demo )
X42 ×42-EQ ( unlicensed demo )
X42 SetBfree modeled tonewheel organ ( free, full-functioning )
X42 MIDI filter plug-ins ( free, full-functioning )
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Please Note. This list is subject to change at any time without notice or obligation by
Harrison Consoles.

!
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Power-User Topics

Session folder layout

Navigating to a session folder will display a series of files and folders:

• instant.xml : this file stores the most recently-used mouse mode, playhead location, and other
transitory information.

• {snapshot name}.ardour : each of these files represents a Snapshot, which stores all of the edits,
settings, and properties of a session.

• {snapshot name}.bak : backup files are occasionally generated for each snapshot
• {snapshot name}.pending : pending files snapshots that get created when an audio recording is

initiated. this allows us to recover audio data, even in the event of a crash or power outage. If a
pending file is found when Mixbus is re-launched, you will see the Crash Recovery dialog, and you
can choose to ignore or recover any lost information that was saved to the pending file.
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• {snapshot name}.history : every snapshot file has a “history” file. The history file saves the UNDO
history for that snapshot.

• analysis: This folder contains data relevant to any audio files that Mixbus has analyzed for transient-
detection and note-detection. By storing this information, Mixbus doesn’t have to re-analyze audio
when you initiate one of these functions.

• dead: This folder serves as a waste basket for unused audio. Menu>Session>Clean-up>Flush
Wastebasket: will delete audio files located in this folder. Click here for more

• export: This is the default location for exported files. Click here for more.
• externals: This folder contains a list of external files that are used in the session, but were not copied

into the session
• interchange: This folder contains imported audio, recorded audio, and MIDI files.
• peaks: Contains waveform images for display in the editor. It is safe to delete the contents of this

folder, and Mixbus will create new data when the session is re-opened.
• plug-ins: Contains plug-in settings. Some plugins (such as impulse-response based reverbs) need to

store more information than is practical in the session XML file. The extra plugin data is stored here.

Session XML file format
Mixbus session files use the industry-standard “Ardour” session file format. These files are plain human-
readable XML. Other workstations that use this format include Ardour and Waves Tracks Live.

A detailed description of the session format is beyond the scope of this manual, but here is an overview of a
session file hierarchy:

• : defines the Session Properties that were chosen for this session.
• : the metadata information for the session ( personnel details, etc )
• : a list of the audio and MIDI files that are used in this session
• : a list of the regions (segments of an audio or MIDI file) used in the session
• : a list of playlists that are used in the session. A playlist is a sequence of regions, and their specific

settings (trim, fade, etc)
• : a list of locations (markers, cd markers, region markers, loop/punch markers) that are used in the

session
• : a list of bundles ( a bundle is a group of input (or output) ports that are associated, such as the 2

inputs of a stereo track )
• : a list of “routes” ( tracks and buses ) that are used in the session. A Route has many sub-fields:

• Currently selected playlist
• Channelstrip fader, EQ, compressor, and pan settings
• Plugins used in this route
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Mixbus Preferences folder
The Mixbus “preferences” folder stores all of a user’s preferences, as shown in the Preferences dialog.

The preferences folder location varies with each OS, but it is always found inside the HOME (“~”) folder:

• Mac OS X: ~/Library/Preferences/Mixbus3
• Windows: ~/AppData/Local/Mixbus3
• Linux: ~/.config/mixbus3

Inside the Preferences folder, you will find a list of files and folders:

• config : this file stores your user preferences
• instant.xml : this stores transitory information such as the last playhead location and window locations
• bindings file : this file stores your customized keybindings
• recent : this file stores the list of recently-opened sessions that is presented to you when you launch

Mixbus
• sfdb : this folder stores your metadata-info for any audio files that you’ve tagged in the Import dialog
• my-dark.colors : this file stores your personal Theme colors for the Dark theme. (Light theme is not

yet implemented)
• plug-in cache ( VST and/or AU ) : this folder stores a list of plugins that have been identified on your

computer. If you delete this folder or its contents, you will have to re-scan your plugins.

If you delete any of these files or folders, Mixbus will recreate a new file with default settings
when it is re-launched.*
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Appendix A: Known Issues

All Platforms:
• Some third-party plug-ins may cause crashes, strange noises, or other problems. We strive to support

plug-ins as thoroughly as possible but due to the many variables (Computer platform, OS version,
Mixbus version, plug-in version, licensing mechanisms, etc.) it is not possible to guarantee that all
3rd-party plug-ins will work as expected on your system.

• On systems with the minimum supported screen height (800 pixels), you may not be able to fit the
editor or mixer window on your screen. You can visit Preferences->UI and disable some of the mixer-
strip features, to save some height. Another option is to (minimize / auto-hide / move to the side) your
desktop’s Taskbar/Dock/launch bar to maximize screen height.

For more details, contact Harrison via email (mixbus@harrisonconsoles.com).
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Appendix B: Release Notes

Mixbus 3.0
Initial Release.

Mixbus Version 3.0 to 3.1 Version Updates

Release version 3.1 Includes:

3 types of control surface support: for Mixbus faders, eq, compressor, bus sends, and other features

• Generic MIDI controllers. A selection of pre-configured devices are provided, with more to come.
• Motorized fader controllers, like the Mackie MCU, Presonus Faderport, and Behringer X-Touch

controllers.
• OSC protocol supports ethernet-based (Wi-Fi) tablet controllers such as TouchOSC and Lemur for

iOS and Android.

User Interface Customization:

Stop trying to automatically scale the mixer strips. Warn the user if the scale doesn’t match their monitor,
but allow the user to ignore the warning if they wish.
Add 140% strip scale, for those users with very large monitors.
Trigger small LEDs whenever scale is less than 100%. This avoids the issue where the LED size varies in a
strip due to variations in individual button sizes.
Mixer mutes and solos now work just like the editor: middle-click for momentary operation; right-click mute &
solo menus; ctrl+shift+click ( mute/solo all )

Favorite Plugins Sidebar:

Drag/drop plugins between the Favorites bar and track/buses.
Allow creating plugin-presets by dragging a plugin to the sidebar.
Allow to add a plugin or preset to all selected routes (double-click).
Save/restore custom order of favorite plugin list.
Manage favorites and delete presets from the sidebar’s right-click context menu.
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Monitor Section Improvements:

Monitoring section reduced to 75% original width
Allow showing/hiding the Monitor Section ( See new “Mon” button on the master bus)
Allow Plugins in the Monitor Section (for room eq/correction – does not affect the master bus)
Fix monitor-section state restore (per channel solo/mute/dim/inv)
Change visible name from “Fader” to “Monitor Processor”

Build version 3.0.3164 included:

MIDI:

Fix overlapping note resolution (see issue #177)
Remove shortening inserted notes by one tick
Add midi-track mute automation

Control Surfaces

(NOTE: Control surface features should be considered “experimental until the official 3.1 release)

OSC:

New OSC commands to support TouchOSC and Lemur (these apps always send float args, whether you
want/need them or not. We’ve added redundant commands so TouchOSC and Lemur can trigger events)

Mackie:

Allow basic access to channelstrip EQ and compression
Lots of basic functionality improvement ( entering & leaving different modes ), but still lots more to do.

Known issues:
On Mac w/XTouch(?), fader automation playback is very coarse.
The “Master” fader position isn’t being updated when the session loads, but after moving it once, it works
fine.

Faderport:

Off button is never lit, because this tells the Faderport to disable the fader entirely.
Fixed fader so it moves during automation playback.
Fixed Trim control range
Fixed “Shift” behavior so it is easier to hold shift & navigate the markers
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Known issues:
disabling and immediately re-enabling the Faderport control protocol will cause a crash.

Miscellaneous Improvements:

Updated German, Russian & Chinese translations
Fixed some window titles ( some said “gui” instead of Mixbus )
“Backspace” key was not working in the mixer window to delete plugins. This is fixed.
Default the value of the save-snapshot entry with current snapshot name
Video file playback: Use video-duration from the container if stream duration is n/a
Fix possibly stuck mute/solo buttons (context menu)
Disable threaded waveview rendering. ( fixes some crashes during startup, but will slow down rendering
slightly, for now )
Explicitly disallow looping when External-sync is engaged
Fix a problem with LV2 plugin UI updates when the plugin does not have output control ports
Use LV2 port symbols, not index, when plugin version changes. ( fixes bugs with Calf plugins on linux,
maybe others )

Session Settings:

Mixbus EQs were using the wrong frequencies at sample rates other than 44k. This has been fixed.
In the case where a session has multiple sub-folders for Audio or MIDI files, open a Finder/Explorer/File-
manager to help the user resolve the ambiguity.
Save/restore plugin state with track-templates.
Properly copy plugin state when Duplicating a track.

Crash Fixes:

Fix a potential crash when discovering control surface libraries.
Fix a potential crash when removing track.
Fix some shutdown crashes, especially for control surface users.
Fix a crash when scroll-wheeling past the bottom of fader travel.

Mac OS X:

Keep AU cache in cache-dir
Re-add AU cache/blacklist management controls to the Preferences->Plugins tab

Windows:

Harrison Consoles Mixbus v3 - 1

Page 359 of 420



Ship both blocking and callback PA backends (for debug purposes)
Keep VST path editor on top of preferences.

Linux:

Uninstall all icon files (linux)
Install 256px icon file (hi-dpi)
LinuxVST window re-sizing: forward event to child window.

Build version 3.0.2872 included:

New features:

Enable remote-control surfaces:

Generic Midi Control: MIDI Learn ( assign MIDI controllers directly to on-screen knobs )
Generic Midi Control: MIDI Profiles ( pre-configured settings for popular MIDI controllers )
Mackie protocols ( for motorized fader-controllers using the Mackie Control protocol )
Presonus Faderport ( dedicated support for this popular device )
OSC ( remote control over ethernet, see TouchOSC - http://hexler.net/software/touchosc )
“Duplicate” track – creates a copy of an existing track:
The copy includes all channelstrip settings, plugins, I/O connections, etc
Optionally copy the playlist of the source track, or even share the same playlist as the source.
New filters on the plugin manager help you see only the types of plugins you want to see.

General improvements:

When a new plugin is added, immediately show the plugin’s GUI ( you can disable this in Preferences-
>Plugins )
Allow renaming of the top-level session folder:
In the past, the top-level session folder name had special significance; it defined the name of the primary
snapshot and the enclosed “interchange” folder with audio and MIDI files. This is no longer the case.
Double-clicking a recent session will now open the last-used snapshot
This solves a problem where renaming the top level folder would report that audio and midi files are
missing.
Allow hiding/showing the mixer-list.
Improved responsiveness of some Harrison plugin GUIs.
Allow user to overwrite existing template sessions. ( prompt before overwriting )
Various speedups and improvements to waveform drawing.
Dramatically speed-up session shutdown when the session has lots of regions.
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Provide user-control over pre roll amount. ( see Preferences->Transport )
Double-clicking the channelstrip compressor threshold should now default to 0, not +1dB.
Updated French, Russian & German translations.
Save & recall “insert” latency setting.
Mixbus assign buttons are slightly brighter. ( more improvements coming here in the future )
Improved the layout of some Preferences panels, including MIDI, Control Surfaces, and Plugins panels.
Fixed seamless looping of audio and MIDI.
…plus hundreds of small bug-fixes and user-suggested improvements

OS X:

AU factory presets were not appearing in the preset menu; this has been fixed.
Prevent some AudioUnit UIs (Addictive Drums) from monopolizing the CPU
Fix some plugins ( like newest Waves ) on latest Mac versions.
Allow users to directly open sessions by double-clicking in the Finder.

Windows:

Improved performance of ASIO audio I/O ( use a callback instead of blocking I/O )
Provide ASIO buffer size selection when the interface supports it
Fix automatic latency compensation for ASIO I/O, if the device reports it.
Fix issues when importing many files.
Updated multi-core support for 64bit Windows. A few users had to select “one processor” to avoid glitches,
even though they had multiple cores available. This might allow some users to utilize multi-core DSP
processing.
Fix occasional crash at shutdown.

Linux:

New option to configure period size (improve performance of USB devices)
Allow latency-calibration without restarting the backend (ALSA) … this helps with USB devices whose
latency changes with each start/stop.

Build version 3.0.2257 for PC & Linux and 3.0.2279 for MAC included:

Windows-specific fixes:

Fixed session loading for VST plugins that store lots of settings data (such as Bliss sampler)
When scanning VST plugins, make a note in the log if the DLL is 32bit or 64bit (this helps with
troubleshooting)
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General fixes:

Fix audible “glitches” when automating the channelstrip pan knob
Fix plugin latency calculation so it works when locating or looping; not just with an explicit stop/play
Fix “playhead-to-next-transient” ( i.e. Tab-to-Transient ) feature. This feature wasn’t working.
Fix “select all {before,after} edit point”. This feature wasn’t working.
Various “solo” fixes ( grouped solos, mixbus solos, stuck solos, “Clear Solos”, etc )
Various locale (non-English language) fixes
Fix looped audio recording (make sure to capture all of the region from the last-completed loop)
Enlarge the channelstrip indicator lights with small mixer-strip scale (makes indicators more visible on small
monitors)
Backup sessions are saved with the “.ardour” extension so they are recognized as snapshots without being
renamed
Various improvements to the Audio Engine dialog, and more meaningful error reports when the audio
engine fails to start
Louder ‘click’ (metronome) sound
Disable “Strip Silence” and “Rhythm Ferret” for midi regions.
Fix problem when importing tracks called “Click” or “Monitor” which conflicted with the internal Click &
Monitor channels.
On a new session, only show mixbuses 1-4. (problem introduced in #1970)
Fix a crash when reordering tracks using the Ctrl+arrow method. (problem introduced in #1970)
Sort ports in the XML file. This allows version-tracking software to manage versions more cleanly (e.g.
session file in git).
Hiding and showing tracks could result in the wrong group “tab” displays. This has been fixed.
Track creation could fail if you previously made a new track and then immediately deleted it. This has been
fixed.

… and 300 minor issues

Build version 3.0.1970 included:

Windows-specific fixes:

Fixed VST “PinConnected” feature; this fixes Plugin Alliance and probably other plugins that weren’t
processing audio.
Improved the accuracy of DSP% calculation by catching short “peaks” caused by operating-system latency
(readings will be higher than before)

Mac OS X-specific fixes:
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Fixed AudioUnit port counting – this fixes a crash bug in NI Reaktor5, and probably others
Solved a problem with non-english accented characters which would cause following tracks and buses to be
invisible.

General fixes:

Fixed a crash when reordering tracks that was introduced in interim 1610
Tweaked scroll-wheel sensitivity for channelstrip knobs
Added columns for audio file format and date to the Recent Sessions list
Allow snapshots to display update time, and be sorted by date
When moving a region up/down in layers, the change was not immediately audible; this has been fixed.
Several fixes and improvements to “Silence detection”
Tweaked some Group-creation and group management UI elements to be more consistent.
Tweaked the Import and Audio Setup dialog to avoid ambiguous “OK” buttons
Prevent “deactivate all” from affecting the channelstrip EQ and compressor; this fixes a problem where
compressor gain redux is stuck showing “all red” and does not work.
Several fixes for copy/pasted midi-notes
Several fixes for re-rendering the waveform views in the background when they are missing or corrupted.
Fixed a problem where the mixer-strip hide/show checkboxes would steal keyboard focus from the mixer
window.
… and fixed approximately 100 smaller bugs that were reported by users.

Build version 3.0.1610 included:

Windows-specific fixes:

In the channelstrip’s “input” pulldown, audio input names could be truncated. This has been fixed.
“Select All” wasn’t working on some systems – this has been fixed.

General fixes:

Mixbus now makes it much clearer when a needed plugin is not installed on your system, and it keeps a
“placeholder” in the mixer strip which preserves all the settings, so you can replace the plugin later.
Show Mixbuses and Master in the normal Editor and Mixer side panels. This allows the user to change the
name more easily, and it displays the correct name in the list.
Fix undo/redo … undo/redo stack could get corrupted when a fade-length was changed.
On MIDI tracks, the Mixer-strip input button sometimes didn’t update to show the MIDI input when it was
changed; this has been fixed.
Fix a display problem when trying to show automation lanes for the mix- and master- buses.
Fix a bug in resampling, during import and file-auditioning, which could cause the file to be truncated.
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Updated Russian (from Alexandre Prokoudine) and German translations (from Edgar Aichinger)
… and fixed approximately 50 small crashing, freezing and minor bugs that were reported by users.

Build version 3.0.1508 included:

Windows-specific fixes:

Fixed various issues with non-latin names on Windows
Greatly improved Audio/Midi setup dialog
Greatly improved support for some ASIO devices ( less finicky when choosing sample rates )
New PortAudio backend can use MME and WASAPI devices directly ( removes the need for ASIO4ALL )
More fixes for VST scanning, with complete separation of 64/32 bit cache and blacklists
Fix audio buffering for VST plugins (fixes lack of output or phased output from a variety of VST plugins)
Take advantage of SSE and AVX processor extensions ( decreases DSP load, allows more tracks and
plugins )
Fixed file metadata tagging on Windows

Mac-specific fixes:

Fixed crash in Native instruments virtual instruments ( Kontakt and Reaktor )
Ensure that copied AU plugins retain settings of the original

Locale & language fixes:

Improved support for non-English accented characters

Build version 3.0.1268 included:

Windows-specific fixes:

Waves VST plugins: tentative fix for title of Waves “Shell” plugins
Fix for 32/64 parallel installs ( use separate cache and blacklist for 32/64 bit VST’s )
Allow verbose VST scanning, providing more details in the Log window.

Mac-specific fixes:

Fix right-click context menu crash ( for renaming mix-buses )
Rework AU scanning and discovery ( a failed scan will no longer prevent previously-scanned AUs from
working )
Fix SetBfree instrument when running on 32bit Mac OSX
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Fix “analyze” feature for AU plugins
Fix the localhost address on Mac OS X, enabling the video player
_
Linux-specific fixes:_

Fix various packaging errors, allowing 32bit Linux package to work on AVLInux and other 32bit distributions

Theme changes:

Provide user control over mixer strip scale ( see: Preferences->GUI )
Provide user control over mixer strip background color (see Theme -> gtk_background )
Provide user control over “mixer strip texture opacity”

Mixer signal-Flow and Plugin fixes:

Fix mix-bus and master-bus “input” metering selection
Fix for plugins with 3+ outputs: maintain 1-1 routing to the channel output
Prevent multiple concurrent plugin scans

Locale & language fixes:

Improved support for non-English accented characters in audio filenames
Fix for licensing file in non-English locales
Support for non-English characters in audio device names
By default, Mixbus now uses English language, even if your OS uses a different locale ( if desired, enable
translations in Preferences->User Interaction )

Video fixes:

Tweak video import dialog (handle non-video file extensions)
Add MXF file as a supported video format

Automation workflow fixes:

Clicking an automation track line without a move adds a point on the line.
Make automation line / gain line cursors consistent.
Automation selection fixes.
- display selected control points in region gain lines
- display selected points in internal edit mode
- allow dragging of region gain lines in Mouse Content mode
Fix a potential crash when dragging automation line.
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Single control points can now be dragged up and down properly.
- preserves the zero notch, but doesn’t mess up the cumulative drag.
Don’t add history by clicking a control point, fix control point selection.
Fix thinko in automation write undo.
- also allow saved automation list state to be touch or off if
actually in write mode.
Fix lack of tempo map undo in Editor::insert_time ()
Unbreak region brush drag wrt undo, avoid some dangling commands in the gui
- also allow moving of automation lines in internal mouse mode.
- this is also a first pass at ensuring that if an operation does
nothing, avoid an undo entry.
Add undo for automation touch & write passes.
Fix some workflow problems wrt automation.
- clearing automation points sets control to “off” rather than touch.
- multiple touches on the same pass acts consistently (no more
fader jumps on mouse button press
- use actual value for initial point rather than some arbitrary
default. clarify new semantics of add () (with_default->with_initial).
- add guard points as needed in stop.

Stability & Performance tweaks:

Fix auditioning on systems with larger disk read chunk sizes.
Fix pre-fader insert mute
Fix some problems when copy/pasting plugins
Improve performance and reduce jitter in “stationary playhead” mode.
Add context menu to hide/show all Midi-tracks
Fix various issues when deleting midi region during step-edit
Remove Track Templates menu item from mixbuses
Remove “bounce-with-processing” which is not supported in Mixbus
Implement scroll-wheel support for Click Boxes
Use “1” as small-step for integer controls.
Fix “Show waveform in regions” Preference.

A selection of notable changes in Mixbus v3.2 is listed
below:
New Features:
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• New: XT-DC Drum Character plugin added to the Character Bundle
• New: “Export Analysis” dialog may be displayed after an export The export analysis window provides

these features:

LUFS loudness measurement LU (Loudness Unit) histogram LU Range Waveform display, with
peak indicators Peak Sample value + True Peak value Spectrogram view These tools provide you
an extra level of confidence that your track sounds great and meets common deliverable
requirements for distribution and broadcast.

Windows:

Fixed some problems with Harrison LV2 plugin “license” text
PortAudio now combines both modes of PortAudio into a single selection. If your system worked best with
PortAudio (no callback), you will need to check the “Buffered I/O” button in the Audio setup window.
Fix hang at exit, after exporting, when using PortAudio nonblocking audio system
Fix OSC remote-control
Improve support for post – export command
Fill some more VST transport flags. (fixes some VST instruments/sequencer plugins that can be synced to
the Mixbus transport)
Prevent crash if VST does not implement effEditGetRect
Implement MIDI device enumeration and latency offset/calibration in portaudio backend

Mac OSX:

When closing a dialog, return focus to the main window; (fixes problems where Spacebar doesn’t work after
closing the Export dialog, for example)

General improvements and fixes:

New: Window > License manager: shows the status of Mixbus and LV2 plugins that use the new
specification (such as x42). Show the License Manager if session contains unlicensed Harrison (or x42) LV2
plugins
Improved the tap-tempo button accuracy … tap several times to get a more accurate bpm
Inline channelstrip plugin parameter sliders now implement “touch” so you can write touch automation from
those controls
Fixed the problem where MIDI bindings to a knob would stop working after you moved the GUI knob
Fix waveform flickering during recording
Allow user to remove the timespan name from the export-filename
“Collect Groups” feature was not doing anything. This is fixed.
Using “Esc” key closes several dialogs that it wasn’t working on before.
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Configurable export preroll : pre-process silence before export to flush reverb tails etc. (fixes reverb tails
from getting into the start of the export, if the associated plugin does not respond to flush)

..and about 100 other improvements and bug-fixes

Mixbus Version 3.2 to 3.3 Version Updates

Release version 3.3 Includes:

New Features:

Plugin pin connection management (see user manual video)

This feature dramatically improves control over the signal-flow in the channelstrip. It improves the default
plugin routing (so stereo VST’s can be used in a mono channel without causing the channel to switch to
stereo outputs). It also allows very flexible selection of sources to feed your plugin sidechain inputs. (note:
the sidechain-feed feature does not yet work on Mac AU plugins, but that feature will be added in an
upcoming update)

Improvements:

• Waveform-drawing is now multi-threaded. This will allow big sessions to open faster.
• Loudness report can now be done on any region & range in addition to the Export window
• Drag & Drop a plugin onto another of the same plugin to copy the plugin’s state (this also works for

the channelstrip EQ & Compressor)
• Never ever change sample-rate saved with the session after creation. A message dialog will appear if

you try to open a session while the soundcard is using the wrong rate.
• Track Rec-arm buttons now provide more contrast when a track is rec-armed
• Instrument list (in the New Track dialog) is now re-filled when plugins are scanned
• Replace some missing items in the region context menu that went missing
• Potential session-save speedup.
• Prevent deletion of last port using the PortMatrix.
• Updated Chinese translation
• Middle-click on location “clock” in sidebar locates to the given marker (since 2011)

Fixes:

• Likely fix for rare “right channel click” problem.
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• Fixed use of DIALOG/UTILITY window type hint on OS X. (likely fix for the problem where the *
Preferences window won’t display, on computers using the Deutsch locale)

• Don’t show plugin GUI when renaming tracks/busses
• Fixed a possible crash at session close.
• Fixed an error message when attempting to timestretch a region multiple times
• Fixed a bug which caused pasted gain automation to be different level than the copied source

…and approximately 50 other minor improvements and bug-fixes

A selection of notable changes in Mixbus v3.4 is listed
below:

New Features:

• Polarity Maximizer feature (YouTube video)
• XT-TG Tom-tom Gate with automation-write capability (Purchased Separately!)
• 2 new bundled x42 utility plugins (stereo-route and midi-map)
• Track Rec-Safe (prevent a track from arming by right-click on the track’s Record-enable, and

choosing rec-safe)

Improvements:

• MCU protocol now provides knobs for all 4 EQ bands, plus filters. Filters are provided on the “Inst”
button (along with the compressor parameters) (Mixbus32C only)

• Audio/midi files are now imported to “session start” by default (Too many users report they import
their first tracks and can’t find them)

• Create new track by dragging an instrument from the favorites sidebar
• Updated German and Russian translations
• Option for stereo-only meters (prevents a multi-output instrument from showing dozens of meters in

the track header)
• Removing multiple tracks is now a one confirmation step
• Adding new tracks (or opening a session with tracks) is now faster
• Rhythm Ferret improved with new modes and options
• Various transient-detection fixes (split region, trim, move, undo,..)
• Add option to auto-save post-export-analysis image
• Added additional metadata placeholders for post-export command
• Support for LV2 plugins that write their own automation lanes
• Add Open Target Folder button to Export Dialog
• Combined view of all plugins-pins for complete channel
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• Loudness normalization during export according to EBU/ITU standards
• Overhauled Region/Range spectrum analyzer: axis-labels, 1/octave weighting, Log-scale display
• Consistent Location GUI layout includes “GoTo” button
• Allow to replace instruments on a MIDI track
• Adding a multi-channel instrument displays a dialog to configure number of outputs
• Additional metadata placeholder for post-export command
• Highlight comment button if comments are present on a track * Plugin-Bypass bypasses the plugin(s)

not Processor. This leaves pin-connections in place. * Switching automation-mode to “touch” writes
the current value into the automation from session start to session end. This avoids the case where
enabling “touch” on an empty automation track could write the wrong value into automation.

• Consistent track+group show/hide column layout in the Mixer sidebar

Mac Fixes:

• Fixed the song position in some Mac AU plugins
• Clever trick to improve AU plugin drawing speed, on affected systems
• Significant reworking of AU plugin window, for plugin windows that can resize themselves
• Handle single-bus, non-variable I/O Audio Units w/multiple configurations (fixes some plugins and

instruments)

Windows Fixes:

• Fixed the song position in some Windows VST plugins
• Buffered-I/O setting is now stored and recalled correctly (special support for Roland Octacapture

device)

Linux Fixes:

• Fix uninstaller for variants (Mixbus32C vs Mixbus) to simplify parallel installation

General Fixes:

• Fixed a rare session corruption problem, caused by plugins that changed the locale while we were
saving (German, French and Danish locale, using comma as decimal separator)

• Adjusting a region’s gain with the Range and Draw tools would sometimes affect the region in the
track above. This has been fixed.

• Ensure that every channel has a fader processor, even if it is missing from the session file
• Fix MTC sync alignment (we now take MIDI latency into account)
• In the plugin redirect box, fix wire display for some unusual pin-connections
• Region Properties dialog could cause a hang. This has been fixed.
• Add support for accented characters in MIDI file paths
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• Import_Freesound tab is hidden while we update to the new Freesound search protocol
• Fix crash when re-loading a session while using the Mackie control surface
• Fix sends on track/bus templates
• Enable/Disable tooltips preference now works correctly
• Fixed display of busses/master on the Meterbridge window after session re-load
• Use strict-i/o on the monitor-section and ignore midi (fixes issues with some plugins when monitoring)
• Fix import/upsampling of multi-channel files
• Fix “clicks” when switching fader and trim automation from “manual” to “play” while transport is rolling

(always interpolate)

Release version 3.5 Includes:

New feature:

Realtime export : Normally, Mixbus maximizes your CPU to perform the fastest-possible export. However,
some users have external devices, such as rackmount analog gear or external MIDI synthesizers, which
cannot be used at faster-than-realtime speed. In the past, we required these users to manually create a
bounce track and mixdown to it, rather than using the normal Export features. Realtime Export provides all
the same features as a regular export, but it limits the engine to run in “real time” so external gear can be
utilized during the export. This new features is accessed from the “time span” tab in the Export dialog.

Improvements:

Harrison plugins now wait 30 seconds before the control panel is locked. This provides more time to
evaluate the plugins.
In the past, the “session end” marker would move automatically in certain situations. For example: when you
recorded past the “End” marker. This has been changed: once the user has grabbed and manually set the
“End” marker, it will no longer move automatically.
Improve the “spectrum analysis” window with better FFT resolution; and show the frequency under the
mouse’s location.
The area underneath an automation curve is now filled with color. This makes it easier to see automation
curves, and especially boolean automation (mutes, etc).
Various fixes to stem exporting: provide more consistent latency offsets on tracks that are exported as
stems.
Transport scrub-bar has been re-enabled: Click and drag inside the scrub-bar to scrub the timeline forward
and back at varying speed.

h3.OSX-specific fixes:
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AU sidechain fixes: plugin “pin connections” will show extra bus inputs even if they don’t flag themselves as
sidechain inputs.
SoundToys plugins would cause a stutter each time they checked the iLok license file. This has been
resolved ( in both Mixbus v3.5 and upcoming SoundToys release )
In the Keybindings editor window, trying to assign a keybinding with the “Cmd” key would fail. This has been
fixed.
Further improvements to AU plugin drawing speed. A problem occurs when both Mixbus and the plugin use
a specific Apple drawing function. This is a low-level drawing function, deep in the guts of OSX; and it has
been “broken” since v10.8. This function has caused problems for many applications, not just Mixbus.
Mixbus uses this function to draw the waveforms in the editor; some plugins also use this function; if both
the editor and the plugin use this function excessively, then Mixbus and/or the plugin will draw slowly. Some
solutions include: Zooming out on the timeline (so the playhead doesn’t have to update as often), hiding the
editor window while adjusting a plugin, or choosing a different plugin. The problem is noticeably worse on
“retina” displays. Dragging the editor and/or plugins to a different monitor might improve performance on
retina systems.

Mixbus v3.7 includes many user-requested improvements
and fixes, as well as 2 new plugins:
XT-SC Spectral Compressor:

The XT-SC is a powerful and easy-to-use multiband compressor which uses advanced DSP derived from
our large-format MPC5 film console.
Watch a video demonstrating the XT-SC features and sound: https://youtu.be/1z66QNt91vQ
Users may purchase a license for the XT-SC at our [URL=“http://sites.fastspring.com/harrisonconsoles/
product/plugin_xt_sc”]online store[/URL] for $159
Plugged-In Members (who were subscribed on or before Nov3) received the XT-SC free.

Micro-Glide:

Micro-Glide is an easy-to-use effect that adds width and depth to your vocals and instruments.
Watch a video of Micro-Glide in action: https://youtu.be/E8y0E929uOw
Micro-Glide is included in the Essentials Bundle. If you already own the Essentials Bundle for Mixbus, then
this plugin will immediately be available in v3.7.

Improvements:
Fix time-alignment of master bus on export: Exporting the master bus, and re-importing it, will result in
correct alignment, even with complicated combinations of plugins on the mixbuses and master bus, and
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including the master bus limiter “lookahead”.
NOTE: due to technical limitations, it is now only possible to export Tracks, not buses, in the Stem Export
dialog. If you want to export the mixbuses as individual files, please solo each mixbus and use “Session-
>Export to Audio File” to generate time-aligned mixbus outputs through the master bus. This guarantees
that all resulting track, mixbus and master output files will align with each other.
New option for Region->Normalize : user may optionally normalize the region to an RMS level, instead of
peak.
Add colored-faders option: fader caps will be colored to match the track/group color. To enable this, visit
Preferences->Theme.
Improved various aspects of the Insert/Remove Time dialog to make it easier to operate.
Safe Mode ( ignores plugins and playhead zoom+location when opening a session ) : Hold ctrl + click “open”
in the Session startup dialog.
The instruments listed in the “New Track/Bus” dialog are now sorted alphabetically.
Allow feedback loops from a “Send” on a mixbus, back to a track input. This will result in a one-buffersize
delay on the audio path. To enable this, right-click on a Send, and choose “allow feedback”.
Correctly show the number of channels/tracks for both type-0 and type-1 MIDI files.
When importing a type-0 SMF MIDI file, split channels into separate tracks.
Added MIDI map file for Akai MIDIMix device.
Basic support for Avid Artist Mix & Avid Artist Edit control surfaces as MCU devices. Faders, pan, mute,
solo, rec-arm and selection are working. These devices only support a limited set of the MCU features.
Default Auto-Input to “Off”, to avoid new user reports of immediate noise or feedback after importing or
creating tracks.
Add a button to interactively check for New/Updated Harrison LV2 plugins, and automatically download/
install them.
If a session is loaded, the Samplerate pulldown is now inactive, to avoid confusion when users changed this
setting and it had no effect.
Sample-rate display always shows active (not desired) rate.
“Download & Install License” feature: an alternative way to install the license file, for new users who have
trouble finding their HOME folder.
Remember the status of analyze and soundcloud upload checkboxes in ExportDialog, so you don’t have to
reset them every time you export.
Improved the speed of XML session file read/write.
Improved the speed of Region Export.
Wrap LTC output if the playhead exceeds 24 hours.

Fixes:
“Blink-rec-arms” option wouldn’t take effect until Mixbus was restarted. This has been fixed.
Allow a LV2 plugin to mark the session modified/dirty. ( fixes a problem with SetBfree saving its settings if
you don’t explicitly save the session )
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Using arrow-keys on selected mixer strips would recursively affect grouped faders: in a group of 4 faders, a
single click would be applied 4 times. This has been fixed.
Don’t include session-search paths with templates.
Disallow pin-management for MB channelstrip plugins. ( it’s not needed anyway )
Moving start/end markers marks the session as modified/dirty.
MIDI CC automation events (when imported from a MIDI file) should not extend a line backwards to the start
of the session.
…and hundreds of smaller tweaks and bug-fixes.

Windows Fixes:
Properly recognize VSTi synths using VST’s metadata. In the past we detected MIDI input and audio output,
and assumed it was an instrument. This caused some plugins to be instantiated with stereo output when
added to a mono channel.
VST threading: prevent concurrent effSetChunk and process() – This is a potential fix for unreliable preset
load/restore.
Allow opening sessions with files embedded from removable drives, even when the disk isn’t attached.
Previously, Windows would prompt you to “insert disk” and wouldn’t continue until a disk was mounted on
the path.
Convert VST parameter names to UTF8, this time for Windows. This is needed for plugins that use
non-ASCII characters in parameter names, such as AirWindows “µ-iness”.
You can now have Sessions with localized names containing characters that aren’t in the system codepage
on Windows. It also fixes the issue where a Session would not open when it was moved into a path with
characters that aren’t in the system codepage.
Fix a bug when formatting time strings in the Recent Sessions window.
Fix a crash when toggling back and forth between a generic plugin GUI window and a VST plugin’s own
GUI.

Mac Fixes:
Fix AU song-position and tempo, which was broken in v3.6.
Text cut/copy/paste now correctly uses Cmd+x/c/v on mac, instead of Ctrl.
Previous versions would only utilize physical processors (ignoring hyperthreading processors) This has
been fixed to match operation on linux and windows.
Fix Coreaudio Aggregate for separate devices with identical names.
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Videos (Training and Tutorial)
The videos on the following pages are provided for your convenience and are a great resource for learning
more about Mixbus and Mixbus32C. Some of these videos were produced using an earlier version of
Mixbus, however the bulk of the information is still very relevant.

If you have read the manual, then some of these videos may be familiar, as some are placed throughout the
manual, others are not.

These videos and more can also be found on our YouTube page. Don’t forget to subscribe to our YouTube
channel to be alerted to our new videos coming soon!

And don’t forget our Mixbus user forum for more Mixbus information, or to just hang out and discuss how fun
and easy it is to mix with Mixbus!
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Quick Start Guides

For Mac Users

Licensing and the Home Folder for Mac

Quick Start Guide for Mac

For Windows Users

Licensing and the Home Folder for Windows

Quick Start Guide for Windows
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https://www.youtube.com/embed/83lsyy0ztKU?rel=0
https://www.youtube.com/embed/83lsyy0ztKU?rel=0
https://www.youtube.com/embed/To5SOyd0Qw4?rel=0
https://www.youtube.com/embed/To5SOyd0Qw4?rel=0
https://www.youtube.com/embed/To5SOyd0Qw4?rel=0
https://www.youtube.com/embed/1ZU58nRzKI0?rel=0
https://www.youtube.com/embed/1ZU58nRzKI0?rel=0
https://www.youtube.com/embed/nMPqBaQOW-o?rel=0
https://www.youtube.com/embed/nMPqBaQOW-o?rel=0
https://www.youtube.com/embed/nMPqBaQOW-o?rel=0
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Mix Tips

Harrison’s Mix Tips Video Series. This video explains side-chaining in Mixbus 3.

Harrison’s Mix Tips Video Series. This video explains gain staging in Mixbus 3

This video demonstrates how to use grouping and bussing to enhance your session workflow within Mixbus
3.

Harrison’s Mix Tips Video Series. This video demonstrates how to create a subgroup in Harrison Mixbus
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https://www.youtube.com/embed/q1WoKW_TKYo?rel=0
https://www.youtube.com/embed/DjlBbao5gMQ?rel=0
https://www.youtube.com/embed/DjlBbao5gMQ?rel=0
https://www.youtube.com/embed/DjlBbao5gMQ?rel=0
https://www.youtube.com/embed/DjlBbao5gMQ?rel=0
https://www.youtube.com/embed/cuInwhnrtlk?rel=0
https://www.youtube.com/embed/cuInwhnrtlk?rel=0
https://www.youtube.com/embed/cuInwhnrtlk?rel=0
https://www.youtube.com/embed/cuInwhnrtlk?rel=0
https://www.youtube.com/embed/cuInwhnrtlk?rel=0
https://www.youtube.com/embed/67TcjTd7LIs?rel=0
https://www.youtube.com/embed/67TcjTd7LIs?rel=0


Harrison’s Mix Tips Video Series. This video demonstrates how to set up parallel compression in Mixbus.

Harrison’s Mix Tips Video Series. This video shows off some of the mouse shortcuts available in Mixbus.

Harrison’s Mix Tips Video Series. This video tells you everything you need to know about the EQ in Mixbus.

Harrison’s Mix Tips Video Series. This video details the compressors in Mixbus.

Harrison’s Mix Tips Video Series. This video explains many different types of clipping, and how it applies to
Mixbus.
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https://www.youtube.com/embed/iESeTOSvX80?rel=0
https://www.youtube.com/embed/iESeTOSvX80?rel=0
https://www.youtube.com/embed/ep5ietQjaq4?rel=0
https://www.youtube.com/embed/ep5ietQjaq4?rel=0
https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0
https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0
https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0
https://www.youtube.com/embed/Sa3-ibczoK4?rel=0
https://www.youtube.com/embed/Sa3-ibczoK4?rel=0
https://www.youtube.com/embed/Sa3-ibczoK4?rel=0
https://www.youtube.com/embed/cx_FqznRpbI?rel=0
https://www.youtube.com/embed/cx_FqznRpbI?rel=0


Harrison’s Mix Tips Video Series. This video shows off the meters in Mixbus.

Harrison’s Mix Tips Video Series. This video demonstrates how to use reverb in Mixbus.

Harrison’s “Shut Up and Mix” Video. Make sure annotations are turned on so you can see all of the mixing
tips!

<< Quick Start Guides | Pro Tips >>
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https://www.youtube.com/embed/fs0m-wFXdZ8?rel=0
https://www.youtube.com/embed/fs0m-wFXdZ8?rel=0
https://www.youtube.com/embed/ZbHwcsU7r2o?rel=0
https://www.youtube.com/embed/ZbHwcsU7r2o?rel=0


Pro Tips

Episode 1 of Harrison’s Pro Tips video series for Mixbus. This video shows you how to quickly import tracks
into Mixbus, and gives an explanation of the import dialog window.

Episode 2 of Harrison’s Pro Tips video series for Mixbus. This video demonstrates all of the export options
available in Mixbus.

Episode 4 of Harrison’s Pro Tips video series. This video demonstrates how to route audio from Pro Tools
into Mixbus.This is a power user function which Harrison does not provide technical support for.

A follow-up to Harrison’s episode of Pro Tips on routing from Pro Tools into Mixbus. This video
demonstrates how to export audio tracks from Pro Tools to import into Mixbus. This is a power user function
which Harrison does not provide technical support for.
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https://www.youtube.com/embed/otZgZs3CDYM?rel=0
https://www.youtube.com/embed/otZgZs3CDYM?rel=0
https://www.youtube.com/embed/otZgZs3CDYM?rel=0
https://www.youtube.com/embed/wddiGR-Y1bk?rel=0
https://www.youtube.com/embed/wddiGR-Y1bk?rel=0
https://www.youtube.com/embed/wddiGR-Y1bk?rel=0
https://www.youtube.com/embed/nJKSImri0vA?rel=0
https://www.youtube.com/embed/nJKSImri0vA?rel=0
https://www.youtube.com/embed/QxGhN8w5D1s?rel=0
https://www.youtube.com/embed/QxGhN8w5D1s?rel=0


Episode 5 of Harrison’s Pro Tips video series. This video demonstrates the region editing and crossfade
features of Mixbus.

<< Mix Tips | EQ Tips >>
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EQ Tips

Episode 4 of Harrison’s Mix Tips Video Series. This video tells you everything you need to know about the
EQ in Mixbus.

This Quick Tip demonstrates how to use the mid-band of the EQ to notch out a problem frequency on a
track in Mixbus.

This Quick Tip demonstrates how to place your instruments in the sound field using the EQ in Mixbus.

This Quick Tip demonstrates how to create a “bump” for your bass guitar with the EQ in Mixbus. This can be
done with a HPF and a Low Shelf.

<< Pro Tips | Quick Tips >>
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https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0
https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0
https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0
https://www.youtube.com/embed/wn1SvzR2Nv4?rel=0
https://www.youtube.com/embed/O9WnyWbMim4?rel=0
https://www.youtube.com/embed/O9WnyWbMim4?rel=0
https://www.youtube.com/embed/Xb-prKFUdi4?rel=0
https://www.youtube.com/embed/Xb-prKFUdi4?rel=0
https://www.youtube.com/embed/Xb-prKFUdi4?rel=0
https://www.youtube.com/embed/HM8XSfaGJuw?rel=0
https://www.youtube.com/embed/HM8XSfaGJuw?rel=0
https://www.youtube.com/embed/HM8XSfaGJuw?rel=0


Quick Tips

This short video demonstrates how to loop record.

Demonstration of basic trim, fade, delete, copy, and paste operations including Smart Mode.

An example of sidechain compression used on a vocal track with a delay. Implemented using the built-in
sidechain compression features of Harrison Mixbus.

“Ripple” audio editing in the Mixbus workstation.

A power users tip on using mutes and solos.
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https://www.youtube.com/embed/VOiyDFv8zt0?rel=0
https://www.youtube.com/embed/VOiyDFv8zt0?rel=0
https://www.youtube.com/embed/VOiyDFv8zt0?rel=0
https://www.youtube.com/embed/bXLtAYwH7XM?rel=0
https://www.youtube.com/embed/bXLtAYwH7XM?rel=0
https://www.youtube.com/embed/7d33y5lVALg?rel=0
https://www.youtube.com/embed/7d33y5lVALg?rel=0
https://www.youtube.com/embed/x7L6gc2lmHQ?rel=0
https://www.youtube.com/embed/x7L6gc2lmHQ?rel=0
https://www.youtube.com/embed/x7L6gc2lmHQ?rel=0
https://www.youtube.com/embed/x7L6gc2lmHQ?rel=0
https://www.youtube.com/embed/XZU26CNDwmE?rel=0
https://www.youtube.com/embed/XZU26CNDwmE?rel=0


This Quick Tip demonstrates how to use the mid-band of the EQ to notch out a problem frequency on a
track in Mixbus.

This Quick Tip demonstrates how to place your instruments in the sound field using the EQ in Mixbus.

This Quick Tip demonstrates how to create a “bump” for your bass guitar with the EQ in Mixbus. This can be
done with a HPF and a Low Shelf.

<< EQ Tips | Harrison Plug-ins >>
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https://www.youtube.com/embed/O9WnyWbMim4?rel=0
https://www.youtube.com/embed/O9WnyWbMim4?rel=0
https://www.youtube.com/embed/O9WnyWbMim4?rel=0
https://www.youtube.com/embed/Xb-prKFUdi4?rel=0
https://www.youtube.com/embed/Xb-prKFUdi4?rel=0
https://www.youtube.com/embed/Xb-prKFUdi4?rel=0
https://www.youtube.com/embed/Xb-prKFUdi4?rel=0
https://www.youtube.com/embed/HM8XSfaGJuw?rel=0
https://www.youtube.com/embed/HM8XSfaGJuw?rel=0
https://www.youtube.com/embed/HM8XSfaGJuw?rel=0
https://www.youtube.com/embed/HM8XSfaGJuw?rel=0


Harrison Plug-ins
Harrison Plug-ins are included in the Mixbus download package and are functional but require a
separate license purchase to access the full user interface.

Plug-in Essentials Bundle: The Plug-in Essentials bundle includes two pieces that complete the Mixbus
puzzle – reverb (GVerb+) and delay (3D Triple Delay). Watch the video to learn more!

Character Plug-in Bundle: The Character Plug-in Bundle is a completely new DSP plug-in from Harrison’s
R&D department. The XT-BC and XT-VC are designed to musically alter the tonality and character of bass
instruments and vocalists, respectively. Watch the video to learn more!

The XT-DC drum character, the NEWEST addition to the Character Bundle, provides powerful DSP to
equalize the two different parts of a drum “hit” separately by dividing the initial attack from the remaining tail.
Threshold and attack window parameters adjustments are provided. Basic presets are provided as starting
points. The XT-DC utilizes 2 separate equalizers, the 1st dynamically tracks the initial attack while the 2nd
dynamically tracks the tail.

The XT-DC will transform the character of each drum in a kit to a much greater degree than any standard
equalizer can possibly achieve. A regular EQ operates on the attack, tail, and background noise equally.
Whereas the XT-DC applies these changes specifically to the drum attack and tail. This gives you
unprecedented access to nearly unlimited sounds from your existing drum tracks. Compared to traditional
“drum replacement” techniques, the XT-DC preserves the drummer’s natural voicing and timing.
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The XT-BC, XT-VC, and XT-DC feature Harrison’s world-class, workhorse DSP derived from our flagship
digital consoles. No other plug-in preserves the playability and musicality of your bass instruments like the
XT-BC; no other plug-in breathes life into your vocals like the XT-VC; and no other Plugin provides the
ability to enhance and shape the sound of each individual drum in your kit like the XT-DC!
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XT-DS De-Esser: The XT-DS De-Esser is Harrison’s transparent, powerful plug-in for taming excessive
sibilance of vocal tracks. It implements Harrison’s proprietary algorithm that is tuned to detect “ess” sounds,
while ignoring sounds that have energy in the “ess” band, but aren’t contributing to the sibilance of the track.
Watch the video to learn more!
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XT-EG Expander / Gate: The XT-EG Expander / Gate is Harrison’s versatile tool for gating noise, or gently
increasing the dynamic range of tracks. All of the common gate controls are accounted for – Depth, Hold,
Attack, Release – but there are also some not-so-common tools that are typically reserved for high-end
audio gear: Hysteresis, Lookahead, and Sidechain Filter. Watch the video to learn more!
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XT-EQ Equalizer: The XT-EQ Equalizer is a powerful EQ derived from the sound of Harrison digital
consoles. It allows you to draw a desired curve using 10 control bands, and features an innovative DSP
curve-match to allow “flat tops” across adjacent frequencies. Watch the video to learn more!
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XT-ME Mastering Equalizer: The XT-ME Mastering Equalizer is a powerful, expanded EQ derived from the
sound of Harrison digital consoles. It allows you to draw a desired curve using 31 control bands, and
features an innovative DSP curve-match to allow “flat tops” across adjacent frequencies. Watch the video to
learn more!
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XT-MC Multi-Band Compressor: The XT-MC Multi-Band Compressor is a powerful 4-band compressor
with phase-accurate crossovers. Each band features controls for threshold, crossover frequency, and depth.
Watch the video to learn more!

XT-LC Look Ahead Compressor: The XT-LC Lookahead Compressor is a compressor that works when
others won’t. Its lookahead design, with super-fast attack and Zero-History release properties, makes it able
to do things that a regular compressor can’t match.
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XT-TG tom tom gate: The XT-TG tom gate has the unique ability to learn the sound of your tom drums and
discriminate against the sound of the spill.
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<< Quick Tips | XTools for Mixbus >>
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XTools for Mixbus
Harrison Plug-ins are included in the Mixbus download package and are functional but require a separate
license purchase to access the full user interface.

XTools for Mixbus are plug-ins derived from Harrison digital console software. They provide incredible
power that was not previously available in any digital audio workstation.

A closer look at the XT-EQ Equalizer plug-in for Mixbus.

A closer look at the XT-ME Mastering Equalizer for Mixbus.

A closer look at the XT-MC Multi-Band Compressor for Mixbus.
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An in-depth look at the XT-BC Bass Character plug-in for Mixbus.

This video is an overview and sound demonstration of the XT-DS De-Esser plug-in from Harrison. This plug-
in is part of the XTools for Mixbus plug-in series for the Harrison Mixbus DAW.

This video is an overview and sound demonstration of the XT-EG Expander / Gate plug-in from Harrison.
This plug-in is part of the XTools for Mixbus plug-in series for the Harrison Mixbus DAW.

This video is an overview and sound demonstration of the XT-LC Lookahead Compressor from Harrison
(Requires MB Ver 3.2). This plug-in is part of the XTools for Mixbus plug-in series for the Harrison Mixbus
DAW.

This video is an overview and sound demonstration of the XT-DC Drum Character from Harrison (Requires
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MB Ver 3.2). The XT-DC drum character provides powerful DSP to equalize the two different parts of a drum
“hit” separately.
It utilizes 2 separate equalizers, the 1st dynamically tracks the initial attack while the 2nd dynamically tracks
the tail.

The XT-TG tom gate has the unique ability to learn the sound of your tom drums and discriminate against
the sound of the spill. This plug-in is part of the XTools for Mixbus plug-in series for the Harrison Mixbus
DAW.

<< Harrison Plug-ins | Essentials Pack >>
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Essentials Pack
Harrison Plug-ins are included in the Mixbus download package and are functional but require a separate
license purchase to access the full user interface.

The Plug-In Essentials Pack for Mixbus contains everything you need to make a polished, professional mix.

Drums demo for the GVerb+ plug-in. GVerb+ is part of the Plug-In Essentials Pack for Harrison Mixbus.

Guitar demo for the GVerb+ plug-in. GVerb+ is part of the Plug-In Essentials Pack for Harrison Mixbus.

Piano demo for the GVerb+ plug-in. GVerb+ is part of the Plug-In Essentials Pack for Harrison Mixbus.
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Vocal demo for the GVerb+ plug-in. GVerb+ is part of the Plug-In Essentials Pack for Harrison Mixbus.

Drums demo for the 3D Triple Delay plug-in. 3D Triple Delay is part of the Plug-In Essentials Pack for
Harrison Mixbus.

Guitar demo for the 3D Triple Delay plug-in. 3D Triple Delay is part of the Plug-In Essentials Pack for
Harrison Mixbus.

Drums demo for the 3D Triple Delay plug-in. 3D Triple Delay is part of the Plug-In Essentials Pack for
Harrison Mixbus.

Vocal demo for the 3D Triple Delay plug-in. 3D Triple Delay is part of the Plug-In Essentials Pack for
Harrison Mixbus.
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<< XTools for Mixbus | 3D Triple Delay >>
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3D Triple Delay
Harrison Plug-ins are included in the Mixbus download package and are functional but require a separate
license purchase to access the full user interface.

Short demo of Harrison’s 3D Triple Delay plug-in for Mixbus users. This video demonstrates some of the
preset starting points available in the plug-in .. Flange, Doubling, Slapback, Ping Pong, etc.

A short demo of Harrison’s 3D Triple Delay plug-in on drums.

A short demo of Harrison’s 3D Triple Delay plug-in on guitar.

A short demo of Harrison’s 3D Triple Delay plug-in on more drums.
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Short demo of Harrison’s 3D Triple Delay plug-in on vocals.

<< Essentials Pack
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MIDI Primer
These pages will discuss basic MIDI messages, devices, and connections. It is intended to give enough
information to get you started. Much of the information is presented in a generic way, not necessarily
directly related to Harrison Mixbus. For specific MIDI for Mixbus click here.

What Is MIDI?

Musical Instrument Digital Interface, or MIDI, is a communication protocol that was published in 1983. The
intent was to allow 2 instruments, from 2 different manufactures, to communicate with each other. One
keyboard could be played while a second connected keyboard (with tone module) could sound the same
note at the same time, doubling the performance.

It is important to know that the information being transmitted is not audio! It is “performance data” in the
form of MIDI messages such as the note played, timing, velocity, etc.

Basic MIDI Devices

1. A MIDI Controller produces and transmits MIDI messages. Controllers can take on the functionality of
keyboards or guitars, etc. They are designed to capture the performance of a musician. They do not
produce sounds of their own.

2. A MIDI Instrument, or tone module, receives MIDI data and produces an audio output. It may be
software or hardware based. A user can have one controller connected to one or more tone modules.
Additionally, in the world of Digital Audio Workstations there are “plug-in” versions called virtual
instruments (VI).

3. A unit that combines a controller and instrument in one package will be referred to as a hybrid for the
purposes of this document. The most common form of this is often referred to as keyboard
synthesizer. It can generate MIDI performance data and audio via an internal tone module.
Sometimes the internal tone module can be switched off with a command known as Local Control. (If
you seek out something called a “MIDI hybrid device” you may come up short).

4. A MIDI Sequencer is a device or software application that can record, edit, and play back MIDI
events.

A single device can implement any combination of controller, instrument, and/or sequencer features. For
example, before computer sequencers were popular, it was very common to buy a keyboard that provided
the keyboard, internal tone module, and sequencing features in one device. These are sometimes called
“arranger” keyboards.
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You may find tone module, tone generator, and sound engine are used interchangeably.

MIDI Messages

The MIDI language is transmitted digitally. The information carried in the messages are note on, pitch,
velocity, program change, note off, and more. There are 2 types of MIDI messages; Channel messages and
System messages. These two sub groups can be further broken down and will be explained below. These
MIDI messages are sent to other devices via a MIDI cable. More on the MIDI cable a little later.

Channels Messages: Each channel message contains a channel assignment and as a result are assigned
to specific channels rather than sent globally. With the capability to transmit (Tx) and/or receive (Rx) on 16
channels, the user is offered some flexibility. Once a channel is establish the channel messages will deliver
instructions such as Program change, Note on, Note off, and more. With this you can send performance
data from one controller, on one specific channel, so that that one or more specific MIDI instruments on the
same Rx channel responds.

When a controller and tone module are combined together, there is often a function called
“Local Control” which determines whether the keyboard will control the internal tone
module directly. If you want to use a sequencer or DAW, you might use Local Control to
disconnect the internal tone module from its keyboard. This way, when the controller sends
performance data to the computer sequencer, and the sequencer returns the data back to
the sound module, you don’t hear the notes from the sequencer and internal controller at
the same time.

*
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Voice and Mode Messages

The “Voice” portion of the channel message is the musical performance part and contains information
regarding the following:

• Note On: Identifies the note that will produce sound. The data sent is channel number, specific note
number, and key on velocity.

• Note Off: Identifies the note that will stop producing sound. The data sent is channel number, specific
note number, and key off velocity (notice that the note command has a discrete code for off and on.
More on this later).

• Polyphonic Key Pressure (Aftertouch): Some controllers have the ability to sense how much pressure
was applied. The data sent is channel number, specific note number, and key pressure. If your
controller does not have aftertouch, a default of medium pressure (64 of 128 possible) is assigned.

• Control Change: Specifies what function of the synthesizer is to be controlled. The data sent is
channel number, controller number, and controller value.

• Program Change (sometimes called Program Select): Selects the type of sound that should be
played. The data sent is channel number and program number. In the early days of MIDI, when a user
wanted a custom sound he would need to patch cables. Today this cable patching process can be
replaced with a stored file in memory, hence the name “patch”. You may also hear the terms voice or
preset. These are essentially all the same thing. You can create your own patches or the manufacture
can provide them for you. Because of the format of the MIDI message, only 128 patches would be
recallable if it wasn’t for the Bank Message. Having multiple banks of patches, provides many more to
choose from.

• Pitch Bend: Modifies, in a continuous manner, the pitch of the note being played. The data sent is
channel number and pitch bend value.

The “Modes” portion of the channel message tells the MIDI instrument how to respond when it receives the
performance part or the message.

Mode Full Name Common Name

1 Omni – On/Poly Omni

2 Omni – On/Mono no common name

3 Omni – Off/Poly Poly

4 Omni – Off/Mono Mono

Omni On/Off is used to determine the utilization of available channels. If Omni is ON then it will Tx or Rx
data on all channels. If Omni is OFF then it will Tx or Rx on just one channel.
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Mono/Poly tells the instrument whether to play 1 note at a time (Mono) or more than 1 note at a time (Poly).
The Mono modes are the least commonly used modes (mode 2 and 4).

Polyphonic capability is merely the ability to play 2 or more notes simultaneously. So if you want to play a 4
note chord you will need 4 note Polyphonic capability.

Multi Mode

With Multitimbral we are talking about many tones to produce a complex sound like a piano part, a violin
part, or a drum part. These are sometimes called “programs”,“patches”, or “presets”. You can have many
parts playing at once, each assigned to its own channel. Before Multitimbral there was Monotimbral, where
only one part could be played. Multitimbral can replace multiple notes with multiple programs so that we
may produce the sound of an entire band with one MIDI performance track.

16 part Multitimbral playback capability is not uncommon today. Also be aware some manufactures may call
Multi mode something different. For example, the classic Yamaha Motif refers to it as “song mode”.

There are other commands that can be invoked with a mode message, such as reset all controllers, local
control, and all notes off.

Let’s address the “All Notes Off” message. As mentioned previously, the note on/off commands are discrete
messages. So what happens if a note is turned on and for some reason the Rx equipment never gets the
message to turn the note off? The “All Notes Off” message addresses this. It sends a Note Off command
across all channels. In Mixbus there is a “MIDI Panic button” on the left side of transport section that sends
the “All Notes Off” message. The button looks like an exclamation point. How appropriate!

above: the MIDI panic button circled in red

System Messages: These messages are mostly global and as such do not carry a channel assignment.

Timbral, or timbre refers to tone quality. Timbre is how we determine the difference between
the sound a bell makes and the sound a sine wave makes. When pitch and loudness are
the same, much of the difference lies in the harmonics or timbre.
*
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System Common Messages are for all MIDI devices in a network regardless of channel assignment. These
messages are things such as MIDI Time Code (MTC), MIDI Clock, Song Select, and Song Position Pointer.

System Real-time Messages are used for synchronization with all devices in the network that are clock
based such as sequencers and drum machines. These devices follow a tempo and need to be in sync. The
resolution of the timing is expressed as Pulses Per Quarter Note (PPQN).

System Exclusive Messages are not global. They operate more as a point to point type of operation. It’s
kind of a catch all command that allows manufactures to use it for a whole host of things. For example a
stored patch can be transmitted to and from equipment by the same manufacture. The manufacture can
register their equipment with The MIDI Manufacturers Association so that they can obtain an exclusive
SysEx ID so that only their equipment will respond to their commands. The code that one manufacturer uses
to write a patch is going to be different from another manufacturer so sending a Yamaha patch to a Roland
won’t do much good. This is because each manufacturer has their own unique way handling information
such as patches.

General MIDI (GM and GM1)

General MIDI is not actually a message but rather a standard that specifies certain functionality of MIDI
equipment. Without General MIDI, each manufacturer can assign whatever patch they wanted, to whatever
storage location they wanted. This would make it difficult to use different equipment from different
manufactures. For example, one manufacturer may have a French Horn for Bank 1 program 4, and another
manufacture may have that spot reserved for Viola. But General MIDI says that Bank 1 program 4 shall be a
Honky-tonk Piano. With this, when a command is sent from one device to another the musician can hope for
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a sound closer to their expectation. General MIDI 1 elaborated on this and added even more specifications
to the standard.

The MIDI Cable

The MIDI cable is unusual in that both ends have a 5 pin male connector.

Pin layout:

• Pin 1: Normally not used (proprietary systems may make use of)
• Pin 2: Terminated to a shield to eliminate noise
• Pin 3: Normally not used (proprietary systems may make use of)
• Pin 4 & 5: A twisted pair, and carries the 5 volt MIDI message

Sometimes this cable is called a MIDI DIN (Deutsches Institut fur Normung). The MIDI cable will carry MIDI
signals in one direction only. If you need MIDI messages to return, then you will need a second cable.

The MIDI DIN cable characteristics are:

• Unidirectional transmission
• Serial transmission
• Maximum recommended length is 50 feet (to insure reliability)
• Transmission speed is 31,250 bits per second
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USB, FireWire, and Ethernet have become popular alternatives when connecting to computers. However, if
you need the full feature set that MIDI has to offer you will need MIDI cables.

Types of MIDI Ports

Often you will find 3 types of connections on MIDI equipment.

• MIDI out: Transmits the MIDI message
• MIDI in: Receives the MIDI message
• MIDI thru: Transmits a copy of the MIDI message found on the MIDI input (This facilitates daisy

chaining and star configurations).

MIDI Connections

Fig. 1 above: A dedicated MIDI controller is connected to a tone module. This requires a MIDI cable. A USB
or FireWire cable will not work.
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Fig. 2 above: A dedicated MIDI controller is connected to a DAW such as Mixbus via a MIDI interface.
Running a Virtual Instrument plug-in within Mixbus replaces the dedicated tone module. The audio output
from Mixbus can be routed to an internal DAC / sound card or to an external audio interface.
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Fig. 3 above: A dedicated MIDI controller with USB MIDI out. In essence the MIDI interface is built-in to the
the controller eliminating the need for an external MIDI interface.
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Fig. 4 above: In this example the MIDI controller has an on board tone module. Now MIDI messages can be
sent from the computer to the MIDI controller so that audio can be produced with the on board tone module.
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Fig. 5 above: This is an example of a daisy chain configuration. A dedicated controller sends MIDI
messages to the first tone module which in-turn sends a copy of the signal to the second tone module. If the
chain is carried out too far, the signal will degrade and become unreliable.
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Fig. 6 above: This is an example of a star configuration. The Thru Box allows this configuration.
Connecting many tone modules to a central point causes less chance of signal degradation. The
advantages of this configuration increases with the number of devices on the network. For simplicity only 2
tone modules are shown. In practice many more may be connected causing the diagram to resemble a star
pattern as the tone modules branch out around a central point.
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Fig. 7 above: A merge box allows 2 MIDI controllers to send MIDI messages to a single tone module. An
example of this configuration could be that one of the controllers may be a keyboard and the other controller
could be a string instrument both playing together into one tone module.

The Interface From MIDI To Mixbus

You will typically need an audio interface with MIDI I/O as in figure 2 or 4 above, or you may opt for a USB
or FireWire connection as in figure 3. Of course you will also need need a MIDI controller. Although you can
input data straight into Mixbus via the various tools provided in the software, it can be an inefficient method
for recording an entire performance. These tools are best suited for making adjustments to an already
captured performance or for step entry.
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above: some of the tools offered in Mixbus
below: the on screen keyboard (right click the MIDI track rec button)

What MIDI Controller Should You Get?

Only you can decide what is best for you, but if you are new to MIDI a keyboard controller is a great choice
for general purpose use and by far the most popular because of its flexibility. You will want to consider the
number of octaves you would like the keyboard to cover. An alternative to a MIDI controller would be a
synthesizer, one that generates MIDI messages and can also contains its own tone module. But because it
can produce its own audio, it may cost more, take up more space, and be heavier. If you like the sounds a
MIDI hybrid makes, and if it has line level outputs, you can record the audio straight into Mixbus via an
audio interface as shown in figure 4 above.

Recording MIDI into Mixbus

To record a MIDI performance into Mixbus, first add a MIDI track. If you would like to hear your performance
thru Mixbus then be sure a Virtual Instrument plug-in is in the redirect box. You can use Plug-in Manager to
do this (by default a MIDI track will be created with the “Reasonable Synth” plug-in already in place).Then,
in the MIDI Connection Manager, confirm that your MIDI input device is connected to the track you wish to
record to. Record arm the track and click the master record button located in the transport section. Once the
transport rolls you will be able to record your performance. MIDI messages will now be captured into
Mixbus.

For more information click here
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Common Support Questions
I purchased Mixbus, but it says it is “UNLICENSED” and I occasionally hear a burst of noise.

• Please check the Mixbus download email that arrived shortly after your purchase. The email should
include a link to your Mixbus license file, and instructions for installing it.

If you need additional help with the licensing process, please watch the appropriate video for your platform:

• For Windows, please watch this video:

• For Mac OS X, please watch this video:

If Mixbus still says UNLICENSED when you launch it, the 2 most common problems are:

1. Your browser changed the filename when the file was downloaded. For example, it might say
“license_key_harrison_mixbus3.txt (2)” or “license_key_harrison_mixbus3-2.txt”. You can rename it
EXACTLY “license_key_harrison_mixbus3.txt”. Or you can delete all the license files on your
Desktop and then re-download the link to solve the problem.

2. Your user does not have write permissions on the HOME folder. If this is the case, then Mixbus
cannot copy the file from your Desktop into your HOME folder. Verify that you can copy files to your
HOME folder. The HOME folder is the folder that contains your Downloads, Pictures, Music, etc.

When I try to open the GVerb+ or 3D Delay, it says that the plugin is unlicensed. How do I get a
license?

• These plugins are part of the Plugin Essentials Pack which is available on our web store. The plugins
are included in the Mixbus installation, but to utilize the on-screen controls you must purchase a
separate license. The Essentials are available to all Mixbus users on all platforms ( Windows, OS X,
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and Linux ) and are automatically installed as part of Mixbus. This allows you to share Mixbus
sessions with your friends and know that they will have the sound of the plugins available, even if they
haven’t purchased them! Neat, huh?

I purchased the Plugin Essentials Pack (or other Harrison plugins), but when I open the plugin it
says “UNLICENSED” and the controls are blacked out.

• The Plugin Essentials license must be copied to your HOME folder ( see above to find your HOME
folder ) and it must have this name: “license_key_harrison_essentials.txt”

How do I show Mixbus where to find my VST plugins? ( Windows )

• In the main menu, click Window->Preferences->Plugins. Add the folder paths that point to your
plugins and click “Scan”. More Here

How do I report a crash in Mixbus? ( OS X )

• If you are using OS X and are still crashing at startup, the most likely cause is a plugin that Mixbus is
not able to scan at startup. When Mixbus reports “Mixbus has closed unexpectedly”, please click
“Generate Report”. This will open a window with the technical details of the crash report. Please copy/
paste this information into an email to mixbus@harrisonconsoles.com for support.

How do I launch Mixbus from a command-line prompt? ( for techies only )

• Windows: cd C:\Program Files\Mixbus3\bin Mixbus3.exe
• OS X: ARDOUR_BUNDLED=1 /Applications/Mixbus3.app/Contents/MacOS/Mixbus3
• Linux: cd /opt/Mixbus3/bin ./mixbus

Where does Mixbus store its preferences?

Mixbus creates a folder with several files. On Windows, the folder path is something like ~\AppData\Local\
Mixbus3\ ( this varies with different versions of Windows ).

• On Mac, the folder path is ~/Library/Preferences/Mixbus3
• On Linux, the folder path is ~/.ardour2

“ui.conf” stores the color, font, and other theme preferences
“announcements” stores the latest announcements from Harrison (usually this is empty unless a new
version is available)
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“bindings” stores the user’s selected keybindings (keyboard shortcuts) for menu actions
“config” stores the user’s preferences such as auto-backup and other items in the Options menu
“instant.xml” stores the user’s last-used preferences such as snap mode, mouse mode, zoom mode,
etc.
“recent” lists the sessions that appear in the recently-used dialog
“sfdb” stores the metadata database which the Import dialog stores metadata about files that you’ve
“tagged” for later use.
a folder called AU_cache where Mixbus stores the scanned AU plugins ( OS X only )
a folder called FST_cache where Mixbus stores the scanned VST plugins ( Windows only )

If you delete the preference folder or any file inside it, Mixbus will create a replacement with default values
when it is next launched. Sometimes this will cause a delay at startup; for example on OS X, Mixbus will
have to re-scan the plugins when it is next launched.

Can I import Key bindings to another computer?

Yes, you have to manually copy the keybindings file from one computer to the other.

The file is found in your “preferences” folder:
~/Library/Preferences/Mixbus3 on Mac
~/AppData/Local/Mixbus3 on Windows

If your question is not answered in this thread, feel free to email us at
mixbus@harrisonconsoles.com for support.
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Contact Information
Visit our website to see the latest news about Mixbus and plug-ins for Mixbus:
http://mixbus.harrisonconsoles.com

Visit our forum to see common Mixbus questions & answers:
http://mixbus.harrisonconsoles.com/forum

For Mixbus support directly from Harrison, please email:
mixbus@harrisonconsoles.com

Chat with other Mixbus users and developers using IRC:
http://webchat.freenode.net/?channels=ardour-mixbus

Physical Address and Phone:

Harrison Consoles
1024 Firestone Parkway La Vergne, TN 37086

615-641-7200 Phone
615-641-7224 Fax

Harrison Consoles Main Website
www.harrisonconsoles.com
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